See what others are saying about this book:

“I’ve been using email for ten years, so I was skeptical that this book could tell me anything I didn’t know already. Much to my surprise, I found highly useful advice immediately! The first three chapters alone made a staggering difference in my efficiency.”


“If you have ever felt like your e-mail was controlling you, this book can help you take back control. Office-support workers will find it particularly useful.”

—Joyce Grant, Editor, Administrative Assistant’s Update

“Finally! This excellent book fills a void in the how-to literature, offering simple and effective tactics for anyone overwhelmed by the daily deluge of email. This book has been a great help to us and to our clients, and it can help you too!”

—Irene Tobis, Ph.D., President, Ducks-in-a-Row® Organizing Consultants

“I loved the tone of the book. Sherwood’s sense of humor and unintimidating writing style make this a sure winner. Its wealth of information and accessibility make it an essential read for anyone who uses email.”


“Overcome Email Overload gives you everything you need to know to take back control of your inbox. Corporate, school and other email system managers should make Overcome Email Overload required reading by their users. Highly Recommended.”

—Mary Houten-Kemp, creator of Everything Email, www.everythingemail.com

“Overcome Email Overload with Microsoft Outlook 2000 and Outlook 2002 is packed with techniques that are easy to apply and really help cut down on your daily workload. Its many (often hilarious) examples clearly illustrate strategies for solving common email problems. A must-read for anyone who wants to communicate more effectively!”

—Mike Beckerle, Manager and Software Designer

“Don’t touch your email without first reading Overcome Email Overload.”

—Heinz Tschabitscher, Guide for About.com’s Email section, email.about.com
“I really enjoyed *Overcome Email Overload with Microsoft Outlook 2000 and Outlook 2002* and found it to be perceptive, clearly-written and very well-organized; it has many useful and practical suggestions for dealing with this very critical area of modern business life. I consider it invaluable for all of us who are impacted by this new form of communication.”

—Craig D. Wandke, Interpreter Operations Manager, Language Line Services, www.languageline.com

“Did I learn new features of Outlook? Yes! Will I keep this handy when I am using Outlook? Yes again! Well done!!”

—Neil Shapiro, Research Programmer

“I’ve been an avid user of email since it was introduced, but in the past few years I’ve really gotten buried. Sherwood’s book has been a godsend to me. I particularly appreciate her skill at setting forth the ‘why’ as well as the ‘what.’”

—Thomas Henderson, retired Chairman & CEO of Guy F. Atkinson Company

“Do you spend hours wading through your email? Are you looking for ways to spend less time sending and answering messages? Learn the secrets of surviving email with *Overcome Email Overload with Microsoft Outlook 2000 and Outlook 2002*. With simple suggestions and detailed how-tos, this book will teach you the tricks to saving time and sending better messages.”

—Julie Hood, author of *The Organized Writer: 30 Days to More Time, More Money, and Less Frustration!*

“Make this part of your new hire kit and encourage a career of professional, organized communication.”

—Andrea Talley, Technical Communication Manager

“If you don’t need more time, don’t read this book. If you enjoy reading all your junk mail, you may not care for it. If you have never had trouble finding an important message, this book may not be for you.”

—Russell Bridges, System Administrator

For a full list of endorsements, see:

http://www.OvercomeEmailOverload.com/eudora/quotes.html
Overcome Email Overload with Microsoft Outlook 2000 and Outlook 2002
OTHER BOOKS IN THIS SERIES:

Overcome Email Overload with Eudora 5

UPCOMING BOOKS IN THIS SERIES:

Overcome Email Overload with Lotus Notes

Overcome Email Overload with Netscape Communicator
Overcome Email Overload
with Microsoft Outlook 2000
and Outlook 2002

Get Through your Electronic Mail Faster

http://www.OvercomeEmailOverload.com

Kaitlin Duck Sherwood
James A. DeLaHunt,
you are quite perfect enough!
Thanks for saying yes!
# Contents

**Preface** ................................................................. 13  
  Acknowledgments ......................................................... 14  
  Characters and Places ...................................................... 17  

**Chapter 1: Introduction** ........................................... 19  
  Who Is This Book for? .................................................. 20  
  Outlook Versions ......................................................... 21  
    Outlook 2000 vs. Outlook 2002 .................................... 21  
    If You Use Outlook 97 or Outlook 98 .......................... 21  
    If You Use Outlook Express ...................................... 21  
    If You Use Outlook 2001 for Mac OS or Entourage ....... 22  
  Overview of This Book ................................................. 22  
  Notation, Terminology, and Simplifications .................. 24  
  Tips ............................................................................. 25  
  Additional Material ....................................................... 25  
  Examples ........................................................................ 25  
  Summary ....................................................................... 26  

**Chapter 2: Organize and Prioritize Your Messages** .......... 27  
  Set up Your Categories .................................................. 29  
  Category Order ............................................................. 31  
  How to Make a View Grouped by Category .................... 32  
  Outlook Rules ............................................................... 36  
    “Real-World” Rules ..................................................... 37  
    How to Create Outlook Email Rules ........................... 38  
    Find Frequent Correspondents with “Sender in Address Book” (Outlook 2002 Only) ............................................. 48  
    More Conditions ......................................................... 49  
    How to Prioritize with Advanced Rule Actions ............ 50  
  Rule Order ................................................................. 54  
  Exchange Rules vs. Outlook Rules ................................. 55  
  How to Test Your Rules .................................................. 57  
  Problems with Contact Names ....................................... 58  
  Problems with HTML Messages ................................. 58
Group Messages by Using Multiple Accounts ......................... 59
Personal Accounts .......................................................................... 60
Junk Mail Accounts ........................................................................ 60
Summary .................................................................................... 61

Chapter 3: Useful Rule Recipes .............................................. 63
Rule Order .................................................................................. 63
Notation ..................................................................................... 65
Space Limitation on Rules ......................................................... 65
Find Potential Viruses ............................................................... 66
Adjust the Importance Level ..................................................... 68
Lower the Importance Level of Multiply Forwarded Messages ... 70
Categorize Humor ........................................................................ 71
Categorize Distribution List Messages ........................................ 72
Categorize Confirmations and Updates ...................................... 73
Categorize Messages from Frequent Correspondents .............. 74
Categorize Messages from Coworkers ...................................... 76
File Junk .................................................................................. 77
    Blacklist Junk Emailers.......................................................... 81
Default Rule: I Don’t Know You ............................................... 82
Summary .................................................................................... 83

Chapter 4: Move Through Your Messages Quickly ............... 85
How to Move to the Next Message Quickly .............................. 86
    Mouse Shortcuts for Moving to the Next Message ................. 87
    Keyboard Shortcuts for Moving to the Next Message .......... 91
How to Scroll through a Message Easily ................................. 92
    How to Scroll with the Mouse ............................................. 92
    How to Scroll with the Keyboard ....................................... 92
Separate “To-Do” Messages from “Done” Messages .............. 93
    Mark “Done” with the Delete Key ....................................... 93
    Mark “To-Do” with Flags ................................................... 94
    Mark “Done”/“To-Do” by Moving Messages to Another Folder... 96
More Keyboard Shortcuts ....................................................... 98
Summary .................................................................................... 98
Chapter 5: Reduce the Number of Incoming Messages .......... 99

Reduce the Number of Junk Email Messages ................. 100
Reduce the Number of Distribution List Messages .......... 100
Global Address List Addresses vs. Internet Distribution Lists 101
Internet Distribution List Administration ......................... 102
When to Unsubscribe ...................................................... 103
How to Unsubscribe ........................................................ 103
Switch to Internet Distribution List Digests ...................... 105
Switch to Announcement-Only Internet Distribution Lists .... 106
Switch to Moderated Internet Distribution Lists ............... 106
Reduce the Number of Messages from Acquaintances ....... 107
Write to Discourage Responses ....................................... 107
Discourage Third-Party Discussions ............................... 114
Send Fewer Messages ..................................................... 117
Educate Your Correspondents ......................................... 124
Summary ........................................................................ 125

Chapter 6: Spend Less Time on Responses ....................... 127

Don’t Respond ............................................................... 128
Don’t Say “Thank You” or “You’re Welcome” ...................... 128
Don’t Respond to Junk Email ........................................... 128
Don’t Answer Messages from Strangers ............................. 129
Don’t Respond to Distribution List Loops ......................... 129
Look at How You Were Addressed ................................... 130
Read All Messages on a Topic before Responding to Any .... 132
Use Prewritten Responses .............................................. 133
How to Create Signatures .............................................. 134
Give Directions ............................................................. 135
Respond to Vague Questions .......................................... 136
“I’m Busy” ......................................................................... 138
Respond to Mass Mailing ................................................. 138
Use Auto-Responders .................................................... 143
Out-of-Office Messages ................................................ 144
Dangers of Non-Out-of-Office Auto-Responders .............. 147
Summary ........................................................................ 148
Chapter 7: Reduce Ambiguity .......................................... 149

Provide Adequate Context .................................................. 150
Quote the Previous Messages ................................................. 151
Make References Concrete .................................................. 151
Repeat Subject in the Body .................................................. 155
Ask Detailed Questions ...................................................... 155
Say What Action You Want .................................................. 157
“Vocal” Techniques for Reducing Ambiguity ....................... 158
Use “Intonational” Grouping .................................................. 159
Use Emphasis ........................................................................ 161
Summary .............................................................................. 162

Chapter 8: Convey Emotional Tone ................................. 163

Use Stand-ins for Gestures and Facial Expression .............. 164
Express Uncertainty ............................................................ 165
Punctuation ......................................................................... 166
Short Utterances ................................................................... 167
Express Urgency .................................................................. 167
In Defense of Nonstandard Writing ................................... 168
If You Think Someone Insulted You ................................. 169
Summary .............................................................................. 170

Chapter 9: Make Messages Legible ............................... 171

How to Determine Your Correspondent’s Email Program .... 172
Use Styled Text Infrequently ............................................... 174
Use Default Font ................................................................ 176
Whitespace ......................................................................... 177
Make Web Sites Easy to Get to ........................................... 177
Punctuation ......................................................................... 178
Cut and Paste ...................................................................... 179
Long URLs ......................................................................... 180
Send Attachments Infrequently ......................................... 180
Word Wrapping ................................................................. 182
“From ” at the Beginning of a Line ..................................... 185
Summary .............................................................................. 187
Chapter 10: Get and Keep Attention ................................. 189

Get Attention............................................................................ 190
Get Attention with Subject Headers............................................. 190
Signal Priority with Addressing Method........................................ 191
Use Your Correspondent’s Name................................................... 193
Identify Yourself to Strangers....................................................... 193
Use Importance Levels................................................................. 194

Keep Attention.......................................................................... 195
Make the Message Easy to Read ................................................... 195
Make Your Points Easy to Find and Respond to............................. 197
Raise Your Perceived Status ........................................................ 204
Show Status Explicitly................................................................. 205

Summary .................................................................................. 208

Chapter 11: Improve Your Company’s Email Effectiveness... 209

Improve Resources ................................................................. 209
Web-based Distribution List Interface......................................... 210
Virus-Checkers ........................................................................ 211
Eliminate Duplicates................................................................... 212
Develop a Good Web Site............................................................. 212
Develop Corporate- or Department-Wide Responses.................... 212
Good Email Software................................................................. 213
Provide Alternatives to Distracting Messages............................... 214
Rules.......................................................................................... 214
Confidential Material................................................................. 215
Messages from “The Company”.................................................. 215

Provide Training......................................................................... 215
Subject Signal Words and Abbreviations ..................................... 216
Signatures................................................................................... 218
Importance Levels...................................................................... 218
Voice instead of Email............................................................... 219
Response Speed......................................................................... 219
Emoticons.................................................................................. 219
Writing Email Well..................................................................... 220

Set Policy .................................................................................. 220
Personal Use............................................................................... 221
Illegal Uses............................................................................... 221
Privacy...................................................................................... 221
Attachments................................................................................ 222
Circumventing Technology Channels ......................................... 222
Email vs. Telephone................................................................. 223

Summary .................................................................................. 224
Appendix A: Visual Basic Scripts ........................................ 243
  Visual Basic Macro Security ........................................... 243
  Investigate the Author .................................................... 243
  Examine the Code ............................................................ 244
  Dims and Sets? ................................................................. 246
  How to Install Visual Basic Macros ................................. 246
  Summary ........................................................................... 252

Index ................................................................................. 253
When I started working on this book, I thought it would be a guide to writing more effective email. After all, *A Beginner’s Guide to Effective Email*, my Web-based guide to writing better email, gets 600,000 hits per year. Hundreds of people per year send me fan email.

Much to my surprise, I found out that almost nobody was interested in a book on writing email well.

I found that people were so overwhelmed by *incoming* messages that they had stopped caring about *writing* email well. They felt that writing well was something that helped their *readers*, not themselves. With forty, sixty, one hundred, or even three hundred messages per day, they felt unable to help themselves, let alone their readers.

Managing email was clearly a much bigger problem than writing email, so I refocused the book on how to deal with email overload. Because I got a lot of email myself over the previous twenty-five years, I knew something about that, too.

I was surprised, however, at how much I learned about dealing with email in the course of writing this book. I could not have done it without the help of many people.
Acknowledgments

I now understand why the Academy Awards are so long and boring. While my name might have ended up on the cover, there is no way that I could have done this without the help of numerous people.

When reading acknowledgments in the past, I had always thought that spouses were shortchanged. I’d see authors heap praise after praise upon their agents, their publishers, their editors, their advisors, their neighbor’s dog, their pizza delivery person, and on and on. Then, at the very end, seemingly as an afterthought, they’d thank their spouse “for everything.” Apparently, the tradition is to thank people in reverse order of importance, but I didn’t know that.

So to make sure that it is very clear to everybody just how important my spouse has been, I want to call attention first to my husband, Jim DeLaHunt. This book would not have come into being without his support. In addition to providing financial support, reviewing the book dozens of times, helping to design the cover, co-authoring the poem on page 123, and giving me ideas when I got stuck, he provided emotional support.

Writing is emotionally difficult for me. Especially in the early days, I could find problems in my writing all too easily. Instead of facing the horrible problems that I had to fix in the prose, it was very easy to become distracted by the nice day outside, a book, or even cleaning the house. Jim kept reminding me that my main priority was the book—not taking long walks, not reading good books, and not keeping a clean house. But most importantly, every time I had a crisis of confidence, he would look me in the eye and say with absolute confidence, “It’s going to be a great book.”

If it has indeed become a great book now, it is because of Jim and many, many other people and institutions.
The libraries of Stanford University, San Jose State University, Palo Alto, Menlo Park, Redwood City, Saratoga, Santa Clara, Sunnyvale, Milpitas, and Cupertino provided useful and fascinating background information.

I regret that I can’t individually list the hundreds of people who sent me questions about email since I put *A Beginner’s Guide to Effective Email* on the Web. While I might have grumbled to myself about all the work it took to answer them, the questions showed me what people cared about and frequently made me scratch my head and think. This book is better because of their questions.

Jeff Ehlers and Dave Perry gave some advice on the cover design.

I had some valuable help with my examples. I had some questions about skydiving terminology and practices that Beth Siegel answered quickly and completely. Jeff Powell and Mia Cheong Walkowski gave examples of good and bad email usage.

Cindy Foster, Mary Wisnewski, Pat Kalish, and Neil Shapiro helped me figure out the interactions between Exchange and Outlook.

While this isn’t an academic book, I learned a lot from academic researchers. Jean Fox Tree’s work illuminated the role of speech disfluencies; Bonnie Nardi’s book *A Small Matter of Programming* prompted me to provide a template rules file. Francis Heylighen and Jean-Marc Dewaele’s paper *Formality of Language* corroborated some of my ideas about formality. (Thanks to Julia Schult for pointing me to their paper.) *Long and Short Routes to Success in Electronically-Mediated Negotiations* by Don Moore, Terri Kurtzberg, LeighThompson, and Michael Morris indirectly made me realize that email is more about negotiation than persuasion.

Olle Bälter’s article *Keystroke Level Analysis of Email Message Organization* showed me that having more than around twenty folders and selectively deleting old messages are time-inefficient strategies. Steve Whittaker and Candace Sidner’s paper *Email Overload: Exploring Personal Information Management of Email* made me understand that people use email as a “to-do” list, an idea that has permeated my book. (Thanks to Bill Walker for pushing me into reading Whittaker and Sidner’s paper and for showing me his own unpublished paper.) Bälter and Sidner’s article on *Bifrost Inbox Organizer* confirmed that prioritizing with categories was the right thing to do.
Sue Mosher’s http://www.slipstick.com is an incredible technical resource. You can find great information from the outlook-users@yahoogroups.com and outlook-dev@yahoogroups.com mailing lists.

I inflicted lousy drafts upon many people, and their feedback shaped this book into what it is now. For a while it seemed like every single reviewer found one thing that would improve the book enormously—and each person found a different thing! It was frustrating to do so many rewrites, but it has made the book far, far better.

- Brendan Kehoe, Michael Brundage, Kevin Johnson of Motorola, David Strom, Geoff Mulligan, and Linda G. Brigman reviewed the book for Addison Wesley Longman. Addison Wesley Longman didn’t take the book, but they provided good feedback and treated me well.
- Frank Ritter’s Introduction to Information Sciences and Technology class at Pennsylvania State University gave me numerous points to think about.
- Some complete strangers generously gave me viewpoints from far outside Silicon Valley. Dan Coutts from Simi Valley, Don Hoffman of the U.S. Navy, Arta Szathmary of Bucks County Community College, Charles Sha’an of Talal Abu-Ghazaleh & Co. in Jordan, Marcel Damseaux from Uruguay, Linda Beal of Higher Colleges of Technology in the United Arab Emirates, Rob Kelley from Australia, John M. Gancz of the Quebec Learner’s Network (Canada), Mike Swift from ISG (New York), Andrew Starr of eMailman, Adam Engst of TidBITS, Michael Tobis of Ducks-in-a-Row® in Madison, and Craig Wandke from Language Line Services in Monterey gave me outstanding feedback. I appreciated getting their perspectives.
Bob Follett helped me make some of the publication decisions.

A few authors gave me important advice and (even more important) encouragement. Nancy Capulet (Putting Your Heart Online), Scott Meyers (Effective C++ and More Effective C++), and Kathy Fitzgerald Sherman (A Housekeeper is Cheaper than a Divorce) helped me believe that I could make the book real.

Marc Olson of Microsoft answered way more stupid questions than he should have had to.

Dan Walkowski provided essential support and came up with a slick trick to make one of my Visual Basic macros work.

I want to give special thanks to my mother. She is an accomplished technical writer and eagle-eyed critic.

Again, I couldn’t have done this without my beautiful and talented husband. I hope that someday I can support him in his pursuits half as well as he supported me in mine. Thanks, Jim—for everything.

**Characters and Places**

Most of the examples revolve around a character named Mabel Garcia. Mabel Garcia is entirely a creation of my imagination. Her bosses, coworkers, family, friends, company, and organizations are equally fictitious.

The only exceptions are a few friends and relatives who thought it would be fun to see their names in print. While the names might exist in the real world, the characters are entirely fictitious. The “real” Martha Boise is not a lawyer and Charlie Yzaguirre isn’t an electric bagpipe repair technician. Claire Beekman is a dog. (And if Georges Harik made electric bagpipes, they would not explode!)

Similarly, there is a town called Hoopston in east central Illinois, USA. However, there are no universities, floss recycling companies, or electric bagpipe repair shops located there that I know of. Hoopston is a perfectly charming town, but it bears no relationship to the Hoopston in this book. I just liked the name.
Do you ever feel overwhelmed by email? Do you ever have to struggle to get through all of your messages between meetings? Does getting one more frivolous message ever make you angry?

It probably wasn't always this way. When you started using email, you probably only got a trickle of email messages each day. After a few months, perhaps ten messages arrived in your inbox daily. A few months after that, you changed to a different department at work and started getting thirty messages per day. And yesterday you came to work and found ten messages about the facilities shutdown, five announcements that people have changed jobs, three jokes, seven messages complaining about the new lobby furniture, four announcements of new projects, eight direct questions about some aspect of your job, two notices that a red minivan's lights are on, confirmation that the book you bought on-line has shipped, and fifty other similarly random messages.

Little by little, your trickle turned into a flood, and now you are gasping for air.

Does this sound like you? If so, cheer up—you've come to the right place. This book will save your time and perhaps your sanity. Some techniques might require a little bit of work at first, but they will be worth it over time.

If you don't get this much email, count yourself lucky—for now. This book will show you how to keep from getting overwhelmed in the future.
Who Is This Book for?

This book is for anybody using Outlook 2000 or Outlook 2002 for Windows who wants to spend less time on email. While you need to know a few very basic things, you do not need to be an expert on Outlook. This book explains all the advanced features that you need to know—and doesn't waste your time explaining every single possible thing you can do with Outlook.

Even if you are an Outlook power user, this book will still be useful. Sixty percent of the book is on email strategies, not which button to push or which menu to pull down. If you wanted to compare it to a book on writing, it would be more like Effective Business Communication than like Mastering WordPerfect 7.3.2 in Ten Easy Steps Unleashed.

When there is more than one page of “buttons and menus” instruction, I give the page number of the next strategy section. This lets you easily skip over material you already know.

I do presume that you already:

- can send and receive email messages
- can add use the address book to make Contacts and Personal Address Lists
- know how to use the Global Address List (if you use Exchange)
- can use the Find and Advanced Find tools
- can open a message in its own window

If you need a more basic book right now, you might try Microsoft Outlook 2000 Step by Step by Catapult, Inc. or Microsoft Outlook 2000 For Windows For Dummies by Bill Dyszel. After you've mastered the basics, you can come back to this book.

If you are a teacher, you will find this book suitable for classroom instruction at many levels. The language in the book is easily accessible, even for teenagers. On the other hand, its deconstructions of the medium can be jumping-off points for collegiate classroom discussions. Homework exercises are available at

http://www.OvercomeEmailOverload.com/exercises/
Outlook Versions

There are a number of different versions of Outlook. This book cannot cover them all.

Outlook 2000 vs. Outlook 2002

Outlook 2002 is so similar to Outlook 2000 that almost everything in this book is the same for the two versions. I point out differences as they appear. (If you want a quick summary, see the Index entry for Outlook versions, differences between 2000 and 2002.)

Almost all of the illustrations show Outlook 2000 windows. If there are purely cosmetic differences between an Outlook 2000 window and an Outlook 2002 window in appearance (such as differences in shading) I don't mention it. If there is additional text or a button that doesn't have to do with the example, I mention the difference but don't show a picture. If there is a difference that is important to the example, I show pictures of both.

If You Use Outlook 97 or Outlook 98

If you are using Outlook 97 or Outlook 98, large sections of the book apply to you (especially Chapter 5 onward). However, there are some key features that Outlook 2000 and Outlook 2002 have that earlier versions don't have. Some of the advice (particularly in Chapter 2 and Chapter 3) doesn't apply to Outlook 97 or Outlook 98. For more information on the differences, see

http://www.OvercomeEmailOverload.com/outlook/outlook9x.html

If You Use Outlook Express

Despite the similarity in the names, Outlook Express and Outlook are completely different programs. Outlook Express has a different user interface, different rule conditions and actions, a mailing list manager, and no voting buttons. This book applies to Outlook Express only slightly more than the Eudora version of this book does.
If You Use Outlook 2001 for Mac OS or Entourage

Outlook 2001 for Mac OS is similar to Outlook 2000 and Outlook 2002 for Windows, but there are some key differences. Unfortunately, publishing priorities prevented me from including Outlook 2001 instructions. For information on how the Mac OS and Windows versions differ, see

http://www.OvercomeEmailOverload.com/outlook/mac.html

While Entourage and Outlook 2001 fill similar roles, they are very different programs. Entourage is much more similar to the Mac OS version of Outlook Express than to any of the Outlook versions.

Overview of This Book

Here's a preview of what you will learn in each chapter.

This book starts by explaining rules—instructions that you can give to your email program to organize and prioritize your messages automatically. Chapter 2 and Chapter 3 are by far the most technical of the chapters, but also the ones that I believe are the most useful. When I started using rules, I was able to get through my email messages in half the time it took before.

• Chapter 2, Organize and Prioritize Your Messages, gives strategies for grouping messages, shows how to create rules, and gives strategies for showing a message's importance.

• Chapter 3, Useful Rule Recipes, is a “cookbook” that gives practical examples of rules.

Next, the book shows how to move through messages more quickly. Finding and viewing one message in Outlook doesn’t take much time, but it’s something you do over and over. A little bit of time saved on each operation can add up quickly. This chapter shows how to take best advantage of the tools that Outlook has.

• Chapter 4, Move Through Your Messages Quickly, shows keyboard and mouse shortcuts for navigating through your messages more efficiently.
The book proceeds to show how to save time reading and responding to messages.

- Chapter 5, *Reduce the Number of Incoming Messages*, gives strategies for reducing the number of messages you get.
- Chapter 6, *Spend Less Time on Responses*, shows how to cut down on the amount of time you spend composing replies, while still being responsive to the messages that matter.

Another way to reduce the number of incoming messages is to *write* better messages. A miscommunication means more work for you—which almost always means more email. Reducing your load by writing well is such an important topic that it’s split into four chapters:

- Chapter 7, *Reduce Ambiguity*, shows how to make the context of your messages more clear.
- Chapter 8, *Convey Emotional Tone*, gives strategies to make a message’s emotional tone more clear.
- Chapter 9, *Make Messages Legible*, shows how to send messages that your correspondents can read easily.
- Chapter 10, *Get and Keep Attention*, shows how to improve the chances that your correspondents will notice, understand, and reply to your messages.

At some point, regardless of how well you manage your own email, you’ll be limited by your coworkers’ email habits. The chapters conclude with:

- Chapter 11, *Improve Your Company’s Email Effectiveness*, which discusses techniques for improving email efficiency for your whole organization.

The Appendices contain some material that is helpful, but not immediately related to overcoming email overload.

Appendix A has an extensive glossary. I define almost all technical terms, abbreviations, and jargon the first time I use them, but I realize that you might not read the whole book straight through. I also don’t define some of the more elementary terms. Finally, the *Glossary* defines some email terms that this book doesn’t use, but that you might see in other places.
Visual Basic is a programming language that is tightly integrated with Outlook 2000. Visual Basic scripts and macros can add many capabilities to Outlook 2000, but it also makes it more vulnerable to macro viruses. Appendix B, Visual Basic Scripts, discusses things to watch out for in macros and how to install them.

**Notation, Terminology, and Simplifications**

Please take a moment to read about the notation and terminology. Understanding the notation and terminology will make the explanations easier to follow.

Sections that mainly cover which buttons to push and which menus to pull down have section headers that start with “How to…”

I use a fixed-width Monaco font for anything that you or your correspondents type. I use variable-width Helvetica font for anything that Outlook displays—menus, buttons labels, explanatory text, and so on.

If you need to select something from a menu, I use arrows (→) to show the order of the menu selection. For example, if I tell you to select Tools → Options..., that means that you should first select the Tools menu, then select Options... from the choices that appear.

Anything in a double-box is a rule (covered in Chapter 2 and Chapter 3). Here is an example:

| Apply this rule after a message arrives |
| from roses-talk@rosegardens.org |
| move it to the RoseGardening folder |

Pictures of what you see on the screen don’t reproduce particularly well and have a lot of unimportant details. I therefore usually show email messages as text instead of as a screen shot:

| To: receiver@catfloss.org | From: sender@catfloss.org |
| **Subject:** This is a header | **Cc:** |
| This is the body of an example message. |
I usually leave out signatures in examples and frequently leave out greetings. Greetings and signatures are useful, but they take up space that I’d rather use for explanations.

**Tips**

I put short pieces of advice that are particularly important or don’t fit in the flow of the text into TIP boxes, like this:

**TIP:** To mark a message as Read, type Control-q.

**Additional Material**

While I only have a limited amount of space in this book to cover material, the Web is limitless. There is additional material at this book’s Web site, including a list of errors found after printing, a bibliography, presentation aids, updates, and examples:

http://www.OvercomeEmailOverload.com/outlook/

**Examples**

Many of this book’s examples deal with personal email. I know that many companies do not allow personal email, but examples about database upgrade projects would bore you.
Summary

- This book is for non-technical people who have some experience with email already, use it mostly at work, and would like to get through it faster.
- This book covers rules, navigating more efficiently, reducing the number of incoming messages, spending less time on responses, writing clearer messages, and improving your organization’s email culture.
- Words in fixed-width Monaco font represent text that you type. Words in variable-width Helvetica font represent text that Outlook displays.
- To save space in examples, I don’t show signatures unless they help clarify the example. I frequently leave out greetings as well.
CHAPTER 2

**Organize and Prioritize Your Messages**

If you are like most people, you go through your messages in the same order that they arrived. This can be very inefficient: you can spend so much time on a low- or medium-priority message that you don’t get to a time-critical message until it’s too late.

Perhaps you skim the subjects and guess which messages are important and which aren’t. Unfortunately, relying on your eyes and memory can be dangerous. You might see an urgent message that distracts you enough that you forget to go back and deal with an important but less-urgent message. You might even overlook an important message completely.

Think about how you handle your paper mail. You undoubtedly sort your paper mail quickly before you read it. Having messages categorized helps you figure out what to look at first, what to read later, and what to ignore.

Prioritizing your email messages can help as much as prioritizing paper mail. If your messages are sorted into groups of related messages, then you can:

- **Match your response speed to message priority.** You can look at high-priority groups of messages often and ignore low-priority groups until you have a free moment. For example, you might want to examine messages from your closest coworkers the moment the messages arrive but wait until the end of the day to read through a company-wide announcements list.
• **Remember discussions.** If you read all the messages on a topic one after another, you are likely to remember what was in earlier messages on that topic. If a lot of unrelated messages separate two related messages, you might not understand the later message without re-reading the earlier one.

• **Judge the amount of traffic on a topic.** Grouping related messages together makes it easy to see how many new messages on a particular topic have arrived. The number of related messages can give you a clue about what action you should take. Suppose, for example, that someone sends a message that asks a question. If you see a lot of responses to that message, someone else has probably already answered the question. You will then know to read all the responses before replying, instead of composing a response right away.

• **Move through your messages more quickly.** Selecting messages out of order from the list of messages is much slower than moving to the next message. To use the techniques in Chapter 4, *Move Through Your Messages Quickly*, your messages must be in priority order.

Fortunately, Outlook has tools that can organize and prioritize messages for you. These tools—called rules—take actions based on conditions that you set. For example, you could set up a rule to assign all messages from your boss to the category named Boss. Setting up rules is probably the single most important step to take to regain control of your email.

This chapter gives strategies for prioritizing, discussing how to:

• group related messages with categories
• view messages grouped by category
• configure rules in Outlook
• test your rules
• organize your messages with multiple accounts

This chapter is by far the most technical chapter of the whole book. But while rules might look intimidating at first, they aren't actually very difficult. If you can follow written directions to bake a cake or change a sparkplug, then you can set up rules.
Set up Your Categories

You might be tempted to use rules to move messages to different folders. However, most people have a hard time keeping track of messages that they haven’t finished with yet if those messages are spread across many folders.

For messages that are not likely to turn into “to-do” items—like junk email or distribution list messages—you can probably get away with moving them into folders. However, for most types of messages, it’s better to prioritize with categories. Assign a prioritized category to all your incoming messages, sort your Inbox by category, and remove messages from your Inbox when you have finished with them. This lets you see all of your “to-do” messages quickly and in priority order.

Giving each of your projects its own category is usually not a good idea. In addition to requiring many categories, this strategy guarantees that some email messages will be difficult to categorize. Email messages that mention two different projects could go in either project’s category. Furthermore, categorizing based on project is very difficult to do automatically. Computers are still a lot dumber than humans: they don’t do a good job at figuring out what a message means.

It is much easier to categorize based on what group the sender belongs to. There is always one and only one sender of a message, and people usually fit into relatively well-defined groups in your life. Your groups might include:

- coworkers in your immediate group (including your boss)
- other people in your company
- relatives
- friends
- fellow members of volunteer organizations
- various distribution lists that you’ve subscribed to (both work and personal)
- retailers that you have a relationship with
- retailers who are trying to get your business (junk email)
- automated response programs (such as order confirmations or account information)
While distribution list messages can be from many different people, I think of the messages as being “from” the distribution list. They are easy to group together because they are usually to the same address.

I make an exception for jokes and do not categorize by sender. Usually the sender didn’t write the joke, and it almost never has anything to do with your relationship to the sender. Furthermore, jokes almost always are low-priority and don’t need a response. If your rules can tell that a message is a joke, your rules should put it in a jokes-only category, regardless of who sent it.

Be careful that you don’t have too many categories. Don’t categorize the same way that you would file papers! Finding an old paper memo can take so long that retrieval time is much, much more significant than filing time. It makes sense to have lots of file folders for paper. But with Outlook’s sorting and searching tools, it’s much faster to find old messages, so filing speed is much more significant than retrieval speed. This means you don’t need many categories: five to twenty is probably about right.

Here’s an example of how someone might set up her categories. Assume that Mabel Garcia is a recreational skydiver, the payroll manager at Floss Recycling Incorporated, and likes to grow roses. She might have these categories:

- **Husband**—messages from her husband
- **Family**—family correspondence
- **Payroll**—messages from colleagues in the payroll department
- **Coworkers**—messages from coworkers who are not in the payroll department
- **Announce**—company-wide announcement distribution list
- **Friends**—messages from friends
- **ParachuteJumps**—parachute jump announcement distribution list
- **Roses**—rose gardening distribution list
- **Parachuting**—general skydiving distribution list
- **ConfirmationsUpdates**—merchandise order confirmations
- **Humor**—jokes
- **ProbableJunkEmail**—junk email
Category Order

As you will see shortly, when Outlook groups by category, the categories are listed in alphabetical order—which usually isn't the same as your priority order. Mabel might not want her jokes (Humor) listed before her payroll department messages (Payroll). To change the order of your categories, put a letter in front of the category name:

<table>
<thead>
<tr>
<th>Without Letter</th>
<th>With Letter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Announce</td>
<td>a-Husband</td>
</tr>
<tr>
<td>ConfirmationsUpdates</td>
<td>b-Family</td>
</tr>
<tr>
<td>Coworkers</td>
<td>h-Payroll</td>
</tr>
<tr>
<td>Family</td>
<td>i-Coworkers</td>
</tr>
<tr>
<td>Friends</td>
<td>j-Announce</td>
</tr>
<tr>
<td>Humor</td>
<td>m-Friends</td>
</tr>
<tr>
<td>Husband</td>
<td>p-ParachuteJumps</td>
</tr>
<tr>
<td>ParachuteJumps</td>
<td>q-Roses</td>
</tr>
<tr>
<td>Parachuting</td>
<td>r-Parachuting</td>
</tr>
<tr>
<td>Payroll</td>
<td>w-ConfirmationsUpdates</td>
</tr>
<tr>
<td>ProbableJunkEmail</td>
<td>y-Humor</td>
</tr>
<tr>
<td>Roses</td>
<td>z-ProbableJunkEmail</td>
</tr>
</tbody>
</table>

Why aren't the letters consecutive? (For example, why doesn't Payroll start with e-instead of h-?) Because at some point, Mabel might want to add a new category in between two old categories. If she leaves a few letters unassigned, she can use an unassigned letter for the new category instead of having to reassign all of the letters and re-categorize all her messages.
By alphabetizing your categories well and using a View that groups by Categories, you will see your messages in priority order, as shown in Figure 1:

Figure 1: Group by Category

How to Make a View Grouped by Category

You might not have ever made a View that groups by category, so this section shows how. If you already know how to create views, you can skip to “Outlook Rules” on page 36.
To set up a view, select View➝Current View…➝Define Views…. You will see a window like the one in Figure 2. Click on the button marked New… shown by the arrow in the upper right:

![Define Views](image)

Figure 2: Define Views

You will see a window like the one in Figure 3. Give the view a name, keep the Type of new view as Table. Select the button labeled All Mail Folders in Outlook.
2000 and All Mail and Post Folders in Outlook 2002 as indicated by the arrows in Figure 3 and Figure 4:

**Figure 3: Create a New View (Outlook 2000)**

**Figure 4: Create a New View (Outlook 2002)**
Click OK when you’ve finished, and you’ll see a window like the one in Figure 5:

![Figure 5: View Summary](image)

Click on the button marked Group By… indicated by the arrow.

In the next window, select Categories under group items by, as shown by the longest arrow in Figure 6:

![Figure 6: Group By](image)
If you want to see the categories as a column in the View, put a check in the box next to Show field in view as shown by the short arrow in the upper left of Figure 6.

Groups can be expanded and collapsed in much the same way that you can expand or collapse folders by clicking on the + or - next to the folder name. You probably want Outlook to remember for you which groups were expanded and collapsed, so in the box marked Expand/collapse defaults, select As last viewed, as shown by the arrow in the lower right of Figure 6. Click OK to finish.

I don’t like the grey bars that act as group headers in the list of messages. To make the background of the bars white instead of grey, click on Other Settings… in the View Summary (Figure 5). You will see a window like Figure 7:

![Figure 7: Unshade Group Headings](image)

Remove the checkmark in the box next to Shade group headings as indicated by the arrow, click OK, and you’re almost done. Select your new View from the View menu to activate it.

**Outlook Rules**

Now that you can view by category, it’s time to categorize. This section shows how to set up rules in Outlook to categorize for you automatically. If you already know
how to make rules in Outlook, you can skip to “Exchange Rules vs. Outlook Rules” on page 55.

When you become so rich and famous that you get a flood of paper mail, you will probably hire somebody to sort your mail. You'll ask him or her to put all your greeting cards in one box, all the bills in another box, all junk mail in the trash, and so on.

Rules can do similar sorting actions. Mail room clerks, however, are much smarter than computers, so you have to be much more precise with a rule. You could tell a mail clerk simply, “Put all junk mail in that box.” With a rule, you have to say something like “When the envelope’s finish is glossy, put that piece of mail into the box marked ‘Junk’.” In addition, a single rule can’t handle too much at once. It’s as if you had to have one clerk to pick out junk mail and a different clerk to pick out bills.

“Real-World” Rules

To help ease into how to set up your rules, let’s first spend a page writing instructions for mail room clerks. For each instruction, you need to tell your clerks what action to take and under what conditions to take it. In the example above, if a letter arrives

```
with a glossy finish on the envelope
```

then you want the mail room clerk to

```
move it to the JunkMail box
```

Or, combining the condition and the action:

```
After a letter arrives
with a glossy finish on the envelope
move it to the JunkMail box
```
Email rules are very similar to these mail room clerks. You just have to tell them (carefully) what you want them to do.

How to Create Outlook Email Rules

When you create rules for email, you can't use the same type of rules as you'd give a mail clerk. Email messages don't have envelopes or handwriting to give clues about the message's nature. However, rules can check specific words or phrases in the message. This is a very powerful capability.

For example, if Mabel wants to do something with all messages from Andy Jain, she can set up a rule like this:

after a message arrives from Andy Jain, assign it to the h-Payroll category

To create this rule, select Tools → Rules Wizard. The first Rules Wizard page will appear as in Figure 8 in Outlook 2000:

Figure 8: Rules Wizard Start Page (Outlook 2000)
In Outlook 2002, there is a text box above Apply rules in the following order: that is labeled Apply changes to this folder: as shown by the arrow in Figure 9. Don't worry about that text box.

![Figure 9: Rules Wizard Start Page (Outlook 2002)](image)
To make a rule that looks for messages from Andy Jain, Mabel first needs to click on the New... button in the Rules Wizard Start page. If she is using Outlook 2000, she will see a page like the one in Figure 10:

![Rule Wizard Rule Creation Page (Outlook 2000)](image)

Figure 10: Rule Wizard Rule Creation Page (Outlook 2000)

The top pane has a number of common types of rules, but none that is exactly what Mabel wants. To create a custom rule, Mabel must select Check messages when they arrive and click on the Next > button.
If Mabel is using Outlook 2002, she will see a page like the one in Figure 11.

![Rule Wizard Rule Creation Page (Outlook 2002)](image)

**Figure 11: Rule Wizard Rule Creation Page (Outlook 2002)**

With Outlook 2002, Mabel must first select **Start from a blank rule**, as shown by the arrow in Figure 11. Then she can select **Check messages when they arrive** as with Outlook 2000. To finish, she must click on the **Next >** button.
A new window that lists a number of conditions will appear. This is where Mabel specifies which messages she wants the rule to take action on.

![Figure 12: Rules Wizard Conditions Page](image)

Mabel can choose from an enormous variety of conditions. In this case, Mabel needs to scroll down to find from people or distribution list, and check the box to the left, as seen in Figure 12. That will make the sentence from people or distribution list appear in the lower box.

Note that the Outlook 2002 windows work the same, but look slightly different. In the Rules Wizard Conditions page, for example, the Outlook 2002 window is taller than the Outlook 2000 window. Thus, more conditions are visible. In addition, the conditions are in a slightly different order between Outlook 2000 and Outlook 2002. Several other Rules Wizard pages have taller windows and differently-ordered lists, but I won’t bore you by pointing those differences out again.
If you use Microsoft Exchange, there are extra conditions in the Rules Wizard Conditions Page.

**TIP:** To find out if you are running with an Exchange server or not, select the Tools menu. If the Tools menu has an menu item for Out of Office Assistant, you are using Exchange. If there isn’t an menu item for Out of Office Assistant, you are not using Exchange.

Just like in a Web browser, clicking on underlined words makes something happen. In this case, if Mabel clicks on *people or distribution list* in the lower pane, she gets to choose who to look for in the From field, as shown in Figure 13.

![Figure 13: Specifying Correspondents](image)

On the Outlook 2002 version of this page, the address book menu (labeled Contacts in Figure 13) is to the right of the Find… button instead of below it. Also, Outlook 2002 shows the email address as well as the person’s name.
To look for messages from Andy, Mabel needs to select the Andy Jain entry (as shown in Figure 13) and click From ->. This will put Andy in the right-hand list, as shown in Figure 13. Clicking OK returns Mabel to the Rules Wizard conditions page. There, clicking on Next > will take her to the actions page.

On the actions page, Mabel must tell the Rules Wizard what to do with messages that match the conditions that she just specified:

![Rules Wizard Actions Page](image)

**Figure 14: Rules Wizard Actions Page**

In this example, Mabel wants to assign the messages to the h-Payroll category, so she needs to put a check in the box next to assign it to the specified category, then change specified to h-Payroll.

Clicking Next > on the actions page brings up the exceptions page, where she can specify exceptions to her rule. For example, if Mabel doesn't want to put Andy's
Out-of-Office messages into the h-payroll category, she should add an exception for that, as shown in Figure 15:

![Figure 15: Rules Wizard Exceptions Page](image)

In the last Rules Wizard page, you can name the rule. Sometimes giving a rule a different name from what Outlook gives it can make its purpose more clear.

![Figure 16: Rules Wizard Finish Page (Outlook 2000)](image)
The Outlook 2002 Rules Wizard Finish Page has an additional checkbox below Turn on this rule. The extra checkbox is labeled Create this rule on all accounts, as shown by the arrow in Figure 17:

![Rules Wizard Finish Page](image)

**Figure 17: Rules Wizard Finish Page (Outlook 2002)**

If you have multiple accounts and there is a checkmark in this box, this rule will run on all messages, regardless of which account they were sent to. Usually, you will not want all rules to run on all accounts. For example, if Andy sends a message to Mabel’s personal account, it probably isn’t about Payroll Department business. On the other hand, rules to get rid of junk email will probably be the same for all of your accounts.

From the Rules Wizard Finish Page, Mabel has the option of running this rule on messages already in her Inbox. It’s a good idea to test rules right away to make sure that it does what you want without unpleasant side-effects. If you wait until later, you might forget exactly what you were trying to do. (For more on testing your rules, see “How to Test Your Rules” on page 57.)
How to Modify Rules

Most of your rules will have the same basic form. It will frequently be easier to create a new rule by copying and modifying an existing rule, than by going through all the Rules Wizard conditions, actions, exceptions, and finish pages.

After you have created a rule, you can modify it easily from the Rules Wizard Start page by clicking on underlined words.

![Rules Wizard](image)

**Figure 18: Rules Wizard Start Page with “From Andy” Rule**

For example, suppose Mabel wants to put messages from anyone in the Payroll Department—not just Andy—into the h-Payroll category. Mabel can click on Andy Jain on the Start page (as seen in Figure 18) to add other Payroll department members.

If your company uses Exchange as its mail server, you could be tempted to add distribution lists from the Global Address List to the list of senders. However, Outlook 2000 and 2002 do not expand global distribution lists the way you might expect. If, for example, you add a distribution list named All Employees
to the list of senders, the rule will only catch messages that come from an account named “All Employees.” It will not catch messages from Andy Jain, even if Andy is listed in All Employees. Rules that look for messages to a global distribution list work well, but looking for messages from one does not.

Outlook lets you use your personal Contacts lists, but Outlook will convert it to a collection of people who are in that distribution list at that moment. If you add or remove people from a distribution list, that will not update any rules.

For example, suppose Mabel sets up a rule condition that looks for messages from people in her payroll list. If she later adds Maurice Resevak to her payroll distribution list, messages from Maurice will not get caught automatically by that rule. Mabel must add Maurice to the rule condition separately.

Find Frequent Correspondents with “Sender in Address Book” (Outlook 2002 Only)

Outlook 2002 lets you create rules that check to see if the message’s sender is in a specific Address Book. This is an extremely good way to find messages from a particular group of people. For example, Mabel could put everyone in the Payroll Department into the address book named h-Payroll, then create a rule like this:

```
  after a message arrives
  if sender is in h-Payroll Address Book
  assign it to the h-Payroll category
```
The rule will look like this when Mabel is done:

![Rules Wizard dialog box](image)

**Figure 19: Rule with Sender in Address Book (Outlook 2002 Only)**

**TIP:** To create a new address book, first select File ➝ New ➝ Folder. Give a name for the new address book, select Contact Items in the box labeled Folder contains, and create the folder under the Contacts folder.

**More Conditions**

The Rules Wizard can look at more than just who a message is to and from. For example, you can tell the Rules Wizard to look for words and phrases in the subject or body of the message.
Suppose that Mabel’s company frequently provides food for meetings, and leftovers are announced on a building-wide distribution list. Mabel might not care about messages about leftover food. She could make a rule that assigns messages that have food in the subject line to a low-priority category.

However, Mabel needs to be a little careful. If the rule looks for food, then it could catch messages that Mabel cares about. For example, if Mabel might want to see messages that ask what food she wants at the holiday party.

If the unwanted messages usually have a subject like

Subject: food in conference room C3

then her rule would be better if it looked for the phrase food in instead of just food. Frequently, looking for a longer phrase makes a condition more accurate.

Other useful conditions that Outlook rules can check for include:

- where my name is not in the To box
- flagged for action
- assigned to category
- which is an Out-of-Office message
- which has an attachment

How to Prioritize with Advanced Rule Actions

By this point, you have learned the basics of organizing your messages with rules. This section’s advice, while useful, isn’t as critical as the sections you’ve already read. If you are in a hurry, you can skip to “Rule Order” on page 54 for now.

In addition to assign it to the specified category, there are several rule actions that can help make messages’ importance even more obvious. You probably won’t use most of the actions available, but this section discusses three that are useful: marking a message’s importance, playing a sound, and moving it to a folder.
TIP: One action that I do not think you should use is delete it. If you automatically delete messages, someday your rules will delete a message that you care about. It is much better to move suspected junk email to a mailbox, so you can occasionally look through the mailbox for misfiled messages.

How to Make Importance More Obvious by Changing the Importance Level

When someone sends you a message, they can attach a importance level to it. These importance levels usually reflect the priority that the sender thinks a message should have. A red exclamation mark (!) in the list of messages shows that a message has been marked with high importance. Blue down arrows (↓) indicate messages that have been marked with low importance.

Your rules can override the importance level of messages. The advantage of overriding the importance level is that the new importance level is more likely to reflect your opinion of the message’s true importance. The disadvantage is that you can’t tell what the sender thought the importance level was. Frequently, however, the sender’s opinion of the importance level is very different from your opinion, so you might not mind.

You might want to lower the importance level of anything marked FYI (For Your Information). You need to set up the rule

```plaintext
Apply this rule after a message arrives
when FYI appears in the subject
mark it as low importance
```
as shown in Figure 20:

![Rules Wizard screenshot](image)

**Figure 20: Lowering the Importance for FYI messages**

**How to Hear Priority by Playing Sounds**

If your rules play sounds, you can hear what kinds of messages come in. Even if you are not focusing on your computer, you can still tell if a high-priority message comes in. If a message from one of your low-priority distribution lists arrives, you can hear that you don't have to put aside what you're doing to read it. If a message from your boss arrives, you'll know to pay attention to it.
It helps if the sound has some connection to the topic. This will help you remember what a noise means. For example, you might associate the following noises and message types:

- old-fashioned cash register ring or credit card slider sound for sale confirmations
- laughter for jokes
- rude noises for junk mail
- wedding bells for messages from your spouse.

**Figure 21: Play Sound example**

**TIP:** If your coworkers can hear every noise that your computer makes, they might get annoyed if you attach sounds to your messages. Use headphones or don’t play sounds.
If you have your rules play sounds, make sure that the sounds are very short—shorter than the time it takes to say the phrase “rule action.” Your sounds will play over and over, and you will get tired of waiting for long sounds to finish.

How to Hide Low-Priority Messages by Moving to a Folder

While I believe it is easier to keep track of your to-do items if they are all in your Inbox, there might be a lot of messages that you get that don’t turn into to-do items. Moving those low-priority messages into other folders can make it easier to see your to-do items.

The most obvious example of low-priority email is unsolicited commercial email, but you might also get low-priority informational messages. For example, you might want to move order confirmations or subscription information out of the Inbox.

Some people like to move messages to folders to group them instead of assigning a category. As long as you can keep track of your to-do items, that’s an okay strategy. (In “Separate ‘To-Do’ Messages from ‘Done’ Messages” on page 93, you will learn more about filing “to-do” messages quickly.)

To move a message to a folder with a rule, you need to give the rule the action move it to the specified folder.

Rule Order

The order of rules is important. Except for a few situations discussed in “Exchange Rules vs. Outlook Rules” on page 55, Outlook runs rules in the order that they appear in the Rule Wizard. For example, suppose Mabel has the rules shown in Figure 20 on page 52. A message from Andy Jain about food in a conference room would get caught first by the leftover food rule (assigning it to the z-ProbableJunkMail category) and then by the payroll rule (assigning it to the h-Payroll category). Thus the food message ends up with two categories—not what Mabel wanted!
To stop Outlook from running a message through later rules, scroll down to the very bottom of the Rules Wizard Actions page and check the box next to stop processing more rules, as seen in Figure 22:

![Stop Running Rules](image)

Figure 22: Stop Running Rules

You almost always should stop running rules any time that Outlook categorizes a message, either by assigning it to a category or by moving it to a folder.

**Exchange Rules vs. Outlook Rules**

If you are using an Exchange mail server, some of your rules will run on the server. This is a useful feature: some of your rules can run regardless of whether or not your desktop computer is on.

This has the side effect, however, that the order that rules run is not always the same as the order they’re listed in the Rules Wizard. Suppose there is a message that matches the conditions in one Outlook rule and one Exchange rule, with the Outlook rule appearing before the Exchange rule in the list of rules. Unless there is a stop processing more rules action in the Outlook rule, the Exchange rule will run first. I haven’t been able to figure out a situation where this would be a problem, but I thought I should let you know just in case.
A rule will run on Exchange unless it has an Outlook-specific action or condition. Outlook-specific actions include:

- assign it to the category category
- play a sound
- clear the Message flag
- flag the message for action in a number of days
- permanently delete it
- notify me using a specific message
- reply using a specific template
- start application
- run this script function
- perform a custom action

Outlook 2002 has one additional Outlook-specific action:

- start application

The conditions (and exceptions) that will force a rule to run on Outlook are:

- suspected to be junk e-mail or from Junk Senders
- containing adult content or from Adult content senders

Outlook 2002 has two additional Outlook-specific conditions and exceptions:

- received through the specified account
- on this machine only
You can also tell which rules run on Outlook by looking at the Rules Wizard’s list of rules. If Exchange is your mail server, if the rule is followed by (*client only*), then it will run on Outlook. If it doesn’t say (*client only*), then it will run on Exchange. If Exchange is not your mail server, the rules will never say (*client only*).

**How to Test Your Rules**

It is a good idea to test your rules when you set them up. If you make a mistake, your rules someday could put an important message into a category with such a low priority that you don’t look at it in time.

Outlook will let you run a message through your rules at any time. This is extremely useful for finding problems with your rules’ setup. You can test your rules by running **Run Now...** from the **Rules Wizard** start page, as shown in Figure 23:

![Figure 23: Run Now](image)

This is a good way to test your rules. If a rule doesn’t seem to be doing what you think it should, try running just that one rule.
Problems with Contact Names

In order for a rule to match a contact, the person's name must match exactly. If a message comes from “Andy Q. Jain” instead of “Andy Jain”, Mabel's rules will not put it into h-Payroll, even if the email address is andy@flossrecycling.com for both. Usually people’s names don’t change much. However, if someone uses two different email programs or two different email accounts, their messages might have two slightly different names. If you find that someone’s messages aren’t always filed properly, you can look for the email address(es) in the sender’s address:

```
Apply this rule after the message arrives
with della@facelessnessity.com in the sender’s address
  or della@deladuck.com in the sender’s address
assign it to the m-Friends category
```

Messages to distribution lists that include people outside your company are likely to have many different versions of the To line. Thus for Internet distribution list rule conditions, it is much safer to look for phrases than for contacts. (Distribution lists are covered in more detail in “Reduce the Number of Distribution List Messages” on page 100.)

Note that “the sender’s address” means the sender’s email address. For example, Mabel wouldn't find messages from Andy if she looked for Jain in the sender’s address. Jain is his last name but doesn't appear in andy@flossrecycling.com.

Problems with HTML Messages

Messages with different colors, fonts, and/or images are usually written in HTML—HyperText Markup Language—which is the “native language” of the Web. Outlook rules have some difficulty with HTML documents, and sometimes (not always!) can’t recognize words in the document. If, for example, you have a rule like this:

```
Apply this rule after the message arrives
with Make Money Fast in the subject or body
assign it to the z-ProbableJunkEmail category
```

58 Organize and Prioritize Your Messages
and an HTML message that contains “Make Money Fast”, the message might not end up categorized as z-ProbableJunkEmail. It’s not your fault, and there isn’t anything you can do about it.

**Group Messages by Using Multiple Accounts**

If setting up rules looks like too much work for you to do right now, you can use multiple email accounts to group your messages. You can frequently check the accounts that you use for higher-priority topics and only occasionally check your low-priority accounts.

In the past, having multiple email accounts was very expensive, but there are now numerous free Web-based email services. Furthermore, many of the Web-based services block junk email.

However, there are significant disadvantages to using free Web-based accounts:

- You have to check each account.
- Free services usually make you look at advertising.
- Free services usually limit how many messages you can keep or how much disk space you can use.

If you step through the instructions in Tools→Accounts→Mail→Add, you can configure Outlook to check messages from several accounts. That makes it easier to check messages. However, you still have to routinely switch between your different accounts. The more accounts you have, the harder it is to remember which you are using at any given moment.

You probably want to have very few accounts—probably less than five. I recommend using three accounts: your work account, a personal account, and an account for junk mail.
Personal Accounts

Separating your work and personal email is one of the best things you can do. Besides making it easier to concentrate on work issues while you are at work, it has these benefits:

- If you suddenly lose your job, you won’t also lose the email addresses of all of your friends and family.
- Your personal email is more private. In some places, employers have the legal right to read email on your work computer at any time without your permission or knowledge. If someone sues your company, lawyers from both sides might end up reading all your company email—regardless of whether it is related to the suit or even your work.
- You are less likely to get in trouble for using company time and equipment for personal use.

If you get a personal account, always checking it from your work copy of Outlook eliminates many of these benefits. It’s better to use a web-based email system for your personal email or, if you have a computer at home, only download personal messages there.

Junk Mail Accounts

Junk mailers have programs that scan the Web for email addresses. If your email address gets onto a Web page in any way—if you put it on a Web page or if you post a message to a discussion group that is archived on the Web—junk mailers will find you.

Similarly, if you give a retailer your email address, they might send you advertisements in the future. They might also sell your address to other retailers. Even if they have a privacy policy that says that they won’t give your address to anyone else, the privacy policy isn’t guaranteed to continue if the company goes bankrupt. When a company files for bankruptcy, knowledge of your email address is considered part of the company’s assets and might be sold to pay off creditors.

Therefore, you should have at least one account for transactions that involve retailers or that can put your email address on the Web.
Summary

• Prioritizing and organizing messages can help you read email more efficiently.
• Categorizing messages by who sent them is a very efficient strategy.
• Changing the name of a category changes where its messages appears if the list of messages is sorted by category.
• Rules can automatically categorize your messages.
• The order of your rules affects the behavior.
• Exchange rules can sometimes run before Outlook rules, even if the Outlook rules are higher in the Rules Wizard's list of rules.
• You can use a distribution list from the Global Address List in your rules, but Outlook changes personal distribution lists into a list of the people currently in that distribution list.
• Outlook 2002 users can find groups of people easily with the with sender in address book rule condition.
• You can categorize messages simply and cheaply by using multiple accounts. Using multiple accounts isn't as complicated as setting up rules, but isn't as powerful.
• Test your rules by using the Run Now... feature.
• The rule condition from person or distribution list won't work unless the person's name matches exactly.
• Rules sometimes won't find words or phrases properly in HTML messages.
Rules are most effective when messages are very regular and predictable. Fortunately, most types of message have some regularity to them. This chapter shows examples of the regularity in several types of message and how to use that regularity to create useful rules.

This chapter is designed to be a “cookbook” for you to follow when setting up your own rules. Thus, you should save this chapter for a time when you are sitting at your computer. Skipping to Chapter 4 (on page 85) right now won’t hurt your understanding of later chapters.

Rule Order

As mentioned earlier, the order of rules is very important.

Putting your rules for distribution list messages near the beginning of the list of rules will help categorize messages properly for people who have two or more different roles. For example, suppose Mabel’s sister is on the roses-talk Internet distribution list. Mabel probably wants to keep her sister’s messages about roses with the other “roses” messages, not mixed in with messages about who is going to pick Mother up from the train station. Thus Mabel needs to put her “roses” rule before her “family” rule.

Be sure to put your unsolicited commercial email rules near the end of your rule list so that you don’t accidentally miscategorize important messages. For example, both junk email and Internet distribution list messages frequently contain instructions on how to unsubscribe. If your Internet distribution list
rules are before your junk mail rules, you can check for unsubscribe in a junk mail rule without the risk of treating your Internet distribution list messages like junk email.

Rules should handle messages in an order something like this:

- call attention to potentially dangerous executable attachments
- adjust importance level
- categorize jokes
- categorize distribution list messages
- categorize confirmation messages
- categorize messages from people you correspond with regularly
- categorize messages from other people you know
- categorize junk email
- file outgoing messages with related received messages

The “recipes” in this chapter appear in the same order that they should appear in Outlook’s rule list. Note that when you create a rule, Outlook puts it at the top of the list. Thus, your list will end up in the reverse order of how you created the rules. You might want to skim this chapter first, then work backwards through this chapter, creating the last rule first and first rule last.

Alternatively, you can import an example file with all this chapter’s rules. While you will still need to customize several of the rules, it is usually easier to customize rules than to start from the beginning. To load the file, follow the directions at:

http://www.OvercomeEmailOverload.com/outlook/rules.html

Because sounds are personal preferences and depend upon what sound files you have on your system, I didn’t put any in these rule recipes. Add sounds as you like.
Notation

Screen shots have inherently lower resolution than regular text and take up a lot of space. For that reason, I show all of the rules in regular text, similar to the recipes in ““Real-World” Rules” on page 37. Each rule recipe is double-boxed and looks something like this:

```plaintext
time rule is applied
condition(s)
action(s)
exception(s) (if any)
```

For example:

```plaintext
Apply this rule after a message arrives
with food in in the subject
assign it to the z-ProbableJunkEmail category
except if the subject contains ice cream
```

TIP: Don’t forget to test your rules, as discussed in “How to Test Your Rules” on page 57.

Space Limitation on Rules

If you use Exchange as your mail server, you only have 32Kb of space there for rules. This is room for about 30 to 50 rules, depending upon how complex the rules are. Note that with Exchange 2000, rules that are not active (in other words, that don’t have checkmarks next to them in the top list in the Rules Wizard Start Page, as seen in Figure 18 on page 47) don’t count against the 32Kb limit.

If you get a message that you have no further room for Exchange rules, you can move some of the rules to Outlook rules by adding an Outlook condition or action. (See “Exchange Rules vs. Outlook Rules” on page 55.

The rest of this chapter shows rules that you might create, using Mabel Garcia’s correspondence for the examples.
Find Potential Viruses

Executable files can be very dangerous, particularly for Outlook 2000 users. Because Outlook is so widely used and because it has such powerful scripting capabilities, it was especially vulnerable to viruses. While Outlook 2002 and later versions of Outlook 2000 are much less vulnerable to viruses, earlier versions of Outlook 2000 have numerous security flaws.

The “Service Pack 1” upgrade has significantly reduced the dangers of viruses in Outlook 2000. To see if your copy of Outlook 2000 is vulnerable, check Help→About Microsoft Outlook. If the revision number is SR-1 or SR-2, then you’ve gotten the upgrade. If you don’t have the upgrade, check with your information technology group about getting an upgrade. If you feel capable of upgrading your copy of Outlook by yourself, you can find the patch at:


If, for some reason, you can’t upgrade, you might want to use rules to quarantine any messages that have executable files attached or embedded Visual Basic scripts. (Visual Basic is a simple but powerful programming language that can control Outlook.) You can quarantine many suspicious messages with these rules:

<table>
<thead>
<tr>
<th>Rule 1</th>
<th>Rule 2</th>
<th>Rule 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply this rule after a message arrives with <code>.exe</code> or <code>.EXE</code> in the body and which has an attachment move it to the z-Quarantine folder and stop processing more rules</td>
<td>Apply this rule after a message arrives with <code>Vbs</code> or <code>VBScript</code> in the body and with <code>text/html</code> in the message headers move it to the z-Quarantine folder and stop processing more rules</td>
<td>Apply this rule after a message arrives with <code>Vbs</code> or <code>VBScript</code> in the body and with <code>TEXT/HTML</code> in the message headers move it to the z-Quarantine folder and stop processing more rules</td>
</tr>
</tbody>
</table>
This is not a replacement for anti-virus software! This will not catch all viruses; it's just one more weapon in the anti-virus arsenal.

When you create your quarantine folder, you should turn its Preview Pane off for security.

TIP: Even messages from people you know can have viruses in them. Be suspicious of all attachments.

If you are willing to load Visual Basic macros into your copy of Outlook, Sue Mosher developed a macro that does almost the same thing as the above rules, only better. It is available at:

http://www.slipstick.com/dev/code/quarexe.htm

See Appendix B, Visual Basic Scripts for how to load macros.

TIP: Note that the folder in the example has a z- prefix. Prefixes are just as useful for sorting folders as they are for sorting categories.
Adjust the Importance Level

One easy way to adjust a message's importance level is to look for common keywords that people use in message subjects.

You might want to lower the importance level of any messages with FYI: (For Your Information) or BTW: (By The Way) in the subject. These usually contain information that you don't need to respond to, like

<table>
<thead>
<tr>
<th>From: Marge Garcia</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: FYI: donuts in break room Cc:</td>
<td></td>
</tr>
<tr>
<td>The donut fairy left a dozen glazed donuts in the break room by conference room C2. Enjoy!</td>
<td></td>
</tr>
</tbody>
</table>

or

<table>
<thead>
<tr>
<th>From: Marge Garcia</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: BTW: donuts are stale Cc:</td>
<td></td>
</tr>
<tr>
<td>Don't bother getting up -- the donuts by C2 are extremely stale.</td>
<td></td>
</tr>
</tbody>
</table>

Therefore, you might enjoy this rule:

Apply this rule after a message arrives with FYI or BTW in the subject
mark it as low importance

You might want to raise the importance level for messages that request actions. These frequently have subject headers starting with REQ: or ACTION REQUIRED:

<table>
<thead>
<tr>
<th>From: Marge Garcia</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: REQ: new donut fairy Cc:</td>
<td></td>
</tr>
<tr>
<td>Please post a help wanted ad for a new donut fairy.</td>
<td></td>
</tr>
</tbody>
</table>
Thus, you might want a rule like this:

Apply this rule after a message arrives
with **REQ:** or **ACTION REQUIRED:** in the subject
mark it as **high importance**

Messages that talk about urgent items frequently mention *what time* something is needed. For example:

<table>
<thead>
<tr>
<th>From: Marge Garcia</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: new donut fairy</td>
<td>Cc:</td>
</tr>
<tr>
<td>Mabel --</td>
<td></td>
</tr>
<tr>
<td>Please post a help wanted ad for a new donut fairy immediately!</td>
<td></td>
</tr>
</tbody>
</table>

You can use rules that find words relating to the near future to make those messages more urgent:

Apply this rule after a message arrives
with **today or tomorrow or ASAP or now or immediately** in the body
mark it as **high importance**

Alert readers might notice that the action in the above rules do not have “and stop processing more rules” at the end. The guideline I suggest is to stop after *Outlook puts the message into a group of related messages*. You might want to use a later rule to categorize the message.
Lower the Importance Level of Multiply Forwarded Messages

Occasionally, unsuspecting people will forward hoaxes, chain letters, or jokes to everyone that they know. (Chapter 5, *Reduce the Number of Incoming Messages*, discusses such nuisance messages in more detail.) Messages with many forwards are probably not a high priority:

From: Jessica Robinson  
To: Mabel Garcia  
Subject: Fwd: FW: Fwd: Fwd: dihydrogen oxide!!!!!!Cc:

>>>A friend of mine at the university told me that they’ve discovered dihydrogen oxide in every brand of coffee!  
>>>Send this to everyone you know and then stop drinking coffee!!!!

To help recognize such nuisance messages, look for combinations of Fw: and Fwd: and for multiple greater-than signs:

Apply this rule after a message arrives  
with FW: FW: or Fwd: Fwd: or Fwd: FW: or FW: Fwd: in the subject  
mark it as low importance

Apply this rule after a message arrives  
with >>> in the body  
mark it as low importance

Instead of lowering the importance level, you could assign multiply-forwarded messages to their own low-priority category. If you assign them to their own category, remember to put and stop processing more rules at the end of the actions.
Categorize Humor

Because jokes are so easy to redistribute by email, people do. If you're lucky, people will put `HUMOR:` at the beginning of the subject header. You can put those jokes into a low-priority category to read later:

```
Apply this rule after a message arrives
with `HUMOR:` in the subject
assign it to the `y-Humor` category
    and stop processing more rules
```

Sometimes you'll have one friend who forwards a lot of jokes to all his or her friends. You might be able to save the friendship with a rule like this:

```
Apply this rule after a message arrives
with `FWD:` in the subject
    and from Loretta Garcia
assign it to the `y-Humor` category
    and stop processing more rules
```

If the friend always sends the jokes to the same list of people, you could also try looking for a recipient that you never correspond with:

```
Apply this rule after a message arrives
with `froglet32@ueci-h.edu` in the recipient's address
    and from Loretta Garcia
assign it to the `y-Humor` category
    and stop processing more rules
```

Instead of assigning jokes to a category, you might want to move them into a special folder just for jokes. Jokes are not likely to become to-do items.
Categorize Distribution List Messages

Because distribution lists can generate an enormous number of messages, categorizing distribution list messages with rules can be very helpful. Fortunately, distribution list messages are usually very regular and so it’s easy to make rules for them.

Distribution lists almost always have the same addressee, so check for that address in the recipients list. For example, the rules below will categorize all of the messages on Mabel’s company announcements and rose gardening distribution lists:

| Apply this rule after a message arrives | sent to FRI-Announcements |
| assign it to the j-Announce category | and stop processing more rules |
| Apply this rule after a message arrives | with roses-talk@rosegardens.org in the recipient’s address |
| assign it to the q-Roses category | and stop processing more rules |

There are two kinds of distribution lists: those that are managed by an Exchange server and those that are not. (“Reduce the Number of Distribution List Messages” on page 100 covers those in more detail.) For distribution lists that do not use Exchange, it is much safer to use the condition

with specified words in the recipient’s address

than

sent to people or distribution list

If you use sent to people or distribution list, the name has to match exactly the name you give in the Contacts list. Unless everybody is working from the same Global Address List, the names might not match.
Categorize Confirmations and Updates

If you buy things online, you will sometimes get computer-generated notifications that orders have shipped, notices of upcoming sales, and so on. You might want to put all such messages into a special category:

Apply this rule after a message arrives
with fatbrain.com in the sender's address
assign it to the w-ConfirmationsUpdates category
and stop processing more rules

Apply this rule after a message arrives
with officemax.com in the sender's address
assign it to the w-ConfirmationsUpdates category
and stop processing more rules

Apply this rule after a message arrives
with roses-talk-listmom@rosegardens.org in the sender's address
move it to the w-ConfirmationsUpdates folder
and stop processing more rules

(For more on Internet distribution list confirmations, see “Internet Distribution List Administration” on page 102.)
Categorize Messages from Frequent Correspondents

There are probably groups of people that you correspond with so frequently that you should make separate categories for them. If you are using Outlook 2002, the best strategy for categorizing messages from groups of people is to make separate address books for each group of people, as discussed in “Find Frequent Correspondents with ‘Sender in Address Book’ (Outlook 2002 Only)” on page 48. Mabel could then use rules like these:

Apply this rule after a message arrives
when sender is in b-Family Address Book
assign it to the b-Family category
and stop processing more rules

Apply this rule after a message arrives
when sender is in h-Payroll Address Book
assign it to the h-Payroll category
and stop processing more rules

Apply this rule after a message arrives
when sender is in m-Friends Address Book
assign it to the m-Friends category
and stop processing more rules

Of course, if there is only one person in a group, it isn’t worth creating an entire address book for that one person. For Mabel to find messages from her husband, she should simply write her rule to look for him:

Apply this rule after a message arrives
from Charlie Yzaguirre
assign it to the a-Husband category
and stop processing more rules
If you use Outlook 2000, you must mention each person individually. For example, if Mabel uses Outlook 2000, she needs rules like these:

<table>
<thead>
<tr>
<th>Rule Description</th>
<th>Category</th>
<th>Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply this rule after a message arrives from Charlie Yzaguirre</td>
<td>a-Husband</td>
<td>Charlie Yzaguirre</td>
</tr>
<tr>
<td>assign it to the a-Husband category and stop processing more rules</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apply this rule after a message arrives from Loretta Garcia or Marge Garcia or Leon Garcia or Pierre Yzaguirre</td>
<td>b-Family</td>
<td>Loretta Garcia, Marge Garcia, Leon Garcia, Pierre Yzaguirre</td>
</tr>
<tr>
<td>assign it to the b-Family category and stop processing more rules</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apply this rule after a message arrives from Jeff Chee or Chantelle Williams or Wayan Li or Winston Thurd or Andy Jain</td>
<td>h-Payroll</td>
<td>Jeff Chee, Chantelle Williams, Wayan Li, Winston Thurd, Andy Jain</td>
</tr>
<tr>
<td>assign it to the h-Payroll category and stop processing more rules</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apply this rule after a message arrives from Jim Wilson or Priya Walkowski or Jessica Robinson or Andre Moretto</td>
<td>m-Friends</td>
<td>Jim Wilson, Priya Walkowski, Jessica Robinson, Andre Moretto</td>
</tr>
<tr>
<td>assign it to the m-Friends category and stop processing more rules</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Categorize Messages from Coworkers

Rules can frequently recognize messages from people inside your company by looking for your company’s domain name. For example, messages from people at Mabel’s company will usually contain flossrecycling.com in the sender’s email address. Mabel can probably use a rule like this:

Apply this rule after a message arrives with flossrecycling.com in the sender’s address assign it to the i-Coworkers category and stop processing more rules

However, in some companies—especially those that use Microsoft Exchange—the sender’s address only has the sender’s account name. In such cases, Mabel’s return address would be something like mabel instead of mabel@flossrecycling.com.

In such cases, you can find messages from inside the company with a rule like this:

Apply this rule after a message arrives assign it to the i-Coworkers category and stop processing more rules except with @ in the sender’s address

You might need to try both versions of the rule to see what works for you.
Junk email can be a big contributor to email overload. Junk email—also sometimes called *spam* or *UCE* (Unsolicited Commercial Email)—wastes not just your time but also your emotional energy.

Getting lots of messages like this is tiring:

```
From: m239sj29@hotmail.com   To: Mabel Garcia
Subject: ADV: Make Money In Your Spare Time!! Cc:

MAKE MONEY FAST by selling Ostrich Meat from Your Own Home!!

Ostrich meat is LO-FAT, tasty, and NUTRICIOUS! Everybody is going to want to try Ostrich Meat and SOON! Your never going to get a better chance of getting RICH while working in YOUR OWN HOME!! For more info on how you can become WEALTHY, at mail to: OstrichMeat@OpportunityKnocks.Boise.ID.US!

This message is sent in compliance of the new e-mail bill Section 301. Per Section 301, Paragraph (a)(2)(C) of S. 1618. If you have received this message in error, or do not wish to receive further messages, please reply and type "Remove" in the subject line. Your request to be removed will be processed within 24 hours.
```

Outlook does have a rule condition for finding junk mail:

```
suspected to be junk email or from Junk Senders
```
Unfortunately, this condition is not very good at finding junk email. Fortunately, there are several common patterns in junk email that other Outlook rule conditions can find. Unsolicited commercial email messages frequently have:

- the word ADV: (as in ADVertisement) in the subject header
- language that insists that you can make large sums of money quickly
- strong language insisting that this is not a multi-level marketing scheme (which it usually is)
- mention of credit cards
- instructions (usually incorrect) on how to stop getting email from this source in the future
- the statement that the message complies with junk email regulations

Unsolicited commercial email seems to have a very high density of capital letters, exclamation points (!) and poor grammar, but it is difficult to write rules in Outlook (or in any consumer-grade email program) to recognize those features.

**TIP:** In most cases, you should not set up rules to delete messages! Your rules will be wrong occasionally. It is nearly impossible to write a rule that can distinguish between junk and non-junk with 100% accuracy.

Once a week or so, look over your presumed junk messages to look for messages you want. After you deal with any incorrectly categorized messages, you can delete the whole batch of accumulated junk mail at once.
Here are some rules that find junk email and assign it to a low-priority category:

<table>
<thead>
<tr>
<th>Rule Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply this rule after a message arrives with <strong>make money fast or multi-level marketing or unsubscribe in the subject or remove in the subject or this message in error or to be removed from or section 301, Paragraph or do not wish to receive further or 1-900 or all major credit cards in the body</strong> assign it to the z-ProbableJunkEmail category and stop processing more rules.</td>
<td></td>
</tr>
<tr>
<td>Apply this rule after a message arrives with <strong>ADV: or ADVERTISEMENT</strong> in the subject assign it to the z-ProbableJunkEmail category and stop processing more rules.</td>
<td></td>
</tr>
</tbody>
</table>

**TIP:** “Unsubscribe” can show up in many legitimate messages. Do not use the word “unsubscribe” in your junk rules unless you have earlier rules that do a good job of finding legitimate messages, like the ones on page 72, page 73, page 74, and page 76.

Many junk messages advertise pornographic services and sites. For example:

**From:** m239sj29@hotmail.com  **To:** Mabel Garcia  
**Subject:** Hi Sexy, I am lonely  
**Cc:**

Hi Sexy Im lonely waiting for you to call me. Let me ad "a little spice" to your life!  
**WARNING!!**  
These lines are extremely xxx-rated. Adults over 18 only!!!  
Sex starved girls will give you a hot sexual experience you'll never forget. Not recommended for people with weak hearts or bad backs!!!

---------------------------------------------------------------------------------------------------

Call 1-800-555-6666 $2.99-$4.99 per min.  
Visa/Mastercard/Amex  Must be over 18
Advertisements for pornography frequently have:

- a notice that the message is only for people over a certain age (usually 18)
- the words sex, xxx, hot, babe, hardcore, and girls

Some useful rules for pornographic junk mail are:

<table>
<thead>
<tr>
<th>Rule Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply this rule after a message arrives with XXX or hardcore or hard core or must be over 18 or must be over 21 or adults only in the subject or body</td>
<td>assign it to the z-ProbableJunkEmail category and stop processing more rules</td>
</tr>
<tr>
<td>Apply this rule after a message arrives with sex or hot or girls or babe in the body and with sex or hot or girls or babe in the subject</td>
<td>assign it to the z-ProbableJunkEmail category and stop processing more rules</td>
</tr>
</tbody>
</table>

Here is an example of why you shouldn't automatically delete junk email:

<table>
<thead>
<tr>
<th>From:</th>
<th>Marge Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>To:</td>
<td>Mabel Garcia</td>
</tr>
<tr>
<td>Subject:</td>
<td>family news</td>
</tr>
</tbody>
</table>

It's been unusually **hot** here this week. The **girls** and Frank are just lying around in the basement trying to stay cool.

Did you hear the news? My niece Diana is expecting in July! I don't know what the baby's **sex** is yet. Boy, it seems like only yesterday that I was taking Diana to the beach, but she **must be over 18 by now**. (Adults only *think* that their nieces stay children forever!)

By the way, I baked another batch of pumpkin bread -- my garden is producing a huge number of pumpkins! I would understand if you **do not wish to receive further** loaves, so let me know if you don't want me to send you more.

The body of this message contains hot, girls, sex, must be over 18, adults only and do not wish to receive further, but if Mabel lets rules delete this message automatically, she'll keep getting pumpkin bread!
Blacklist Junk Emailers

If someone sent you junk email once, you probably don't want to read anything from that address ever again. One way you can find junk email is by keeping a list of addresses that sent you junk before. Right-click in the list of messages on a junk email message and select Junk Mailers ➝ Add to Junk Senders List from the pop-up menu. You can then use a rule like this:

Apply this rule after a message arrives
suspected to be junk email or from Junk Senders
assign it to the z-ProbableJunkEmail category
and stop processing more rules

TIP: Sadly, it probably isn't worth your time to put free accounts (like hotbabes92347@yahoo.com) into the Junk Senders list by hand because they'll probably send their next message from a different free account.
Default Rule: I Don’t Know You

If you don’t regularly get email from strangers, you might want to put any message that gets to the end of the rule list into a separate category. If the earlier rules stopped properly, only messages from strangers (or friends who have changed their email addresses) will get to this rule.

To make a rule that always acts, hit Next > on the Rules Wizard conditions page without putting a checkbox in any of the boxes:

```
Apply this rule after a message arrives
assign it to the t-UnrecognizedAddress category
and stop processing more rules
```

Outlook will ask you if you are sure you want to make a rule with no condition. Tell it you’re sure.

You should look at your t-UnrecognizedAddress category on an infrequent but regular basis to make sure that you didn’t miss something important. For example, you don’t want to miss a message from your mom telling you her new email address.
Summary

- Rules work best with regular, predictable messages—like those from distribution lists—but many common messages are regular enough that you can create rules for them easily.
- You probably shouldn’t delete junk email automatically. You might delete something important by accident.
- Changing a message’s importance level based on common keywords can be useful.

This chapter gives examples for rules that adjust the importance level of messages, as well as ones that recognize and categorize messages:

- containing executable files or Visual Basic scripts
- containing jokes
- from distribution lists
- about confirmations and updates
- from frequent correspondents
- from coworkers
- from other people you know
- containing unsolicited commercial advertisements
- containing unsolicited pornographic advertisements
- from people you don’t know
- that you send
Simply reading through your messages might take a while. You need to

1. select and open a message to read
2. read the first page of the message
3. scroll down to the next page of the message
4. read the next page of the message
5. mark the message somehow to make clear which messages you’ve finished with and which you haven’t

You might not have ever consciously thought about the last item, but you probably spend a fair amount of keystrokes and mouse clicks already on keeping track of messages that you haven’t finished with. For example, you might keep track of “to-do” messages by flagging them, moving “to-do” messages to the Outlook Task folder, or by deleting all messages that are not “to-do” items.

These tasks can take more time than you might think. For example, it takes at least four long mouse moves, four clicks, and one drag to select a two-page message from the list, read it, and flag it. When you deal with hundreds of messages each week, the time you spend on these tasks adds up.

While this book can’t help with the second and fourth items—reading faster—this chapter can help with the other tasks regardless of whether you prefer to use a mouse or the keyboard. In a perfect world, it would only take one click to simultaneously mark a message either “done” or “to-do” and move to the next message. Furthermore, you shouldn’t have to move your mouse very far to
switch between “done” and “to-do.” If you like using the keyboard more than the mouse, it should only take one keystroke to do either.

This is not a perfect world and Outlook is not a perfect product. The best you can do with standard Outlook is one click or keystroke for “done” messages and two for “to-do.” If, however, you are willing to trust some Visual Basic macros that I wrote, you can get to one-click navigation. (Visual Basic is a programming language that is closely connected to Outlook. Don’t worry, you don’t need to learn Visual Basic to use the macros that I wrote.)

In both cases, the key is to put buttons in the toolbar. There isn’t much that you can do with the mouse that is quicker than pressing a button in the toolbar. Even if you prefer to use the keyboard, it helps to add a toolbar button: when you add a toolbar button, you can also add a keyboard shortcut.

This chapter shows how to cut down on the number of keystrokes and mouse motions that you have to make to move through your messages. It covers scrolling through messages, moving to the next message, and marking messages “done” or “to-do.” Each major section explains techniques for using the mouse and for using the keyboard.

The explanations are complicated slightly because Outlook responds differently if you view a message in the Preview Pane or in its own window. (The Preview Pane shows you the selected message in a different pane of the main window. Select View ➝ Preview Pane to show it.)

If you are certain you know everything there is to know about navigating through Outlook, you can skip to Chapter 5, Reduce the Number of Incoming Messages on page 99. However, there are a lot of things in this chapter that are not obvious. I recommend reading this chapter.

**How to Move to the Next Message Quickly**

Selecting messages out of order from the list of messages is a very slow way to move through your messages. It is much faster if you can go through messages in order, one after the other. (This is part of why it is so important to set up rules to prioritize your messages!) It is relatively easy to move to the next message with the
keyboard but surprisingly difficult to do with the mouse. This section will show techniques for both the keyboard and the mouse.

Mouse Shortcuts for Moving to the Next Message

As mentioned before, you probably want toolbar buttons to take you to the next message. While there aren’t “next” and “previous” buttons in the main Outlook toolbar or a standard way to customize the toolbar to add such buttons, when a message is open in its own window, the toolbar automatically has “next” and “previous” buttons.

If you like to use the Preview Pane and list of messages, there is a slightly tedious but straightforward way to make “next” and “previous” buttons. To make these buttons, you need to use Visual Basic macros that I have written. You need to install the macros then sign them with a digital certificate. You might need to install a program from the Office installation CD in order to create a digital certificate. Then, once you’ve installed the macros, you need to make buttons for them in the toolbar.

If you aren’t comfortable with the idea of installing the macros, you can skip ahead to “Separate ‘To-Do’ Messages from ‘Done’ Messages” on page 93, though you might want to detour through “How to Put a Button in the Toolbar” on page 88.

Install the Visual Basic Macros

I have written four Visual Basic macros for you:

- **MessageDown**: move to the next message
- **MessageUp**: move to the previous message
- **MoveToDone**: transfer a message to a “done” folder
- **MoveToToDo**: transfer a message to a “to-do” folder

These macros can all be found at the following Web page:

http://www.OvercomeEmailOverload.com/outlook/OEOmacros.html

Because many people won’t want to install Visual Basic macros, I’ve put the installation instructions out of the way in Appendix B, *Visual Basic Scripts* on page 243. You should probably read the rest of this chapter before deciding if you want
to install the scripts. If you decide to install them, go read Appendix B, and then come back here.

If you install the macros, you will need to know how to add buttons to the toolbar. Even if you don't want to install the macros, you should know how to customize the toolbar. The next section shows how.

**How to Put a Button in the Toolbar**

To put a button on the toolbar, select **Tools ➝ Customize**. You'll see the toolbar customization page, as shown in Figure 24:

![Toolbar Customization Page](image)

**Figure 24: Toolbar Customization Page**

There are many different actions that a button can take. There are so many that the actions are divided into categories listed on the left-hand side of the window. To see the command for marking a message *Unread*, for example, you need to select the **Edit** category first.

Once you have selected a command, you can drag it to the toolbar. The only catch is that if you try to put it too far to the right, it won't go. If the cursor changes to
the icon in Figure 25 below, move it to the left until the X goes away (Outlook 2000) or changes into a + (Outlook 2002), then release the mouse.

Figure 25: Icon Meaning “You Can’t Place That Button Here”

You can change what a button looks like on the toolbar. Open the toolbar customization page, then click in the toolbar on the button you want to modify. This will make the Modify Selection... button active. Clicking on Modify Selection... will give you a pop-up menu with various customization options. To take the text off of the button, select Default Style from the menu, indicated by the arrow on the left of Figure 26:

Figure 26: Changing the Icon on a Toolbar Button
If you select Change Button Image, you’ll get a palette of different icons, as shown by the arrow on the right of Figure 26.

How To Add a Keyboard Shortcut

Although toolbar buttons are most obviously useful if you prefer the mouse over the keyboard, you can also make a new keyboard shortcut by putting an ampersand (&) in a toolbar button name. Put the ampersand before the letter that you want to be a shortcut. For example, if you have a button to mark messages Unread with the Name of U&nread, then pressing Alt-n will mark the selected message Unread.

TIP: Many letters already are used with the Alt key. For example, Alt-a makes the Actions menu active. It isn’t dangerous to use a letter that Outlook already uses, but you won’t be able to use the previous shortcut. Letters which Outlook doesn’t normally use with the Alt key in the main Outlook page are b, g, j, m, n, q, x, and y.

How to Add My Macros to the Toolbar

If you installed the macros from page 87, you can now make the next/previous message buttons. Select Macros. The four macros that you installed—Module1.MessageDown, Module1.MessageUp, Module1.MoveToDone, and Module1.MoveToDo—should show up in the right-hand box as shown in Figure 27:

![Figure 27: Macros](image-url)
Unfortunately, for some reason the macros sometimes don’t appear immediately. If they don’t appear, close the window, select Tools ➝ Macro ➝ Macros… from the main menu bar and then try again. The macros should appear as shown in Figure 27.

Because the module names are long, you might want to change how the buttons appear. I set the button for Module1.MessageDown to show only a down arrow, for example.

**Keyboard Shortcuts for Moving to the Next Message**

*Space* is your friend. As mentioned earlier, pressing *Space* repeatedly will page through a long message in the Preview Pane. In addition, when you get to the end of the message, *Space* will take you to the next message. Thus hitting the biggest key on the keyboard does the most common operation. (If *Space* doesn’t work like this for you, select Tools ➝ Options…, press the tab marked Other, then the tab marked Preview Pane, and put a check mark in the box next to single key reading using space bar.)

There are additional keyboard shortcuts that you can use in the main Outlook window, but they are different depending upon whether the list of messages or the Preview Pane is active:

<table>
<thead>
<tr>
<th>active pane</th>
<th>next message</th>
<th>previous message</th>
</tr>
</thead>
<tbody>
<tr>
<td>list of messages</td>
<td>↓ and →</td>
<td>↑ and ←</td>
</tr>
<tr>
<td>Preview Pane</td>
<td>Alt-↓ and Alt-→</td>
<td>Alt-↑ and Alt-←</td>
</tr>
</tbody>
</table>

Using *Space* is easier.

**TIP:** You can use *Tab* to switch between the list of messages, Preview Pane, and list of folders.

When you open a message is in its own window, you can’t use *Space*. You can, however, use *Control-comma* (, ) to go to the next message and *Control-period* (.) to go to the previous message.
How to Scroll through a Message Easily

Scrolling through a message doesn’t take much time, but it’s something you can’t avoid.

How to Scroll with the Mouse

If you like to use the mouse, I strongly recommend getting a mouse with a scroll wheel to help you scroll forwards and backwards in long messages. It is tedious to move the mouse all the way over to the scrollbar and then all the way back every time you want to look through a message.

How to Scroll with the Keyboard

The arrow keys, PageUp, and PageDown, will all move you around a message if you are looking at a message in its own window or if the Preview Pane is active (with its header bar in blue instead of grey). However, if the pane with the list of messages is active, those navigation keys will move you around the list of messages, not the Preview Pane.

If either the Preview Pane or the list of messages is active, Space will scroll the message down one page and Backspace will scroll the message up one page—regardless of whether the Preview Pane or list of messages is active. I highly recommend the Space key!

TIP: Remember that Backspace and Delete are different: Delete will delete the message!
Separate “To-Do” Messages from “Done” Messages

If your incoming messages are all in your Inbox, the easiest way to keep track of your “to-do” items is to hide messages when you finish with them. There are several ways to do this:

• by deleting
• by flagging
• by marking Unread
• by moving to another folder

This section will discuss advantages, disadvantages, and speeds of various methods.

Mark “Done” with the Delete Key

Many people delete each message as soon as they finish with it. This is fast and makes seeing “to-do” items easy: their Inbox has “to-do” items and nothing else.

While this certainly is a simple way to do things, I don’t think it is the best way. Old messages can help you:

• remember important facts: “Who replaced Winston?” or “What did the VP say the third quarter’s financial goals were?”
• train others: “What have been the major issues in the department recently?”
• prove that you did something: “Did I submit all of my status reports on time?” You can even send yourself a message so that you have a dated record of a thought or action.

Deleting all messages when you are done with them is like deliberately losing your memory. Imagine if you threw out all of the papers in your filing cabinet every month!

If you delete some things but not others, you have to take some time to decide what to keep and what to throw away. This might only take a tiny bit of time, but it adds up when you do it over and over again. It is faster to keep everything.
It also probably isn’t worth your time to periodically purge your files in hopes of finding old messages more quickly in the future. Find and Advanced Find work so well and so quickly that cleaning out old messages probably won’t save as much time as it takes.

Disk space was once expensive. It was not economically possible to keep all of your email messages. But now, text messages are now ridiculously small compared to the size of hard disks. You probably won’t ever need to throw away text messages.

If you run into limits on your company’s servers, first complain to the system administrators that the quota is too low. Point out how cheap disk space is. If that doesn’t work, copy some of your old messages to a Personal Folder on your local hard drive. Select File → Import and Export → Export to File and select Personal Folder file (pst). Outlook will prompt you to choose a name and place for it.

Mark “To-Do” with Flags

Some people use flags to mark messages “to-do.” This is a very reasonable thing to want to do, since flags seem designed just for keeping track of “to-do” items. Normally, however, to flag a message takes at least four steps: one to select the Actions menu, one to drag down to Flag for Follow Up (Outlook 2000) or Follow Up (Outlook 2002), one to click on the OK button in the window that appears, and one to move your cursor back to wherever you had it before.

![Figure 28: Dialog Box for Flagging Messages](image-url)
Yes, you can put a button in the toolbar to flag the message, but you still have to dismiss the dialog box in Figure 28 and (if you are using the mouse) move your mouse back to the toolbar.

It is also difficult to view only the messages that you haven't finished with. In Outlook, there is no way to show both Read-but-flagged and Unread messages without also showing Read-not-flagged messages.

Note: Outlook 2002 lets you set a time—not just a date—for when a flag is due. In the Outlook 2002 version of Figure 28, below the button marked Clear Flag, there is a pop-up menu for setting the time.

**Mark To-do with Unread**

Using Read/Unread to mark “done”/“to-do” works better than using flags.

You can easily add a toolbar button to mark messages Unread or Read, and there are built-in keyboard shortcuts (Alt-e, Alt-n for Unread, Control-q for Read). If you want to make the Unread keyboard shortcut shorter, you can modify the toolbar button as discussed in “How To Add a Keyboard Shortcut” on page 90.

Marking a message Read or Unread doesn’t advance you to the next message. If you are not done with a message, you need to take one action to mark it Unread and a second to move to the next message. (If you are done with the message, you just need to move to the next message.)

**How to Hide Read Messages**

It is easy to see only “to-do” messages if you mark them Unread: use the Unread Messages View. Be careful! It is easy to make mistakes. If you don’t remember to mark a “to-do” message Unread right away, it will disappear from view as soon as you move to the next message.

It is also a little tricky to move a lot of Read messages to other folders at once. There isn’t a standard View that shows only Read messages or groups by Read/Unread. To make it easy to select all of your Read messages so you can move them at once to a “done” folder, you will need to create a View that groups by Read/Unread. (See “How to Make a View Grouped by Category” on page 32.)
Mark “Done”/“To-Do” by Moving Messages to Another Folder

If you are brave enough to add a Visual Basic macro, you can create a button to move the selected message(s) to a “done” folder. See “Install the Visual Basic Macros” on page 87.

After you’ve put buttons for the macros in the toolbar, moving through messages with buttons is very fast. If you decide you are done with a message, press the button for the MoveToDone macro. If you decide you will need to do something with the message in the future, press the MessageDown or MessageUp button (depending on how you order your messages).

If you categorize messages by moving them immediately into folders instead of assigning them categories, you might want to move all your “to-do” messages to a special “to-do” folder. You can do that with the macro named MoveToToDo.

The macros assume that your “done” and “to-do” folders are named zz-Done and aa-ToDo. If you want to use folders with different names, you need to change the
macros. Open the Module window as described in “How to Install Visual Basic Macros” on page 246, as shown in Figure 29:

![Visual Basic Macros for Moving Messages](image)

**Figure 29: Visual Basic Macros for Moving Messages**

You need to change the lines shown by the arrows in Figure 29. Replace *zz-Done* and *aa-ToDo* (as shown by the arrows) with the names of your folders. Be sure not to delete the quotation marks!

**Move Messages to a Final Home**

Organizing your old messages can make finding old messages easier. After you separate “done” and “to-do” messages in different folders, you might want rules to move your “done” messages to final resting spots. Once your messages are
separated, you can run those rules at a convenient time. If you have folders with the same name as your categories, the rules will be very simple, of the form:

```
Apply this rule after a message arrives
assigned to h-Payroll
move it to the h-Payroll folder
and stop processing more rules
```

Important! Make sure that you don’t enable these rules except when you do a Run Rules Now… as described in “How to Test Your Rules” on page 57. Otherwise your messages will end up in many different mailboxes before you read them.

More Keyboard Shortcuts

There are many more shortcuts in Outlook than I covered in this chapter. I cover more in later chapters, but you might want to look quickly through the others. To see a list of all of the keyboard shortcuts, press F1, then type keyboard shortcuts.

Furthermore, as mentioned in “How To Add a Keyboard Shortcut” on page 90, you can make new shortcuts by putting the buttons for that action in the toolbar.

Summary

- Old messages are worth keeping.
- You can save time by adding toolbar buttons for Outlook operations that you do frequently.
- You can add keyboard shortcuts by putting an ampersand (&) in a toolbar button’s name.
- The arrow keys and Space can take you quickly through messages.
- The easiest and fastest way to move through messages requires installing the Visual Basic macros. Read the directions at:

```
http://www.OvercomeEmailOverload.com/outlook/OEOmacros.html
```

If you do not want to install those macros, the next best way is mark messages Unread if you haven’t finished with them.
Organizing and prioritizing messages helps to decrease the amount of time you spend on email, but reducing the number of incoming messages can save you even more time. Obviously, you want some of your email, but some messages are unnecessary. Junk email is one form of unnecessary email, but even non-junk messages can waste your time.

For example, distribution lists, while useful, can generate an enormous amount of traffic. Off-topic postings, arguments, and just plain boring messages waste your time.

Sometimes, email from strangers doesn’t waste as much time as messages from people you know. After all, you can figure out very quickly if a message is junk email or off-topic. You might even be able to use rules to get rid of it, as shown in “File Junk” on page 77. On the other hand, you might need to read all messages from your boss through to the end.

This chapter shows how to reduce the number of these three types of messages: junk email, distribution lists, and nuisance messages from acquaintances. Some of the techniques require some extra effort at first but will save you time in the end.
Reduce the Number of Junk Email Messages

Junk email is very annoying. If you don’t get junk email now, consider yourself lucky—and take steps to make sure you don’t start getting junk email. If you already get junk email, you might want to start over with a new email account, then keep that account away from junk emailers.

Your company’s Information Technology department might have a way of getting rid of junk email before it ever gets to your Inbox, saving you download time. You might need to ask for the service, however. Find your company’s email system administrator and ask, “Can I get a spam filter on my account, please?”

The best thing you can do to keep from getting junk email is keep your email address private. Don’t put your email address on a Web page, don’t put messages up on any of the public Internet discussion forums, and don’t give your email address out to retailers.

**TIP:** This is such an important point that I will repeat it to make sure you see it: Keep your work email address private!!

If keeping your email address private would interfere too much with your use of the Internet (or if your email address is already on junk email lists), consider getting a second email account. As mentioned in “Group Messages by Using Multiple Accounts” on page 59, there are now a number of services that will give you free accounts. You can use one account for public contact and one for private contact, effectively separating your email into two groups: junk and non-junk.

Reduce the Number of Distribution List Messages

Distribution lists are a great way to communicate with people—both inside and outside your company—who have shared interests and goals. However, they can lead to an enormous amount of email traffic. Rules can help enormously by grouping messages from distribution lists (also called simply mailing lists) into
their own category or folder, but that might not be enough. Fortunately, there are a few things you can do to save time with distribution lists.

**Global Address List Addresses vs. Internet Distribution Lists**

If your company uses Exchange as its mail server, then you are probably most familiar with distribution lists where you send to an address that you select from the company's Global Address List. (To figure out if Exchange is your mail server, see the tip on page 43.) For distribution lists that include people who do not use an Exchange server, you usually send a message to an Internet address, perhaps that you keep in your Contacts list. In this book, I will call the non-Global Address List distribution lists *Internet distribution lists*, to distinguish them from Global Address List-based distribution lists.

Internet distribution lists usually behave differently from Exchange-based lists:

- To get on or off of an address in a Global Address List, you usually need cooperation from a human being—the owner of the address—to join or leave the list. With an Internet distribution list, however, your negotiations are almost always with a piece of software, not a person.
- While anybody can send a message to any address in the Global Address List, usually only the people on an Internet distribution list can send messages to the other people on list.
- With a Global Address List-based distribution list, you can see exactly who is on the list. Usually with an Internet distribution list—especially if it is open to the general public—you cannot tell who is on the list or even how many people are on the list.
- Messages do not go directly to the people on an Internet distribution list. Instead, you send the message to an address and then some software resends the message out to the list members. This means that list software can and sometimes does modify the message along the way. For example, many distribution lists strip off attachments and text styling (such as colors, font sizing, italics, etc.)

The next few sections discuss Internet distribution lists. If you aren't on any Internet distribution lists and don't plan on ever joining any, you can skip to “Reduce the Number of Messages from Acquaintances” on page 107.
Internet Distribution List Administration

The software that administers most Internet distribution lists (called a list server, listserv, or listbot) allows people to join or leave the list without causing work for anybody else. Yes, there is a human being—the list owner—who has control over the list server, but he or she is not guaranteed to pay any attention to the list server. The list owner might not even read the list messages. It is thus important to know how to communicate with the list server.

When you join or subscribe to a list, the first message usually gives instructions for how to communicate with the list server. It will tell you what options you have and what the list server’s email address is. (Usually the list server’s address is different from the address you use to reach subscribers. The subscribers are reached by the listname address.)

Be sure to save that first message in a safe place. If you occasionally delete large blocks of old messages, be sure to move that first message into a special folder that you don’t ever delete. (I put mine in a folder with other confirmation messages from automated services.)

**TIP:** This is important enough that I will repeat it: **Keep the first message you get from an Internet distribution list in a safe place!**

If you subscribed to an Internet distribution list by sending an email message, the most important thing to remember is the list server’s email address. Putting the list server’s email address into your address book will help you find it in the future.

If you subscribed to an Internet distribution list from a Web page, the most important thing to remember is where that Web page is. That page should take you to information about how to communicate with the list server. You should send yourself email with the location of the Web page and file that message somewhere safe. (You could bookmark it in your Web browser, but if you keep lots and lots of bookmarks, you might have a hard time finding it.)
When to Unsubscribe

There are several situations where you should unsubscribe from some of your Internet distribution lists:

- If your email takes up too much of your time, ask yourself if you really need to be on all your distribution lists. Many Internet distribution lists now have archives on a Web site, so you might want to look at the archive occasionally instead of having messages from the list filling your Inbox.
- When you go on vacation, you might want to temporarily unsubscribe. You will probably want to spend your first day back from vacation going through only your hundreds of work-related messages, not also your hundreds of distribution list messages. You might also want to spare others on the distribution list from getting your Out-of-Office messages. (See “Out-of-Office Messages” on page 144.)
- You should unsubscribe when you change email addresses. Unsubscribe using your old address and resubscribe with your new address. Many list servers look at the return address to decide whether to honor a removal request. If your return address has changed since you subscribed, the list server might not honor your requests. (This is an appropriate security feature. You don’t really want your worst enemy to alter your Internet distribution list subscriptions, do you?)

If all the email from your old account is forwarded to the new account, you could be stuck with the distribution list forever.

How to Unsubscribe

How to unsubscribe from a distribution list is not always as obvious as you would hope. There are many different kinds of list servers, each with a slightly different set of commands. This is why you should save the instructions! Three years from now, you might want to unsubscribe and not remember how.

You could be lucky: list servers frequently put unsubscribe instructions in every message. For example, all messages that go through Yahoo Groups currently have a header with the unsubscribe address, like this:

List-Unsubscribe: <mailto:moo-unsubscribe@yahoogroups.com>
(See “How to Determine Your Correspondent’s Email Program” on page 172 for how to show a message’s headers.) Other Internet distribution lists frequently add unsubscribe instructions at the end of the message.

Get Help from the List Server

If you have lost the original instructions but have the list server’s address, try getting help from the list server. Commands like info and help followed by the name of the list can sometimes get you more information. Nonsense like slkdfj might also convince the list server that you need help. A message like this will probably get something useful in response:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: <a href="mailto:lists@catfloss.org">lists@catfloss.org</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: help floss-talk</td>
<td>Cc:</td>
</tr>
<tr>
<td>help floss-talk</td>
<td></td>
</tr>
<tr>
<td>info floss-talk</td>
<td></td>
</tr>
<tr>
<td>alsdjfaj floss-talk</td>
<td></td>
</tr>
</tbody>
</table>

If nothing else, the response will probably tell you the correct way to ask the list server for information.

If that doesn’t tell you how to unsubscribe, you can try a few of the common ways to unsubscribe. Usually you unsubscribe by putting one of the following key words in the body or the subject of a message to the list server:

unsubscribe
remove
leave

Sometimes you need to follow the name of the list with the email address to remove. For example:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: <a href="mailto:lists@catfloss.org">lists@catfloss.org</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: unsubscribe floss-talk</td>
<td>Cc:</td>
</tr>
<tr>
<td>unsubscribe floss-talk <a href="mailto:mabel@flossrecycling.com">mabel@flossrecycling.com</a></td>
<td></td>
</tr>
</tbody>
</table>

Try several different unsubscribe messages. After no more than three or four tries, you’ll probably succeed in either unsubscribing or getting directions on how to unsubscribe.
How Not to Unsubscribe

As mentioned earlier, the list server has a different address from the listname address, so sending a removal request to the listname address usually does nothing except make you look really stupid. Not only are “please remove me” messages a way to lower people’s opinion of your intelligence, but you might also get swamped with incoming messages. Fifty people might explain the proper way to unsubscribe. They might not all be polite, either.

If you can’t remember how to unsubscribe from an Internet distribution list and have misplaced the instructions, at least apologize if you ask the list subscribers how to unsubscribe. You might still look like an idiot, but you will at least look like a polite idiot.

I am on an Internet distribution list where instructions on how to unsubscribe are at the bottom of every message. People get really annoyed by messages like this:

```
From: Mabel Garcia       To: floss-talk@catfloss.org
Subject: unsubscribe     Cc:

Hi - I'm terribly sorry, but I can't seem to find the instructions on how to unsubscribe from this distribution list. Could someone please send me the directions?

***********************************************************************
** To leave the list send a message TO lists@catfloss.org**
** with the subject "unsubscribe floss-talk". **
** **
** ** Messages on the Cat Flossing Research List are those **
** of the individual members and do not represent the **
** International Cat Flossing Association. **
** Questions? - Contact list@catfloss.com **
***********************************************************************
```

Switch to Internet Distribution List Digests

If you get a lot of messages from an Internet distribution list, you might want to get the messages in a digest—a single email message that combines all the messages sent to the list in one day or one week. Getting a digest won’t reduce the amount of text that you have to read, but it might make the messages easier to manage. If
you can't restrain yourself from reading any message when it appears in your Inbox, this might keep your day from getting too fragmented.

Unfortunately, there are three possible disadvantages to digests:

• Digests are very long, so they require a lot of scrolling.
• It is harder to reply to the author of one of the messages in the digest. (Selecting “reply” will send a reply either to the entire list or to nobody.) You'll need to copy and paste the author's address into a new message's To field.
• You can't skip individual messages as easily.

Switch to Announcement-Only Internet Distribution Lists

If you want to stay informed of only the most important aspects of a topic, you might want to see if you can subscribe to an announcements list. Sometimes, interest groups will have two Internet distribution lists for a particular topic: one for announcements only and one for general discussion. Announcement lists generally have many fewer messages than general discussion lists.

**TIP:** Sometimes, the names of announcement lists end in -announce and the discussion lists end in -talk. Digests frequently end in -digest. For example, roses-talk@rosegardens.org is almost certain to be a general discussion list.

Switch to Moderated Internet Distribution Lists

If a lot of the messages on a list are not useful—idiots ranting, chain letters, messages that are off-topic, and so on—you might want to switch to one with some human quality control. On some Internet distribution lists, a human being (called a moderator) reads each of the messages and decides whether or not to let the message go to everyone who is subscribed. While the moderator sometimes distributes guidelines for what he or she considers appropriate, in the end the moderator gets to decide what goes through. Because of the moderator, you won't have complete freedom of expression, but the percentage of useful messages should be higher than in an unmoderated list.
There won’t always be a moderated list on the topic that interests you. If you’d like to provide a useful public service, you could volunteer to moderate an Internet distribution list.

Reduce the Number of Messages from Acquaintances

Distribution lists can generate many messages, but you can usually wait to read and respond to them. Messages from friends and colleagues, however, need more careful attention. Reducing the number of those messages might help you more than getting rid of distribution list messages.

Write to Discourage Responses

There are a number of techniques you can use when writing messages that will make your correspondents less motivated to respond. These include

- sending clear messages
- writing with formality
- making clear that you think the conversation is over
- keeping your thanks until later
- avoiding rhetorical questions
- using voting buttons

Send Clear Messages

If your correspondents misunderstand your message, they will have to send you messages asking for clarification. You’ll have to read at least one more message and write at least one more message.

- Writing more understandable email is such a large and important topic that it’s split into several chapters: Chapter 7, Reduce Ambiguity, Chapter 8, Convey Emotional Tone, and Chapter 9, Make Messages Legible.
Write with Formality

You can affect how many responses you get to your email messages by changing how formal your writing is. People naturally use very formal language to recognize that the audience can't respond easily. For example, here are three situations where people use very formal language. In each, there is a barrier to communicating freely:

- **When addressing people with radically different status.** If you and the Ambassador have tea, one of you might ask about the other’s health, but both of you are socially constrained from actually discussing recent surgeries. The formal language you would use with the Ambassador reflects those social constraints.

- **When addressing an audience of the future.** Politicians know that lawyers might examine their documents carefully decades or even centuries later. The original authors might not be alive then to answer questions. The formal language in legal documents is a way of showing that nobody will be able to answer questions later.

- **When addressing a large number of people.** If every member of a large audience tried to comment on a speech, there would be chaos. The audience is not completely free to respond. The formal language used in speeches encourages people not to interrupt.

Intimate discussions, on the other hand, use very informal language. If you were as formal with your loved ones as with the Ambassador, they would probably wonder why you were angry! Advertisements use informal language deliberately to try to make the message seem more intimate (and therefore more trustworthy).

So be cautious about your messages’ tone. If you want people to respond, be chatty and informal. If you want to discourage people from responding, send messages that are more formal.

Use "No Reply Needed"

Email doesn’t have clear and common conventions for how to end a conversation, unlike in verbal conversations. In person, body language can say, “I’m leaving now.” On the telephone, people say, “goodbye” to signal the end of the call. Email is new enough that conventions to end the conversation haven’t developed yet.
You can help create a new standard. I recommend showing that the conversation is at an end by saying No Reply Needed. (Why did I capitalize No Reply Needed? Because I hope that someday people will abbreviate it NRN.)

For example:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Mei Lin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Phrockmeijer report</td>
<td></td>
</tr>
<tr>
<td>Cc:</td>
<td></td>
</tr>
</tbody>
</table>

Mei --

The Phrockmeijer report is on-line at
http://internal.flossrecycling.com/~mabel/phrock.pdf

I hope it is what you wanted.

No Reply Needed.

If you put FYI in the subject, that will also show that you don’t need a response. Use No Reply Needed when you are pretty sure that the receiver wants the information; use FYI when you aren’t sure.

Don’t Thank Your Correspondents Right Away

“Thank you” and “You’re welcome” are particularly uninteresting messages. In spoken conversations, they are in context and very brief. They are polite, gracious, and make interactions more pleasant. However, in an email conversation, it might take you a moment to figure out what a message that just says “thank you” is about.
You can discourage messages that only say, “You’re welcome” by not sending messages that only say, “Thank you.” If you have a question about the favor, thank your correspondent when asking your question:

<table>
<thead>
<tr>
<th>From: Mei Lin</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Subject:</strong> Re: Phrockmeijer report <strong>Cc:</strong></td>
<td></td>
</tr>
<tr>
<td>Mabel -</td>
<td></td>
</tr>
<tr>
<td>Thanks a bunch for telling me so promptly where I could find the Phrockmeijer report.</td>
<td></td>
</tr>
<tr>
<td>I'm confused about one thing, though. The report says that the floss is green. Didn’t we switch to purple three weeks ago?</td>
<td></td>
</tr>
</tbody>
</table>

But unless it was an exceptional effort to get you the information, do your correspondent a favor and wait until your next message to say thanks:

<table>
<thead>
<tr>
<th>From: Mei Lin</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Subject:</strong> Floss Expo <strong>Cc:</strong></td>
<td></td>
</tr>
<tr>
<td>Mabel -</td>
<td></td>
</tr>
<tr>
<td>Thanks for getting me the Phrockmeijer report last week.</td>
<td></td>
</tr>
<tr>
<td>Carlos reminded me that Floss Expo is coming up soon. Can you spare some Payroll clerks to staff the booths again?</td>
<td></td>
</tr>
</tbody>
</table>
Another thing you can do is gives thanks profusely in advance:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Mei Lin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: Floss Expo</td>
<td></td>
</tr>
</tbody>
</table>

Mei -

Yes, I think Winston and Jeff would like to work Floss Expo again. I’ll ask them.

In the meantime, could you email me the latest version of our brochures so they can get up to speed?

Thanks in advance!

While I don’t recommend it, some people abbreviate Thanks In Advance to TIA; I’ve also seen advTHANKSance—the word “thanks” in(side) the word “advance.”

Some people don’t like thanking in advance. They feel that it is rude to assume that the receiver will do the favor. I agree, it is—but so is not thanking someone and so is contributing to someone’s email overload by sending them messages that just say “thank you.”

Avoid Rhetorical Questions

Some questions are rhetorical; you don’t really want an answer. Unfortunately, without verbal and gestural signals, it is hard for people to figure out when a question is rhetorical. You’re likely to get sincere answers to all your questions:

<table>
<thead>
<tr>
<th>From: Claire Beekman</th>
<th>To: Pat Nguyen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: safes</td>
<td></td>
</tr>
</tbody>
</table>

> Claire --
> Have you ever seen those little safes in hotels? Please put some in the cafeteria for employees to keep their wallets and purses.

Yes, there was a safe in the closet of the hotel I stayed in last week.
You’re likely to get better responses if you reword your rhetorical questions as statements:

<table>
<thead>
<tr>
<th>From: Pat Nguyen</th>
<th>To: Claire Beekman</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: safes</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

Claire --

Please put some small safes -- like the ones hotels sometimes have -- in the cafeteria. I want employees to have a safe place for their wallets and purses.

Use Voting Buttons

You can sometimes use voting buttons. That encourages people to give you answers like “Yes” and “No” instead of long, rambling messages like this:

<table>
<thead>
<tr>
<th>From: Winston Thurd</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: progress</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

> Will you be able to resume work on the Phrockmeijer report tomorrow?

Well, my creeping Norwegian sunwarts are really still bothering me. Yesterday I spent all day in the tub, and they still really itched. The doctor said that I should NOT put butter on it or anything like that, but my sister knows someone who had a friend with creeping Norwegian sunwarts, and *he* said that putting coffee grounds on the spots was the only thing that stopped the itching at all. So I hope that will help because I’m just about going crazy! Still, they *are* better and I’m getting bored, so I’m planning on coming in to work tomorrow.

If you use Outlook 2002, you can send voting buttons to other Outlook 2000 and Outlook 2002 users. If you use Outlook 2000, you can only send voting buttons to people who are on the same Exchange server as you are.
How to Add Voting Buttons

To add voting buttons to a message, first click on Options... in the message composition window's toolbar. (Note that there is no menu option for voting buttons.) Next, check the box next to Use voting buttons, as indicated by the arrow in the upper left of Figure 30:

![Figure 30: Voting Buttons](image)

You can use the pre-defined buttons (such as the Yes, No, and Maybe indicated by the middle arrow), or you can create your own. To create your own buttons, type the phrases that you want to appear on the buttons, separated by a semicolon (;).

To see the vote count, you need to go to the message that you sent, then click on the tab marked Tracking. To make your original message easier to find, you might want to save it somewhere besides Sent Items. Click on the Browse... button (indicated by the lower right arrow) to select a folder where you will be able to find the sent message more easily. (I recommend the Inbox, since your call for a vote is a “to-do” item until the voting is over.)
Discourage Third-Party Discussions

Another good strategy for reducing the amount of incoming email is to discourage your correspondents from getting into conversations with each other.

Consider the following exchange:

- Alicia sends a message to Mabel, Jeff, and sixteen other people asking what color the brochure covers are.
- Mabel sends a message to Alicia, Jeff, and sixteen other people saying the covers are the same green as the new logo.
- Alicia sends a message to Mabel, Jeff, and the other sixteen saying that she hates the new logo.
- Jeff and Alicia send messages back and forth (Cc’ing the seventeen others) arguing about whether the new logo is better than the old one.
- Mabel and the sixteen others get annoyed at Alicia and Jeff’s private argument pushing into their Inboxes.

Granted, Alicia shouldn't have gone off-topic, but Mabel could have made it difficult for the argument to get started in the first place. Then Mabel (and the sixteen others) wouldn't have needed to read Alicia and Jeff’s argument about the logo.

Reply to Sender Only

If Mabel had responded just to Alicia, then Alicia’s complaint about the logo would have only gone to Mabel, not also to Jeff. Granted, Mabel wouldn't have had a chance to impress everyone else with her insight and wit, but perhaps that’s just as well.

Being careful to respond only to the sender also can save you from the most common embarrassing email mistake: sending a message to more people than you intended. You’ve probably seen how dangerous this can be!
For example, if Della accidentally replied to everybody instead of just to Charlie, Jessica would be surprised to get the following message:

```
From: Della Hunt
To: Charlie Yzaguirre, Jessica...
Subject: Re: Friday card game
Cc:

> Would you all be interested in getting together on Friday
> to play cards?

Charlie, you have got to be out of your mind to invite Jessica to play cards. That woman cheats so much that I'm amazed that she isn't in jail yet!
```

Reply-To-All mistakes can lead to, at best, a lot of messages telling you that you made a mistake. At worst, you'll make people angry and a flame war—an angry argument fought using email messages—could erupt. Either will eat up your time and energy.

**Use Bcc Instead of To or Cc**

Reducing the number of people you send a message to isn't always possible. A lot of people might need to read your message. However, you can use Bcc to keep other people’s Reply-To-All mistakes from involving you in their arguments.

You might have already noticed that you can see all the addresses in the To and Cc fields, but can't see addresses in the Bcc field. It's not that Outlook sends the Bcc list to everyone, but the receiving software hides it; Outlook never sends the list. Nobody can ever see your Bcc list except you.

You can probably see that Bcc can significantly reduce the amount of follow-up discussion. Be careful, though—Bcc has some dangers. In particular, it is easy for people on the Bcc list to respond to everybody (except, of course, anyone on the Bcc list) by mistake. This can have very embarrassing consequences if the original sender was supposed to keep the message secret!
For example, suppose Wilbur passes on a secret to Chris and Tyronne using the Bcc addressing method, indicated by the circle in Figure 31:

Figure 31: Wilbur Tells Loy’s Secret to Chris and Tyronne

If Tyronne or Chris replies to all instead of just to Wilbur, Loy will learn that Wilbur didn’t keep the secret. Loy would be very surprised to get this message from Chris:

```
> You may certainly use me as a job reference. I’m sorry that
> you won’t be staying with the company, but I can understand
> that you want to move on.
> Naturally, I will not tell anyone else about your leaving.
```

```
From: Chris Olszewski
To: Wilbur Haliburton
Subject: Re: reference
CC: Loy Duncan

> You may certainly use me as a job reference. I’m sorry that
> you won’t be staying with the company, but I can understand
> that you want to move on.

Wilbur, see if you can find out what Loy wants. If he needs more money, we can probably arrange that. I’ll raise his salary $10K if I have to. We’ve gotten away with underpaying him pretty horribly in the past.

--
Chris
```
Reduce the Number of Messages from Acquaintances

(Note that Tyronne, who Wilbur also put in the Bcc field, will not get this message.)

It is true that Chris is the one who made the mistake of replying to everyone instead of just to Wilbur. However, Chris couldn't have made that mistake if Wilbur had sent a separate copy instead of using Bcc.

**TIP:** It is a bad idea to write down anything that you would be embarrassed for others to find out. Your co-workers might see the message over your shoulder. The receiver's co-workers might see the message on the receiver's screen. The receiver could even forward it to many people. You cannot control who sees your email messages.

Also, if your correspondents file messages with rules that check whether the messages are addressed to them specifically, putting them on the Bcc list might make their rules send your message into a low-priority category or folder. Sending a separate copy makes its importance more obvious.

**Send Fewer Messages**

One of the best ways to get fewer responses is to send fewer messages. This doesn't mean that you shouldn't send email at all. Email is a wonderful thing when used correctly! However, you should consider carefully whether your correspondents really want your message. In particular, be careful about sending anything to a large group of people. The more people who get a message, the more likely it is that someone will misinterpret the emotion, context, or meaning. You might need to read and/or send a number of clarifying messages.

**TIP:** Before you send a message to a large group of people, consider whether you would walk up to a microphone to say it to that many people in an auditorium. If you wouldn't say it in front of three hundred people, don't email it to three hundred people.

There are certain types of messages that will really annoy people. The more people you send such messages to, the more likely it is that you will get messages back.
that tell you not to do that. The rest of this section describes messages that you should not send.

“Me Too”

You might have already seen the “Me too” message. This is fine when there are only two people in the discussion, but not when there are hundreds:

<table>
<thead>
<tr>
<th>From: Leo Newman</th>
<th>To: <a href="mailto:abuse-L@catfloss.org">abuse-L@catfloss.org</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: junk email</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

Tyler Spratt <tspratt@electricbagpipes.com> said:
> I think that all people who waste Internet bandwidth
> should have their access cut off forever.

Me too!

You should only write your support to the entire recipient list if you have something new to add:

<table>
<thead>
<tr>
<th>From: Leo Newman</th>
<th>To: <a href="mailto:abuse-L@catfloss.org">abuse-L@catfloss.org</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: junk email</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

Tyler Spratt <tspratt@electricbagpipes.com> said:
> I think that all people who waste Internet bandwidth
> should have their access cut off forever.

I agree in principle, but I think a permanent banishment would be a bit extreme. Just take our... uh... *their* Web connection away for a week. That will teach them!

Otherwise, keep quiet. The second, third, and seventy-third identical “me too” messages aren’t interesting.
Sometimes, someone on a distribution list will ask for your opinion or vote. In those cases, respond ONLY to the person who originally posted the message. Be clear about your vote, and put it in the subject if possible:

From: Leo Newman
To: Tyler Spratt
Subject: YES! Cut off access! (was junk email)

Tyler Spratt <tspratt@electricbagpipes.com> said:
> I think that all people who waste Internet bandwidth
> should have their access cut off forever. All those who
> are in favor, send me email and I will report the count.

I am in favor of cutting off access for anyone who wastes Internet bandwidth.

If you call for a vote, make it easy for people. If your distribution list is an Exchange-based list, you can put voting buttons directly into the message, as described in “Use Voting Buttons” on page 112. If you can't use voting buttons, ask people to put their votes clearly in the subject line so that you don't have to open the message:

From: Tyler Spratt
To: abuse-l@catfloss.org
Subject: access cut vote (was junk email)

I think that all people who waste Internet bandwidth should have their access cut off forever.

If you are in favor of cutting off the access of people who waste Internet bandwidth, send me (not the whole list) email with an empty message body and the subject YES! cut off access
If you disagree, send me email with an empty message body and the subject NO! don’t cut off access
I will tally the results and post them to this list.

You can set up a rule to sort the votes into YES and NO folders.
Chain Letters

Chain letters—messages that try to convince people to redistribute it widely—are a form of computer virus. They live on computers and use naive people to spread themselves, taking up time, energy, and disk space along the way.

Be particularly cautious about messages that promise easy riches. You could be liable for criminal penalties if you advertise for a Ponzi or pyramid scheme—one where later participants send money to earlier participants. Do not trust messages that say that the scheme is legal. Those promises are worth as much as it cost to send the message: not much. Check with a lawyer before getting involved in anything that could possibly be a pyramid scheme.

Even well-meaning chain letters can have unpleasant results. The oldest and best example is the Craig Shergold letter. Craig was a nine-year-old boy battling cancer. He sent out a chain letter asking people to send him postcards. They did. Craig has completely recovered, and, as of this writing, is a healthy college student. Unfortunately, thousands of postcards are still coming, causing problems for his local post office.

So while it might sound cruel to ignore the plight of some poor soul, unless you research the case enough to determine that it is legitimate and still appropriate, don’t pass on a chain letter. Even if it is for a legitimate cause, it can get out of control.

If you must pass on or—yuck!—start a chain letter, at least do the following:

• Put a date, including the year, in the middle of the letter. If you put a date at the front or back, it is likely to get accidentally deleted. If you do not put a date in it, the message will live on past its useful lifetime.
• Put specific information about the issue and contact information so that future recipients can easily verify it.
• Show your name and email address prominently. If you don’t believe in the cause strongly enough to put your name on it, you shouldn’t send it.
Hoaxes

Hoaxes are a type of chain letter that propagate urban legends. Some hoaxes are scary and some are funny. Common hoaxes include:

- warnings of new forms of criminal activity
- promotions saying a large corporation will give a large sum of money to a worthy charity if they receive a certain number of email messages
- warnings about nonexistent computer viruses
- alerts about proposed governmental regulations or taxes

Hoaxes die if readers can investigate them easily. Thus, watch out for messages that don't have many concrete details. Most hoaxes don't include specific names of victims, perpetrators, or even investigating bodies. Hoaxes usually will not reference web pages or phone numbers that will give further information, nor will they give exact dates. Hoaxes usually do contain a lot of hysterical language and an urgent request to pass the message on to absolutely everybody that you know.

Armed with these guidelines, you should immediately suspect that the following is a hoax:

<table>
<thead>
<tr>
<th>From: Leo Newman</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: Re: Re: DANGER!!!</td>
<td></td>
</tr>
</tbody>
</table>

> >> I don't usually pass on chain letters, but this one is true! A friend of mine bought a Harik electric bagpipe to serenade his girlfriend with, and right after he plugged it in, it exploded! The blast was so strong that it broke his nose and her ribs!
> >> If you have a Harik bagpipe, take it in for a refund immediately, and tell everybody you know about the danger!
A message like the following is much more likely to be genuine:

```
From: Charlie Yzaguirre  To:  
Subject: bagpipe recall  Cc:  

Harik Bagpipes Corporation has found a problem with their Quicksilver bagpipes. If all the drones are blocked when the power is turned on, a feedback loop can make the bag quite hot. After approximately 30 minutes, it can explode.

Harik Bagpipes has recalled the Quicksilver model. They can be returned at their place of purchase or to Harik Bagpipes directly. (Other models are not affected by this problem.)

Our Web site has further information:
http://www.electricbagpipes.com/prod/recall.html

I, Charlie Yzaguirre <charlie@electricbagpipes.com>, have checked the sites mentioned. This seems to be a genuine problem as of 20 Feb 2036. Please do not pass this on unless you have checked the Web sites. Before you pass this on, please replace my contact information with your own.
```

You should investigate a story for yourself before passing it on to everyone you know. If it is a hoax, you might get a lot of messages pointing that out to you.
Affectionate Messages

There is a type of self-replicating message that preys on love instead of fear, anger, greed, or pity. These messages have some uplifting content, followed by a command to send the message to people you feel warmly towards. They might look something like this:

```
From: Charlie Yzaguirre       To: Mabel Garcia
Subject: FW: Fwd: beautiful smile Cc: 

>> >Your smile is beautiful!
>> >Like pentameter it whispers
>> >Delicate hurricanes of grace,
>> >Sweeter than a dream of roses.
>> >
>> >Send this message to five people who have beautiful
>> >smiles!
```

Despite the sender's good intentions, these types of sentimental messages are yet another form of virus.

Humor

Some people really like getting jokes by email. However, the practice is so common and widespread that sometimes people get overwhelmed by the number of jokes that they get. If a joke is so funny that you feel you must redistribute it, put HUMOR: in the subject. That way, your correspondents can delete it quickly or save it for later.

**TIP:** If you pass on any original material, please attribute the author. This gives credit where credit is due and allows people to find the author if they choose.
Junk Email

You probably hate junk email. So does everybody else. Sending massive amounts of unsolicited commercial email is inconsiderate and rude.

Sending junk email probably won't get you what you want, either:

- People get so much junk email now that they delete it pretty quickly. You probably won't get as many interested responses as you want.
- Your Inbox might fill with hate email and/or notifications of undeliverable email.
- You will lose your Internet account. Count on it.
- You might be liable for civil penalties under various anti-junk email laws.
- You might get harassed. If you give a phone number in your message, you might get thousands of people phoning to ask that you not send junk email. If you have a web site, it might get attacked by anti-spam vigilantes.

Sending junk email will greatly increase the amount of email that you get—until your account gets cancelled!

Further Information on Nuisance Messages

For up-to-date information on nuisance messages, see

http://www.OvercomeEmailOverload.com/hoaxes.html

Educate Your Correspondents

Sometimes your friends and colleagues will send you inappropriate messages—chain letters, “me too” messages, and so on. If you are in a position of authority, you might find subordinatesCc’ing you on more than you care for. Usually, your correspondents mean well. However, if you don't let them know that you don't want such messages, they will probably send more. That means more messages for you.

Your correspondents probably think they are doing you a favor, so you shouldn't be nasty about it. In fact, if you are not careful, you'll get an angry, defensive response back. Some examples of polite educational messages are in Chapter 6, Spend Less Time on Responses.
If you get a lot of messages from inside your organization, you might want to pay close attention to Chapter 11, *Improve Your Company's Email Effectiveness*. It shows how organizations can institute policies and create technological aids to improve email efficiency.

**Summary**

To reduce the amount of email that you receive:

- Don’t give out your email address. Try not to publish it anywhere on the Internet or give it to retailers. If you feel you need a public email address, get an additional account.

- While humans usually administer addresses in the Global Address List, software usually administers Internet distribution lists. If you join any Internet distribution lists, keep track of how to communicate with the software.

- Unsubscribe from some of your Internet distribution lists. Alternatively, switch to a digest, announcements-only, or moderated list.

- Discourage responses by writing formally, explicitly mentioning that you don’t need a response, thanking in advance, avoiding rhetorical questions, and using voting buttons.

- Discourage discussions between your correspondents by making it hard for them to see and respond to each other’s messages. Whenever possible, use Bcc or reply to the sender only instead of to everybody.

- Send fewer messages. In particular, don’t send junk—“me too” messages, messages that don’t apply to most of the receivers, unsolicited advertisements, hoaxes, chain letters, and affectionate chain messages.

- Ask your correspondents not to send you inappropriate messages.
You’ve cut down on your incoming messages. The ones that still come through are organized and prioritized. Now you need to respond to at least some of them.

Responding to messages usually takes more time than reading messages. Composing is slower than typing: you have to think about what to say, write, rewrite, scratch your head, and rewrite again. Add in the difference between reading speed and typing speed, and you can see that writing a message takes a lot more time than reading one.

Responding to messages more efficiently can therefore save you a lot of time. This chapter will show you how to:

- **Recognize what messages don't need a response.** If you don’t respond to any messages at all, you’ll probably hurt your career and friendships. However, there are many cases where you don’t need to respond.
- **Recognize the right time to respond.** It isn’t always best to respond to a message the instant that you finish reading it.
- **Write common responses once and reuse them.** Outlook can help you to respond quickly and effortlessly to common questions.

While these techniques won’t completely eliminate the time you spend on replies, they can greatly reduce it.
Don’t Respond

It might make sense to ignore some messages. In a perfect world, you would have the leisure to respond to every message carefully and considerately. However, in this world, you have limited time. Furthermore, your correspondents also have limited time: they might not want you to respond.

Don’t Say “Thank You” or “You’re Welcome”

As mentioned in “Don’t Thank Your Correspondents Right Away” on page 109, you probably don’t want to regularly send messages that say only, “Thank you” and “You’re welcome.” It takes time for you and is probably a nuisance for your correspondents. Only send a separate thank-you message if there was an exceptional effort involved. (And if it was that exceptional, send a copy to your correspondent’s boss as well.)

It is much better to give thanks in advance or the next time you have reason to send email to them.

Don’t Respond to Junk Email

In almost all cases, you should not respond to junk email. While it might feel very good to fire off an angry message or to tell them to stop sending you messages, it probably won’t do you much good. A lot of junk email comes from temporary or non-existent accounts, so your message might come right back to you.

Responding can even increase the amount of junk email you get. By giving any reply at all, you let the senders know that your address has a real, live person attached to it. That makes your address more valuable to junk emailers.

If you want to take effective action to people who send junk email, you’ll need a fair amount of technical sophistication and time. The excellent book *Stopping Spam* by Alan Schwarz and Simson Garfinkel (O’Reilly & Associates, 1998) explains the procedure in detail. However, if you had enough free time to take effective action, you probably wouldn’t be reading my book.
Don’t Answer Messages from Strangers

You do not need to respond to email from strangers. While this sounds mean, the time you spend on strangers is time you aren’t spending on the people who matter to you.

If you have any sort of public persona, you can end up getting so many messages from strangers that it can take a long time to answer them all. Thirty minutes, an hour, four hours—at some point you have to stop. While it would be nice of you to respond, it isn’t reasonable for people to expect that you will always do so.

TIP: If you send email to a stranger, be pleasant and acknowledge that he or she is doing you a favor. Say please and thank you prominently.

Don’t Respond to Distribution List Loops

It is a good idea not to respond to any sort of multi-person email arguments. Occasionally, people will get caught in a nasty, self-perpetuating loop between people trying to help and people that they annoy by helping. I saw this happen once:

• Someone subscribed a large number of people to an Internet distribution list without their knowledge or permission. Furthermore, the list was misconfigured so that the list server address and the list name address were the same.
• A lot of people tried to unsubscribe.
• Many people wrote to the list saying something along the lines of, “Look, you idiots, don’t write to the list to unsubscribe! Unsubscribe like this …”
• A bunch of people wrote to the list saying, “I’m not an idiot, the list is misconfigured!”
• More people wrote to the list saying, “Please don’t send any more messages about unsubscribing!”
• Even more people wrote to the list saying, “Please don’t send any more messages telling people not to explain how to unsubscribe!”
• People responded by saying, “Come on, don’t be so mean! I made a simple mistake—you don’t have to jump all over me!”
Hundreds of messages went back and forth during the weekend that the unsubscribe feature was broken.

The more people on a list, the more likely that such an argument will start; the more people on a list, the more likely that such an argument will get out of control.

If you see a list getting locked into a bad loop like this, shut up and stay out of it. Giving advice almost always makes it worse, unfortunately.

**Look at How You Were Addressed**

You can sometimes tell if you need to respond to a message by looking at the location of your email address in the message headers. In general, you don't usually need to respond unless:

1. you are in the To list, and
2. the message is from someone you have responsibilities towards, and
3. the sender has a question.

If you are in the Cc list, then you probably should not respond unless there is something wrong in the message. Most people don't want to get messages like this:

```
From: Betsy Pirrot          To: Liz Alizadeh
Subject: Re: Release 3.1.4.2Cc: John D. Haines, ...

I got your message about the change orders.
```

The one exception: you should respond, even if you are only on the Cc list, if something in the message is incorrect or a problem. For example, suppose a message gave arrangements for a meeting for next Tuesday. If you know that the entire division will be at a conference next Tuesday, you should alert the sender.

Figuring out how you should respond when you are in the Bcc list is a little trickier. Because Bcc is sometimes used to spare people from follow-up discussions, it isn't always obvious if you should act as if you were in the To list or the Cc list. You probably want to act as if you were in the Cc list unless there is an direct question or order to you in the body of the message.
Be careful with the rule about direct questions: sometimes the sender will have a question but not ask it explicitly. For example the sender might discuss an issue but never actually say that they want a response:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Jeff Chee</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: report covers</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

Jeff --

I was thinking about the report covers. Blue might be better than teal.

--

Mabel

In this case, Mabel didn’t actually ask, “What do you think?” but the question is implied. Treat this as a direct question and give a response.

If you need to respond to a message, but won’t be able to answer for a few days, it is polite to send a message back. Don’t just say that you got the message, however. Say what you need to complete the action and when you expect that the action will be completed:

<table>
<thead>
<tr>
<th>From: Jessica Robinson</th>
<th>To: Charlie Yzaguirre</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: Friday card game</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

Charlie -

I don't know if I will be able to join you to play cards. My trial is on Monday, and I might be busy for five to ten years after that.

I will phone you by Friday morning if I will be able to join you for cards.
Read All Messages on a Topic before Responding to Any

Frequently, you are better off reading all of the messages on a topic before responding to any of them. This will help you avoid time-wasting sequences like this:

- Carlos sends a question to a distribution list.
- Jamshid reads Carlos’ question.
- Jamshid answers the question.
- Mabel reads the question.
- Mabel answers the question.
- Mabel reads Jamshid’s answer.
- Mabel feels stupid.
- Everyone else on the list gets annoyed at having to read two answers to the question.

Here’s another common sequence:

- Alicia emails a question to Mabel.
- Alicia finds the answer on her own.
- Alicia sends a message to Mabel telling her not to bother with the question.
- Mabel reads Alicia’ question.
- Mabel spends an hour researching the question.
- Mabel sends Alicia an answer.
- Mabel reads that Alicia didn’t need the answer.
- Mabel feels stupid.

Don’t be like Mabel! If you read all the messages on the same topic before replying to any, then you will know if someone else answered any questions raised. This will save you from wasting time on composing unnecessary messages.

As discussed in the introduction to Chapter 2, using rules to group related messages makes it much easier to see if there are further messages on a topic. Grouping messages will help you avoid making the mistakes above.
You might worry that if you don’t respond immediately, you will forget to reply. What if nobody answers Carlos’ question? The best way to make sure a question gets a reply is to create a response window (with the question quoted) as soon as you see that you might need to respond. Then, read all the other messages. If someone else answers the question, you can close the response window. If nobody addresses the issue, the response window will still be open when you finish reading your messages, reminding you to respond.

If you get a message that has multiple issues, it’s best to create one response window for each issue, editing each so it only quotes one of the issues. That way, you can keep track of each issue independently.

**Use Prewritten Responses**

If you send a few basic messages over and over again, consider saving those responses so that you don’t have to retype them. The easiest way to do this is to create signatures with the different responses. Then, when you open up a response window, click where you want the response to go, select **Insert ➔ Signature**, and select the response that you want.

You could use **Insert ➔ File** to insert a file, but the file would be an attachment. People aren’t always willing to open attachments, as discussed in “Send Attachments Infrequently” on page 180. Signatures, however, appear in the body of the message.
How to Create Signatures

To create a signature, select Tools→Options..., then click on the Mail Format tab. Click on the button labeled Signature Picker (Outlook 2000) or Signatures... (Outlook 2002). Then click on the New... button as circled in Figure 32 below:

Figure 32: Creating a Signature for a Prewritten Response

Be sure to be *extremely* polite in your canned responses. If all goes well, you'll be using these responses over and over again, including times when the person receiving the message is in a bad mood. If you are not careful now, some day someone will misinterpret your emotional tone and send you an angry message back.

If your prewritten message is vague, you can use it more often than if it is specific. The disadvantage, of course, is that vague responses are more likely to be ambiguous. (I cover ambiguity in great detail in Chapter 7, *Reduce Ambiguity.*) Sorry. Life is full of difficult choices.

The rest of this section covers examples of some prewritten responses.
Give Directions

Writing good directions takes a lot of time. It is a good idea to write and save good, clear directions for each route to your building:

To get to Floss Recycling's headquarters from Highway 914:
+ Take the Tubman exit north (towards downtown).
+ Take Tubman Road through three stop lights and turn left at the Lion's Pride restaurant. That's Goa Way, but the sign is hard to see.
+ Take Goa Way for six blocks. Floss Recycling Inc. is on the right-hand side in the big building painted like a floss dispenser.

---

To get to Floss Recycling's headquarters from the airport:
+ Follow Erhart Road out of the airport until you come to a fork in the road; take the right fork. You will then be on Goa Way.
+ Take Goa Way for six blocks. Floss Recycling Inc. is on the left-hand side in the big building painted like a floss dispenser.
If you know that someone is coming from a particular direction, you can quickly edit out all the directions that you don't need:

**From:** Mabel Garcia  **To:** Jamaal Lee  
**Subject:** Re: interview  

Jamaal --

I'm happy that we will finally have a chance to meet. I think you will find that Floss Recycling Inc. is a fun place to work.

To get to Floss Recycling's headquarters from the airport:
+ Follow Erhart Road out of the airport until you come to a fork in the road; take the right fork. You will then be on Goa Way.
+ Take Goa Way for six blocks. Floss Recycling Inc. is on the left-hand side in the big building painted like a floss dispenser.

**Respond to Vague Questions**

Some people write email that is difficult to figure out. (They haven't read Chapter 7, *Reduce Ambiguity*, yet.) Frequently the question will be too vague, like:

**From:** Warren Bailey  **To:** webmaster@ueci-h.edu  
**Subject:** campus information  

Please send me information about the University of East-Central Illinois at Hoopston.

This gives no clue about what the sender wants: admission application deadlines? The number of faculty? The acreage? The number of buildings? The name of the Engineering Dean’s dog?
If you are in a position where you get vague questions regularly, you can save time by developing an all-purpose response that suggests places to go for further information. For example:

I'm sorry, but your message wasn't specific enough for me to determine what interested you about the University of East-Central Illinois at Hoopston.

If you were interested in admissions, see http://www.admit.ecih.edu/

If you were interested in research, see http://www.ecih.edu/academics.html

If you were interested in sports, see http://www.sports.ecih.edu/GoBrooms.htm

If you were interested in alumni activities, see http://www.ECIHAlumni.org/

You can also try searching the University of East-Central Illinois at Hoopston web from http://www.ecih.edu/searchpage.html

Good luck in your search.

Hopefully, this will either answer the question or make the questioner understand that he or she will have better luck if they ask their questions more carefully.

**TIP:** If you want people who send you vague questions to leave you alone, make your all-purpose answer very long, boring, and impersonal. It will make them think that you are busy and uninteresting.
Even if you can’t write a response with specific advice like the one above, you can still create a signature for vague messages. You might want one like this:

```
I'm sorry, I couldn't figure out what you wanted. Please tell me
  + What *exact* area of the subject interests you?
    Please be specific.
  + What level of detail do you need?
  + What level of expertise do you have in this area?
  + What have you tried already?

Frequently, if you tell me what you will do with the information, that will answer several of the questions at once.
```

“I’m Busy”

You can also use a signature to tell people that you can’t give them much attention. For example:

```
I'm at the Floss Recycling Expo in North Dakota this week, so don't have much time for email. I read your message, but unfortunately don't have time to respond thoughtfully. I'll respond to your message next week.
```

Respond to Mass Mailing

As mentioned in “Educate Your Correspondents” on page 124, you occasionally might need to ask people to not send you mass mailings. A carefully written response that asks people not to send you mass mailings can save you a lot of time. This section has examples of signatures that you might want to use for discouraging nuisance email.
Hoax Responses

Hoaxes can be extremely annoying, as mentioned in Chapter 5, *Reduce the Number of Incoming Messages*. If you get hoaxes regularly, you can use a prewritten response like the following:

```
I applaud your public spirit in wanting to help all of us out, but this message has all the trappings of a hoax:
+ It uses lots of emotionally charged language.
+ It gives few specifics.
+ It is essentially impossible to verify: it does not give contact information for the original author, names of victims, perpetrators, or investigating bodies. There is no URL for further information.
+ It has no date.
+ It implores the readers to pass it on to everybody they know.

Hoaxes are a form of computer virus: they use unsuspecting readers to replicate and transmit the hoax. For more information on hoaxes, see
http://www.snopes.com
http://www.symantec.com/avcenter/hoax.html

I know that you wanted to help, but I get approximately 80 messages per day. Please do not send me any other mass-mailings in the future unless you check them out carefully yourself.
```
Chain Letters

For chain letters, you could try sending a message similar to the hoax message above, or you could just explain why you don't want to participate:

I appreciate that you thought of me, but I'm not interested in any sort of chain letters. Many chain letters are hoaxes or illegal. Even those that are valid when they are created frequently spin out of control -- especially if they don't have a date mentioned somewhere.

I am thus unwilling to pass on a chain letter unless I can check it out very carefully myself. And, given that I already get about 80 email messages per day, I don't have time to investigate them.

I know you thought I'd like to read the message, but please do me a favor and don't send me any more chain letters.

Thanks!

P.S. For more on chain letters, see http://chainletters.org
Humor Glut Responses

If you like getting jokes, but find them distracting, here is useful response to have available:

I appreciate you thinking of me and like the jokes you send, but I get approximately 80 pieces of email per day, making it tough for me to see what is urgent and what is not. While the jokes are nice, they make it even harder to see what is important.

If you could put "HUMOR:" at the beginning of a subject line, then I could set up my email program to automatically put jokes in another folder. That way I could still read the jokes, but at some time when I am not so busy. Could you do that for me? I know that's asking extra work from you; if that's too much to ask, then (sigh) would you mind taking me off of your jokes distribution list?

Again, I appreciate your jokes but just don't have the time to deal with them in my Inbox.

Thanks in advance!

You can then set up your rules to quietly put messages with HUMOR in the subject header into a jokes category or folder, as described in “Categorize Humor” on page 71.
Ask for Bcc

As mentioned in “Use Bcc Instead of To or Cc” on page 115, you'll get fewer messages if you are in the Bcc list instead of the To list. If you get a lot of messages that have a huge list of people in the To list, you might want to store a response like this:

Could you do me a favor, please?

In the future, when you send out a large mailing like the one I just got from you, could you please put the addresses on the BCC line instead of on the TO or CC line?

When all the addresses are on the TO or CC line:

1) Everyone can see all the addresses. Some people prefer to keep their addresses private.
2) Some people (depending upon their email software) have to wade through all the addresses to get to the body of the message.
3) If someone does a REPLY-TO-ALL by accident (instead of a simple REPLY to just you), everybody on the address list will get that message - which might not be relevant to anyone but you.

BCC keeps the addresses private, so none of those problems can occur.

I know you weren't deliberately trying to cause problems, and hope you aren't offended by this message. I just wanted to let you know of a better way.

Thanks!
Use Auto-Responders

You can set up your rules to respond automatically to messages. This is useful but dangerous: you might respond inappropriately if your rules misfire. For example, suppose that Rose Winkle, the chief operations officer, sends Mabel a message about the Payroll Department's budget. If Mabel's rules send a message about rose gardening in response to messages that have rose in the header, Rose Winkle will be pretty surprised!

However, if you are absolutely overwhelmed by messages, you could respond with a generic form that gives some information and tells how to bypass the automatic response and get to you. One way of getting past the automatic response is to tell people a secret word that will bypass your rules.

Put the secret word on a separate line to make it more obvious.

```
Hi --

I get a lot of email, much of it unsolicited commercial messages. I thus ignore any message that comes from an address that I don't recognize.

If you are looking for information on roses, please look at http://www.rosegardens.org

If you are looking for information on the Hoopston Hollering Hangar Honchos skydiving club, please look at http://www.hangarhonchos.org

If you are a real human being and that didn't answer your question, send your message again but put the word KERSHNUGLE in the subject line. I'll see the word and read your message.

Sorry to inconvenience you.
```
To respond to messages from strangers that don’t have the secret word in the subject, you need to change the default (last) rule in your rule list. (See “Default Rule: I Don’t Know You” on page 82):

```
Apply this rule after a message arrives
move it to the z-UnrecognizedAddress folder
    and reply using C:\Templates\UnknownAddress.oft
except if the subject contains KERSHNUGLE
stop processing more rules
```

You should put these rules after ones for getting rid of junk email. Otherwise, you will respond automatically to junk email.

To create a prewritten response that a rule can use, you need to create a template—another form of prewritten response. Create a new message, type in the message and/or subject line that you want, and Save As… as an Outlook Template (*.oft) file.

**Out-of-Office Messages**

One of the most common uses of auto-responders is to let people know that you will not be able to read a message for a while. If you use an Exchange mail server, you can create an Out-of-Office message with an assistant.
How to Create an Out-of-Office Message

Select Tools→Out of Office Assistant to bring up the Out of Office Assistant, as shown in Figure 33 below:

![Out of Office Assistant Main Page](image)

Figure 33: Out of Office Assistant Main Page

Press the button marked I am currently out of the Office (indicated by the upper arrow) then type your message in the upper box (indicated by the lower arrow).

The Out of Office Assistant will only reply once per correspondent each time you go out of the office.

**TIP:** When you return, Outlook will remind you to turn your Out-of-Office message off. Do so.

Your system administrator can configure Exchange so that Out-of-Office messages go to everybody or only to people inside your company. The only way to tell if Out-of-Office messages go outside the company is for someone outside the company to send you email. There are advantages and disadvantages to each method.

If Outlook sends messages to people outside the company, even junk mailers or people sending to your Internet distribution lists will get replies. Junk mailers will
then know that there is a person attached to your address; your distribution
listmates might get bored with Out-of-Office messages.

If Outlook doesn't send Out-of-Office messages to people outside your company,
you won't send messages to junk mailers or distribution lists. However, your
friends, family, and professional colleagues outside the company won't learn that
you're out.

With or without Exchange, you can set up automatic responses to messages that
are addressed to only you and from people you know about:

<table>
<thead>
<tr>
<th>Apply this rule after a message arrives sent only to me and with flasrecycling.com in the sender's address have server reply using a specific message and stop processing more rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply this rule after a message arrives sent only to me and from Loretta Garcia or Marge Garcia or Leon Garcia or Pierre Yzaguirre have server reply using a specific message and stop processing more rules</td>
</tr>
<tr>
<td>Apply this rule after a message arrives sent only to me and from Jeff Chee or Chantelle Williams or Wayan Li or Winston Thurd or Andy Jain have server reply using a specific message and stop processing more rules</td>
</tr>
<tr>
<td>Apply this rule after a message arrives sent only to me and from Jim Wilson or Priya Walkowski or Jessica Robinson or Andre Moretto have server reply using a specific message and stop processing more rules</td>
</tr>
</tbody>
</table>

Unfortunately, this will send a response every time one of the specified people
sends you a message, not just the first time.
Dangers of Non-Out-of-Office Auto-Responders

Auto-responders can be very handy, but you need to be careful. If you auto-respond with a Rule instead of with the Out of Office Assistant, your auto-responder can get caught in a loop. Take the following situation:

- Mabel goes on vacation.
- Tyronne sends Mabel email.
- Tyronne goes out of the country on business.
- Mabel’s email program sends Tyronne a message saying that Mabel is on vacation.
- Tyronne’s email program sends Mabel a message saying that Tyronne is out of the country on business.
- Mabel’s email program sends Tyronne a message saying that Mabel is on vacation.
- Tyronne’s email program sends Mabel a message saying that Tyronne is out of the country on business.
- repeat until Tyronne or Mabel get back...

Any sort of automatic response can get into a loop, but vacation messages are particularly likely to get caught in this kind of loop. During a vacation in January 2000, a major U.S. university had so many “I’m out of the office” loops that they had to take the entire email system down.

You should thus be very careful about autoresponses. Here are some steps to take to avoid loops:

- Do not reply automatically to messages from your hobby or announcement distribution lists. (You might want to temporarily unsubscribe to your distribution lists until you are back.)
- Do not reply automatically to bounce messages—automatic responses that tell you that a message that you sent couldn’t be delivered.
Summary

- Recognize that you don't have to answer or even read every single message.
- Attach your thanks to other messages. Don’t send a thank-you in its own message unless the effort was exceptional.
- You do not need to respond to strangers.
- If you ask questions of strangers, be sure to be very polite. Say “please” and thank them in advance.
- If you are in the Cc list, you shouldn’t respond unless there is something incorrect in the message.
- Read all messages on a topic before responding to any of them, but open a response window immediately if you think you might need to reply.
- Use prewritten responses.
- A long and boring all-purpose response will discourage further correspondence.
- If you use an automatic response system, give a magic word so that people can get your attention if the prewritten response doesn’t answer their question.
- You can’t tell if your Out-of-Office messages will go outside the company or not unless you test it.
- Don’t respond automatically to distribution lists if you can help it.
- Don’t forget to turn off Out-of-Office messages when you return.
Chapter 7

Reduce Ambiguity

Ambiguous messages waste time. At best, your correspondents will need to ask for further information. This will add to the stack of messages you have to deal with: at least one more message to write, at least one more message to read.

Worse, your correspondents might ignore the message. You'll have to send more email to get them to act.

At worst, your correspondents won't realize that they didn't understand your message and will do the wrong thing. You'll have to spend more time (and email messages) trying to correct the situation.

You might find that you have more trouble making your meaning clear in email than you do with other communications media. This is not surprising: you probably got lots of training on how to write paper documents, some on how to speak, and none on how to write email.

Centuries of improvements in printing technologies have led to variations in paper and typography styles. These differences can give clues to the content of the document: the Bickham Script font is for formal invitations while Greymantle is for stories of elves and fairies. Email, by contrast, is so new that it doesn't have enough variation to give the same type of clues. Furthermore, because email messages move so quickly and are so easy to reply to, they tend to be dialogues like speech, not monologues like paper correspondence. Therefore, training on how to write paper documents won't, by itself, teach how to write email well.
Email has some similarities to spoken communication, but isn't exactly like speech. The printed word doesn't convey gestures, intonation, or facial expression. This means that knowing how to speak well also doesn't automatically mean knowing how to write email well, either.

This chapter examines in further detail how email is different and how to properly convey your meaning.

**Provide Adequate Context**

Without adequate context—information about a message's environment or situation—messages are not as understandable. Consider the following newspaper headline:

*Bulls and Bears Face Similar Challenges*

If you are from North America, this headline will have at least three different meanings. If it is in the business section, the headline is about stockmarket analysts or investors. If the headline is in the sports section, it refers to professional sports teams based in Chicago. In the science section, the headline is about large mammals. (If you are from outside North America, you might not have the cultural context to understand the first two meanings.) The headline is perfectly understandable with adequate context and ambiguous without it.

Unfortunately, email messages don't provide much context. By and large, email messages all look the same regardless of who sent them, where in the world they came from, and what they are about. A message could be a budget forecast, party invitation, joke, or request for information. Adequate context is essential.
Quote the Previous Messages

As you probably have already seen, a simple and effective way for you to give context to a very brief response is to quote from the previous message. You've probably been annoyed by colleagues who send messages like this:

<table>
<thead>
<tr>
<th>From: Winston Thurd</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: progress</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

no

When your correspondents quote some of the previous message, they are much more understandable:

<table>
<thead>
<tr>
<th>From: Winston Thurd</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: progress</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

>Are you going to have the budget estimates done by Thursday?

no

Make References Concrete

A common problem with lack of context comes from words that take the place of things that aren't mentioned in the message:

<table>
<thead>
<tr>
<th>From: Jeff Chee</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: cover selection</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

I talked to them about it, and they want to see the other one before they make up their minds.

Even if Jeff quoted some of the previous message, Mabel might still have to struggle to figure out what *it*, *they*, and *the other one* refer to.

While you need to avoid references to missing things in any kind of writing, it is a particular problem in email because it feels so much like a conversation. If you are responding to a message that you just received, it might feel like you don't need to
explain what you’re talking about. However, unlike in a face-to-face conversation, you won’t notice when your correspondent shifts his or her attention to other things. Your correspondent might have six hours of meetings between sending a message and reading your response.

Fortunately, you have a good chance of spotting potential problems by looking for certain types of words. Carefully examine your message for the following place-holding words and consider using more specific words:

- pronouns (such as his, it, or those)
- common names (such as Chris or Dave)
- concept holders (such as information or data)
- relative expressions of place (such as here or there)
- relative expressions of time (such as today or next Wednesday)

Pronouns

Using pronouns for people or things that aren’t explicitly mentioned is a very common problem:

<table>
<thead>
<tr>
<th>From: Alex Gupta</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: rose garden tourCc:</td>
<td></td>
</tr>
<tr>
<td>He said that he would give me a tour if you would lend him the keys. Could you get the keys to him by Saturday?</td>
<td></td>
</tr>
</tbody>
</table>

Examine any pronouns carefully, particularly in your first three sentences, and replace any that are ambiguous:

<table>
<thead>
<tr>
<th>From: Alex Gupta</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: rose garden tourCc:</td>
<td></td>
</tr>
<tr>
<td>Ezra said that he would give me a tour if you would lend him the keys. Could you get the keys to him by Saturday?</td>
<td></td>
</tr>
</tbody>
</table>

Common Names

Common names can be almost as confusing as pronouns. Chris might be Christine Olszewski, Christopher Chen, or Christiaan Phrockmeijer. (A friend worked at a place where ten percent of the employees were named Mike. There were a few
groups that even had two people with the same first and last name.) Minor variations in spelling can also confuse people: which coworker is Ann and which is Anne?

If you mention someone whose name is common, do at least one of the following:

- write out enough of the name to make it unambiguous
- give their email ID (like jsmith or rowilliams)
- mention the person's position in the organization

Concepts

Placeholders for concepts, like idea, data, and information are warning signs that your message might be too vague. Questions like this are difficult to answer:

<table>
<thead>
<tr>
<th>From: Mercedes Meyers</th>
<th>To: <a href="mailto:info@ueci-h.edu">info@ueci-h.edu</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: information</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Please send me information.</td>
<td></td>
</tr>
</tbody>
</table>

Your correspondents will reply faster, more accurately, and more completely if you get rid of words that refer to concepts:

<table>
<thead>
<tr>
<th>From: Mercedes Meyers</th>
<th>To: <a href="mailto:info@ueci-h.edu">info@ueci-h.edu</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: UECI-H history</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Are there any Web pages about the history of practical jokes at the University of East Central Illinois' Hoopston campus?</td>
<td></td>
</tr>
</tbody>
</table>

Places

Here is a very imprecise word in cyberspace. Given that people can access their email from just about anywhere, here could be a workplace, a home, a hotel, or even an Internet cafe. There is even more ambiguous, since it refers to where you think that the receiver will read the message, not where the receiver does read the message. Be very specific when you refer to places.
Time

Times and dates can also lose their meaning. Words like yesterday, today, tomorrow, last Monday, and next month are dangerous in email. Next Thursday might pass before your correspondents—or whomever they forward the message to—see the message. Although your messages contain the date and time that you sent them, that information can get lost when the message is forwarded. Thus, you should always spell out dates fully. Times should include not just AM or PM, but also the time zone if there is any possibility of misunderstanding.

Typographical errors in dates are very easy to make, and can have disastrous consequences. It is a good idea to mention the day of the week. Then, if the day of the week doesn't match the date, your correspondent has a chance to notice that something is wrong.

Examples: Bad and Good

Here is an example of a message with ambiguities in place, time, and concept:

<table>
<thead>
<tr>
<th>From: J. Wilson</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: meeting</td>
<td>Cc:</td>
</tr>
<tr>
<td>Hi - Can you come here for an informational meeting next Monday at 8?</td>
<td></td>
</tr>
</tbody>
</table>

People will be more likely to come to the right place at the right time for the right reasons if the message reads as follows:

<table>
<thead>
<tr>
<th>From: J. Wilson</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: HRGC meeting Mon 1/19?Cc:</td>
<td></td>
</tr>
<tr>
<td>Hi - Can you come to a meeting of the Hoople Rose Gardening Club next Tuesday, 19 Jan 2038 at 8 PM? Ezra P. Snodwhistle will give a report on last month's meeting (5 Dec 2037) with the Pest Control Superintendent. The meeting will be in the Waldo Room of the Hoopston Third National Bank.</td>
<td></td>
</tr>
</tbody>
</table>
Putting information in a very simple table can help the information stand out:

<table>
<thead>
<tr>
<th>From: J. Wilson</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Subject</strong>: HRGC meeting Mon 1/19?<strong>Cc:</strong></td>
<td></td>
</tr>
<tr>
<td>Hi - Can you come to a meeting of the Hoople Rose Gardening Club? Ezra P. Snodwhistle will give a report on last month's meeting (5 Dec 2037) with the Pest Control Superintendent.</td>
<td></td>
</tr>
<tr>
<td>DATE: Tuesday, 19 Jan 2038</td>
<td></td>
</tr>
<tr>
<td>TIME: 8 PM</td>
<td></td>
</tr>
<tr>
<td>PLACE: The Waldo Room of the Hoopston Third National Bank</td>
<td></td>
</tr>
</tbody>
</table>

Repeat Subject in the Body

Providing the appropriate context does no good if people don't notice it. In particular, people frequently don't pay close attention to the **Subject:** header. I once saw someone send a message like this to a large group of people:

<table>
<thead>
<tr>
<th>From: Roger Yzaguirre</th>
<th>To: Jessica Robinson</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Subject</strong>: party at Mama Del's 530-730p 2/6 <strong>Cc:</strong></td>
<td></td>
</tr>
<tr>
<td>Please join us in celebrating Mabel's 45th birthday at Mama Del's! Appetizers at 5:30 PM, pizza at 6:00 PM.</td>
<td></td>
</tr>
</tbody>
</table>

About a fifth of the people didn't notice the 2/6 in the subject header and wrote to ask the date of the party. The moral of the story: always repeat any important header information in the body of the message.

Ask Detailed Questions

You need to be particularly careful about context in messages that are not responses to a previous message. Your correspondent can't look up the previous message, so you need to be very clear.

Questions are most likely to need more context. If there is something you don't know about or don't understand, you're more likely to be vague—which could
frustrate your correspondent. You’d probably be frustrated, too, if you got messages like this:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Christopher Chen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: heating system</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

Please tell me about the building heating system.

Is this a question about the layout of the heating ducts? What type of wiring the system uses? What brand of controllers the system uses?

If you are going to ask a question—particularly of someone you haven’t met before—you need to frame your question carefully. If your question is too broad or vague, your correspondent might ignore it, delay responding, or send it back to you with a request for more details. Be sure to answer the following questions:

- Which specific aspect of the subject interests you?
- How much detail do you need?
- How knowledgeable are you already in the subject?

Frequently, if you explain what you plan to do with the information, that will answer the first two questions implicitly. For example:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Christopher Chen</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: heating system</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

Chris,

The conference rooms on the seventh floor are either too hot or too cold. I’d like to reset the temperatures in all three rooms.

Please tell me about the building heating system.
The second message is better than the first, but it would be even better with detailed questions:

From: Mabel Garcia          To: Christopher Chen
Subject: heating system     Cc:

Chris,

The conference rooms on the seventh floor are either too hot or too cold. I'd like to reset the temperatures in all three.

+ Can I reset the thermostats, or is that something that Facilities has to do?
+ If I can reset the thermostats, how do I do so? I looked at what I believe are the thermostats, and I couldn't find any knobs or dials on them.

Thanks!

Say What Action You Want

You can also be unclear if you don't explicitly say what you want to happen. In spoken conversations, the context usually makes it clear if you are expressing a desire, an opinion, a fact, an order, or a question. In email, it is not as clear. For example, look at the following message:

From: Mabel Garcia          To: Jeff Chee
Subject: report covers      Cc:

I was thinking about the report covers. Blue might be better than yellow.
Why did Mabel send this message?

- Is Mabel ordering Jeff to change the color of the report cover?
- Is Mabel expressing an opinion that Jeff can ignore if he chooses?
- Does Mabel know a fact about the covers that makes blue a better choice than yellow?
- Does Mabel want Jeff’s opinion on the color?
- Does Mabel want to know if there is a penalty for changing the cover color?

Mabel’s message would be clearer if she were more explicit:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Jeff Chee</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: report covers</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

I was thinking about the report covers. Blue might be better than yellow.

Would there be any problem with changing the cover color?
+ Is blue more expensive?
+ Would blue clash with the other artwork?
+ Would changing the color delay production?

Please find out the answers to these questions and get back to me.

“Vocal” Techniques for Reducing Ambiguity

Email shares many traits with verbal conversations; people give fast, short contributions that they can’t take back. Because of the similarity, people tend to write exactly what they would say out loud. However, without the emphasis and pauses of spoken language, it is easy for your correspondents to interpret something differently from how you intended. This section will show how to use text to simulate vocal expressions.
Use “Intonational” Grouping

Pauses in speech help to group together sets of words. The following might be perfectly understandable in speech, but is unclear in text:

<table>
<thead>
<tr>
<th>From:</th>
<th>Frieda Kenyon</th>
<th>To:</th>
<th>Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: summer picnic menu Cc:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>It's time for the annual summer picnic! Which menu option would you like: hot dogs with lime gelatin, or lasagna with corn on the cob or green bean casserole?</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Is the green bean casserole a main dish or a side dish that goes with lasagna?

While a standard use of commas can make such groupings unambiguous, the sender and the receiver have to both agree on what “standard use” is. In American English, a comma is optional after the next-to-last item in a list. Furthermore, poor understanding of comma rules is common.

It is much safer to use spaces, tabs, and carriage returns to make the grouping clear:

<table>
<thead>
<tr>
<th>From:</th>
<th>Frieda Kenyon</th>
<th>To:</th>
<th>Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: summer picnic menu Cc:</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| It's time for the annual summer picnic! Which menu option would you like:  
  + hot dogs with lime gelatin  
  + lasagna with corn on the cob or green bean casserole? |

"Vocal” Techniques for Reducing Ambiguity
Some people like to make numbered outlines:

<table>
<thead>
<tr>
<th>From: Frieda Kenyon</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: summer picnic menu</td>
<td>Cc:</td>
</tr>
<tr>
<td>It's time for the annual summer picnic!</td>
<td></td>
</tr>
</tbody>
</table>

Which menu option would you like:
1. hot dogs with lime gelatin
2. lasagna with
   2a. corn on the cob or
   2b. green bean casserole?

Numbered outlines do make things very clear, but they can encourage people to respond with just a number. If you send messages with numbered lists, be prepared for responses that look like this:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Frieda Kenyon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: summer picnic menu</td>
<td>Cc:</td>
</tr>
<tr>
<td>2b</td>
<td></td>
</tr>
</tbody>
</table>

If you are asking a question and your correspondents all use the same Exchange server, you can use voting buttons, as described in “Use Voting Buttons” on page 112. If you have one button for each possibility, that will separate the options well. Otherwise, repeating all the information takes more work, but is the clearest of all:

<table>
<thead>
<tr>
<th>From: Frieda Kenyon</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: summer picnic menu</td>
<td>Cc:</td>
</tr>
<tr>
<td>It's time for the annual summer picnic!</td>
<td></td>
</tr>
</tbody>
</table>

Which menu option would you like:
+ hot dogs with lime gelatin
+ lasagna with corn on the cob
+ lasagna with green bean casserole?
An advantage of this last style is that it becomes very easy to quote the important part of the message. You're likely to get more concise and understandable responses, almost as if you had used voting buttons:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Frieda Kenyon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: summer picnic menu</td>
<td></td>
</tr>
<tr>
<td>I would like:</td>
<td></td>
</tr>
<tr>
<td>&gt; lasagna with corn on the cob</td>
<td></td>
</tr>
</tbody>
</table>

Use Emphasis

In speech, emphasis helps eliminate ambiguity. For example, the following sentence is unclear without emphasis:

I said that I would go to the store tomorrow.

Am I conveying the message that I am hurt that you doubted my promise?

I said that I would go to the store tomorrow.

Am I clarifying that I’m not going to the garden?

I said that I would go to the store tomorrow.

Am I telling when I plan on going to the store?

I said that I would go to the store tomorrow.

It is true that I could rewrite the message to eliminate the ambiguity:

As I explained already, I can’t go to the store today. I will go tomorrow.

However, it is easy to overlook that an ambiguity exists. It is generally obvious where you should put emphasis. You should add emphasis even if you don’t think something is ambiguous.

While Outlook lets you put words into italics, your correspondent’s email program might not be able to display them. (Chapter 9, *Make Messages Legible,*
explores the issue of differing presentation capabilities.) If you don't know what your correspondent's email program can display, it is far safer to use plain text. (It's also faster to type!)

Instead of italics, you can show emphasis with asterisks. Thus the above example could be written in email as:

<table>
<thead>
<tr>
<th>From:</th>
<th>Loretta Garcia</th>
<th>To:</th>
<th>Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject:</td>
<td>shopping trip</td>
<td>Cc:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>I said that I would go to the store <em>tomorrow</em>.</td>
</tr>
</tbody>
</table>

**Summary**

Ambiguous messages waste time. Your correspondents will be more likely to understand and respond to your messages properly if you:

- Quote the previous message.
- Rewrite your message to eliminate placeholders for people, places, dates, times, and concepts.
- Use whitespace—carriage returns, tabs, and spaces—to show how words should be grouped together.
- Emphasize words that you would stress in conversation.
- Ask for the result that you want.
- Use voting buttons.
- Frame questions carefully. Explain what specific aspect of the subject you are interested in, what level of detail you need, and what level of expertise you have.
You have probably already seen how destructive a flame war—a series of angry email messages—can be. An organization can take hours to clean up after even a minor battle. Besides generating an enormous number of messages, flame wars are emotionally draining. Reducing your participation in flame wars is a very good way to improve your email productivity.

Why is it so much easier to make someone mad in an email conversation than in a face-to-face conversation? Because text lacks not only vocal inflection but also body language. There is no twinkling of the eyes to say you are kidding, no slapping the back of your hand to show urgency or frustration, no slouching or slumping to display discouragement. Unfortunately, without these cues, it is easy for your correspondents to misinterpret your underlying emotion.

In addition, you can't see your correspondents' mood. In a face-to-face talk, if you see that someone is having a really bad day, you will adjust your message appropriately. You won't tell a joke to a guy who you can see is grieving.

Unlike paper documents, email doesn't have a built-in “cooling off” period. The combatants can send responses immediately—they don’t have to wait until they see the other person or until the postal carrier comes to pick up a letter. Email arguments thus can escalate very rapidly.

Finally, email is shorter than almost all paper documents. This means there isn't as much opportunity to convey emotional tone.
Even if you don’t make someone angry, not conveying your emotional tone adequately can lead to significant misunderstandings. It is important to be able to express urgency and uncertainty in messages.

Fortunately, there are a number of conventions that you can use to help express your emotional tone. These include analogues for body language and vocal inflection, as well as markers for urgency and uncertainty. This chapter discusses these techniques.

**Use Stand-ins for Gestures and Facial Expression**

You’ve probably already seen emoticons—textual pictures of faces—in electronic mail messages. By far, the most common three are:

- :-) *smiley*, which means, “I’m happy”
- ;-)) *winky*, which means, “I’m kidding”
- :-(( *frowny*, which means, “I’m sad or disappointed”

While there are numerous others from ill (()% to angry (>:-<) to astonished (:-o), these are much less common and so more open to misinterpretation.

**TIP:** People also sometimes use <gr‘n> or <g> to show a smile.

**TIP:** Recognize that emoticons won’t have much meaning to people whose email goes through a text-to-speech processor: imagine a computer reading a “winky” emoticon: “semi-colon dash close parenthesis...” Some text-to-speech processors leave out punctuation completely! If you think your correspondent might be using a text-to-speech processor, take the extra time to be explicit about your emotions.

Some people say that emoticons should never ever be used in business communications. I feel that it depends upon what type of communication it is. If you are wisecracking to your good friend in the office across from you, it is probably appropriate. If it is the vice-president addressing everyone in the
division, it is likely to be less appropriate. If it is a message to the CEO of your favorite foreign client, it is probably not a good idea:

Think of it this way: if it is a solemn enough message that it would be impolite to grin broadly if you said it in person, you shouldn't use a smiley face in email. If you might grin broadly in person, it's reasonable to convey that in email.

**Express Uncertainty**

Paper documents are usually designed to be **persuasive**. Authors usually avoid expressing any doubt so the audience will take their side of an issue. Email messages, on the other hand, are usually **collaborative**: people normally use email to find a consensus. This difference in purpose means that it is much more important to express your uncertainty level in email than in paper documents.

For example, suppose that the vice-president asked you how long it will take to finish a project. If you sound too certain, the vice-president might commit the entire division to an unreasonably early goal. Such a misunderstanding can lead to flame wars or damage your career.

Unless you are very certain what people will do with information that you give them, you should show when you have doubts about your information.
Punctuation

Here are some typographical tricks you can use to show uncertainty.

You’ve probably already seen (?) to indicate uncertainty or (sp?) when someone isn’t sure about the spelling of a word:

From: Liz Alizadeh  To: Mabel Garcia  Subject: CFO  Cc:  
>What's the name of the Chief Financial Officer?  
Chris Olshefsky(sp?). She's been CFO for two (?) years.

I like to use a leading and trailing question mark when there is an entire phrase that is uncertain:

From: Mabel Garcia  To: Loretta Garcia  Subject: parachute delivery  Cc:  
Sorry I couldn't bring your parachute to you. I got called into lunch with Chris Olszewski, who is the ?first female CFO? of Floss Recycling Technologies, Inc.

In this case, Mabel wants to show that she thinks there were no chief financial officers who were female before Chris got the job. Putting (?) after “first”, “female”, or “chief financial officer” could be misinterpreted. For example, a put a question mark after “female”, might imply that Mabel wasn't sure if Chris was female or not!

Several dots can symbolize a pause. This can be an indication that the sender is either discouraged or uncertain:

From: Mabel Garcia  To: Liz Alizadeh  Subject: Re: CFO  Cc:  
>What's the name of the Chief Financial Officer?  
Her name... oh yeah, Chris Olszewski. I wish I were moving up as fast in the world as she is...
Short Utterances

While most people think that “um” and “uh” are mistakes to be avoided at all costs, they actually have a purpose in verbal conversations. In a conversation, listeners get uncomfortable if there is too much silence in a sentence. They don’t know if the speaker is still composing his or her thoughts or if he or she has gone mentally missing. “Uh” and “um” alert the listener that the speaker is having trouble formulating speech, and it will take a moment for the sentence to resume.

Similarly, you can use “um” and uh” in your email to show that you’re having difficulty answering the question:

<table>
<thead>
<tr>
<th>From: Mei Lin</th>
<th>To: Carlos Diaz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: brochures supplyCc:</td>
<td>&gt;How many boxes of brochures do we have left?</td>
</tr>
<tr>
<td></td>
<td>Um. Seventeen, as I recall.</td>
</tr>
</tbody>
</table>

Clearly, you could write out that you are unsure:

<table>
<thead>
<tr>
<th>From: Mei Lin</th>
<th>To: Carlos Diaz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: brochures supplyCc:</td>
<td>&gt;How many boxes of brochures do we have left?</td>
</tr>
<tr>
<td></td>
<td>I'm not exactly sure how many boxes there are, but I think there are about seventeen.</td>
</tr>
</tbody>
</table>

However, that is a lot more keystrokes than “um.” You might find, as many people do, that typing a long explanatory phrase takes more time than you want to spend.

Express Urgency

You have probably heard this before, but it is worth repeating: use capital letters and exclamation marks very sparingly. The lack of emotional cues in email makes experienced email readers hypersensitive to any cues that they can find. Thus,
capital letters will convey the message that you are shouting. Many email users wince when they receive email like this:

Furthermore, upper case is hard to read. Because of the uniform height of capital letters, it takes about 10%-14% more time to read something that is entirely in uppercase than it does to read something that is in mixed case.

**TIP:** If you are such a poor typist that switching case is a burden for you, use all lower case instead of all upper case. It might convey the message that you are mumbling but is easier to read than all upper-case and doesn’t seem as aggressive.

### In Defense of Nonstandard Writing

I must warn you that there is a vocal segment that dislikes using nonstandard writing to express emotions. They argue that if Mark Twain could convey emotion without having to resort to such tricks, then we should not have to.

What they don’t acknowledge is that there are big differences between Mark Twain’s great novels and my electronic mail messages:

- It is flattering for someone to tell me that I should be able to write as well as Mark Twain, but not reasonable. Twain was one of the very best of the very best English-language writers. Most people sending messages are not as skilled as he was.

- Twain probably spent weeks on every chapter. I bet that he wrote, rewrote, thought, rewrote, went shopping, rewrote, went on vacation, rewrote, fixed his roof, rewrote, and rewrote some more. Twain didn’t have to deal with scores of email messages every day, as many people now do.

- Twain could spend hundreds of words to convey an emotional tone. Email is usually very brief, which gives the sender less chance to convey a tone accurately.
• Books are usually written to unknown audiences, while email messages are usually to specific people—making email messages much more personal. If a male left-handed rabbit herder read a book that said nasty things about male left-handed rabbit herders, he probably wouldn't be nearly as insulted as if someone emailed him insults about male left-handed rabbit herders.

Besides, even Twain could not write to convey his tone unambiguously. When I read *Tom Sawyer* in high school, I didn’t think it was funny. I naively accepted the outlandish situations.

It can be difficult to simultaneously convey emotions clearly and follow standard grammar rules. In the heat of the moment, one or the other is likely to suffer. While it is good to try for both, I feel that conveying emotions accurately is more important than following every grammar rule.

**If You Think Someone Insulted You**

You shouldn't respond angrily when you think you've been insulted. This is especially true if others are participating in the conversation. The sender might have been clumsy at expressing his or her emotion; you might have misunderstood. If you are quick to respond harshly, people might think that you have an uncontrollable temper, which usually does not lead to quick career advancement.

If you get a piece of email that angers you, it’s a good idea to take an hour to calm down. It’s an even better idea to wait overnight. Re-read it later, and see if you can find a gentler interpretation. Ask a friend or colleague to look over your shoulder at the message and see if they can see another interpretation. If you decide that the message really is insulting, get a trusted person to read over your response before you send it. In a flame war, you're always better off looking like the more reasonable participant.
You'll be much better off if you send a request for clarification than an angry response:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Wilbur Haliburton</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: turtles loose</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

Excuse me, I am slightly confused by your last message. I felt that my previous message (Subject: Re: turtles loose) was clear, worthwhile, and to the point.

If you meant to abuse me, could you please explain what it was that angered you? All that I could tell from your previous message was that you were angry, not why.

If you meant to abuse the owner of the turtles, you want Ray Mankowitz, not me. I have never owned a turtle.

An even better way to respond to inflammatory email is by talking to the person face-to-face or by telephone. You will have many more emotional cues to help you figure out the person's intent.

**Summary**

Emotion and meaning are more prone to misinterpretation in email messages than in more traditional communications.

- Wait before responding to a message that angers you. Have a trusted friend review any messages you wrote when you were angry.
- Convey emotions with emoticons.
- Capital letters and exclamation marks indicate urgency. Use them sparingly. If changing case is an enormous burden for you, use all lower case letters instead of all uppercase letters.
- Use uncertainty markers to show how confident you are about what you say.
CHAPTER 9

Make Messages Legible

What you see when you create a paper document is the same thing that your correspondent will see when reading it. This is emphatically not true with email messages. There are a lot of different email programs, each with their own way of presenting messages. If you and your correspondent have different email programs, his or her program might display a message quite differently from how you saw it. It is relatively easy to send people messages that they can’t understand.

Why is this? For starters, when people first started using Internet email in the early 1970s, the technical and social environments were very different. Early email messages used only very simple text. Anything else would have been impractical:

- Essentially everybody using the Internet spoke English—a language with a very simple alphabet (called the “Latin character set”).
- Computer-to-computer communication was very slow and expensive.
- Almost no computers had graphic display terminals.
- There was essentially no off-the-shelf software.

The first email standards didn’t allow attachments, styled text, or even non-Latin character sets. Later, when people decided they wanted to be able to send more kinds of messages, the software had to stay backwards-compatible with the simple text. This means that everything sent by email today—from video to Chinese hypertext to Spanish spreadsheets—is encoded in Latin characters.

Furthermore, because the Internet grew out of a U.S. government project, it was aggressively non-profit for the first twenty years of email. No one person or
company was allowed to control the email standards, so nobody could control the software. Anybody could write email software, and pretty much anybody did. Even I have written two (non-commercial) email programs. There are now many different email programs, each with different features and capabilities.

Finally, it would be impossible to make all email programs understand all file formats. In 1993, the email specification was extended to allow people to send *attachments*—documents in any arbitrary formats. However, the email program doesn't have responsibility for showing those documents. Instead, you must have “helper” programs that understand the various formats. If you don't have a program that understands a format, then you can't read that type of attachment.

So there are three reasons your correspondents might be unable to read your message:

- They might use an older email program that only understands plain Latin text.
- Their email program might have different features and capabilities from yours.
- They might not have the right helper programs to read the attachments that you send.

While your close co-workers probably all use the same email program that you do, you might need to correspond with people in other divisions, other countries, or even other companies. They might not have the same email program that you do.

If you send a message that your correspondent has a hard time understanding, he or she will probably send you another message. You will then need to spend time both reading his or her message and also re-writing your original message.

This section discusses the problems that can arise from a mismatch between the sending and receiving software and how to avoid having to send a message twice.

## How to Determine Your Correspondent’s Email Program

To figure out what email program your correspondent uses, open the message in its own window and select **View ➔ Options**.... This brings up a window that shows
all the message headers, including the ones that Outlook normally suppresses. Figure 34 shows the headers for a message written with Microsoft Outlook:

![Message Options](image)

**Figure 34: Message Headers**

(Note that Microsoft Exchange uses a different method for transferring messages than from ones that come from the Internet. If you use Exchange and get a message from someone on the same Exchange server, there will be no message headers.)

The name of the sender’s email program is usually in the *X-Mailer: or User-Agent:* line of the headers, as indicated by the arrow above.)
In some cases, it’s not straightforward to figure out what email program sent a message. Here are a few translations:

- If the entire box is empty, that means that it was sent with Outlook to someone on the same Exchange server.
- Mozilla means Netscape Communicator.
- Internet Message Service usually means Microsoft Outlook.
- Some versions of Eudora don’t use X-Mailer: or User-Agent:. However, you might be able to recognize Eudora messages from the first few characters of the Message-ID: header. A Message-ID: that starts with v, p, or a followed by four digits usually means that Eudora sent the message. (The four digits give the version number. For example, \texttt{v0421} means the sender used Eudora version 4.2.1.)

Message-ID: headers from Eudora for Windows frequently start with three digits, separated by periods which correspond to the version number. For example, Eudora for Windows version 4.0.1 sends messages with \texttt{Message-ID:} headers that start with \texttt{4.0.1}.

**Use Styled Text Infrequently**

Most current consumer-grade email programs (including Microsoft Outlook, Qualcomm Eudora, Microsoft Outlook Express, Netscape Communicator, and AOL) understand styled text. However, some older or more obscure email programs only understand plain text. Italics, bold, and color changes will show up to those programs as commands in the text. For example, the sender might see something like this:

<table>
<thead>
<tr>
<th>From: Tyronne Washington</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Phrockmeijer report</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

Hiya! Hey, I *loved* the presentation you gave to Christiaan this morning.
Great Job!
However, if the reader’s software doesn’t understand the formatting, the message will probably show up as something like this:

```html
From: Tyronne Washington <tyronne@flossrecycling.com>
To: Mabel Garcia <mabel@flossrecycling.com>
Subject: Phrockmeijer report
MIME-Version: 1.0
Content-type: text/html; charset="us-ascii"

<html><head><style type="text/css">-->
blockquote, dl, ul, ol, li { margin-top: 0; margin-bottom: 0 }
</style></head><body>
<div><font face="Arial">Hiya! Hey, I loved the presentation you gave to Christiaan this morning. Great Job!</font></div>
</body></html>
```

Keep your correspondent’s capabilities in mind when you send styled text. If you don’t know your correspondent’s capabilities, you might want to email everything as plain text.

**TIP:** Even if your correspondent’s email program can display styled text, you might still want to keep it simple. If you make your messages too pretty, your colleagues might think that you don’t have work enough to do. They might start giving you more work or sending you jokes.

If you are not using Microsoft Exchange as your email server, you can turn off styled text on a person-by-person basis. In their Contact form, under E-Mail address, there will be a checkbox labeled Send e-mail using plain text only. (If you are using Exchange as your server, you will not see this checkbox.)
You can set Outlook to prevent you from creating any new messages with styled text. To do this, go to the Tools→Options... and select the Mail Format tab. Next to Send in this message format (Outlook 2000) or Compose in this message format (Outlook 2002), select Plain Text.

**Use Default Font**

People sometimes like to dress up their messages with a nicer font. I will absolutely agree that proportional-width fonts (like in this paragraph) look nicer than fixed-width fonts like this:

This is a fixed-width (or monospaced) font.

However, you need to be careful when using a proportional-width font. Even if your correspondents’ software has the capability to change fonts, if that font you used isn’t on their system, their software might substitute a different font. That new font probably won’t have the same spacing as the font you used. Any vertical alignment that you have in your message (especially in tables) will probably be ruined.

For example, here is a message with a table that I composed in the same font as this paragraph, then converted into a monospaced font:

<table>
<thead>
<tr>
<th>Item</th>
<th>Jan</th>
<th>Feb</th>
<th>Mar</th>
<th>April</th>
</tr>
</thead>
<tbody>
<tr>
<td>Covers</td>
<td>700</td>
<td>650</td>
<td>800</td>
<td>1930</td>
</tr>
<tr>
<td>Copying</td>
<td>600</td>
<td>525</td>
<td>930</td>
<td>1245</td>
</tr>
<tr>
<td>Folders</td>
<td>550</td>
<td>930</td>
<td>125</td>
<td>970</td>
</tr>
</tbody>
</table>

Even if your correspondents use an email program that can display different fonts, they might not choose to see different fonts. Some people always use their default font. For example, because Windows fonts frequently appear very small on Macintoshes, Eudora for Mac OS lets its users choose to always use their default font. Thus, what someone reads might not look the same as what the sender correspondents wrote.
Whitespace

Because HTML removes extra spaces and tabs, messages that are displayed in HTML might look different from the messages you composed. This most commonly happens if your correspondent reads email through a Web-based service like Yahoo mail or Hotmail. The message above can sometimes look like this when read from a Web page:

<table>
<thead>
<tr>
<th>Here are my budget estimates:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
</tr>
<tr>
<td>Covers</td>
</tr>
<tr>
<td>Copying</td>
</tr>
<tr>
<td>Folders</td>
</tr>
</tbody>
</table>

If you need to send tables of information to someone who reads their email with a web-based service, ask if they have a different account. If they don't, you might want to send the information in a different form so that you don't have to send it several times.

Make Web Sites Easy to Get to

You're undoubtedly aware that Outlook recognizes URLs (the Uniform Resource Locators or Web addresses) in a message and makes them active. Clicking on a URL will take you to that Web location.

Unfortunately, not everyone's email program can recognize URLs. Even if your correspondent's program can, it is a lot dumber than your correspondent: the program will guess wrong sometimes. You can help the program recognize URLs correctly by taking care when writing messages.

Many email programs look for the character string http:// to decide if something is a URL or not. If the opening http:// isn't there, the program will think it is just regular text. This means your correspondent will have to copy the address and paste it into a Web browser by hand.
Outlook and Outlook Express will recognize URLs that start with www or ftp followed by a period. However, even Outlook and Outlook express can’t recognize URLs that start with something besides www and ftp. I don’t know of any email program that can recognize that these are URLs:

- www0.mercurycenter.com
- livepage.apple.com
- web.nwe.ufl.edu/writing/
- library.ci.sunnyvale.ca.us
- sports.yahoo.com

It is always safer to include the http://!

**Punctuation**

While Outlook almost always correctly recognizes where a URL finishes and where punctuation begins, some other email programs doesn’t recognize the end of a URL as well. Frequently, programs includes any punctuation that follows the URL. For example, look at the following message:

```plaintext
From: Mabel Garcia  To: Wilbur Haliburton
Subject: URL  Cc:

The URL is http://www.flossrecycling.com/phrock.html.
See if you like it!
```

Some email programs think that the last period (after html) is part of the URL. Thus, if people click on the link, they’ll get an error that the page doesn’t exist. This can lead to an unproductive email exchange, with one person insisting that the page doesn’t exist and the other insisting that it does.

I will admit that it looks ugly, but it causes less confusion if there is at least a space between the URL and any punctuation:

```plaintext
From: Mabel Garcia  To: Wilbur Haliburton
Subject: URL  Cc:

The URL is http://www.flossrecycling.com/phrock.html.
See if you like it!
```
You can enclose the URLs in angle brackets (<> to make the punctuation clear:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Wilbur Haliburton</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: URL</td>
<td>Cc:</td>
</tr>
<tr>
<td>The URL is <a href="http://www.flossrecycling.com/phrock.html">http://www.flossrecycling.com/phrock.html</a>. See if you like it!</td>
<td></td>
</tr>
</tbody>
</table>

Cut and Paste

Unfortunately, angle brackets right against the URL make it slightly harder to cut-and-paste the URL. A few years ago, I had repetitive strain injury, and had to operate a trackball with my foot. I was using an older email program that required cutting and pasting URLs, and had a really hard time getting the cursor between the < and the http. While I understand that not many people mouse with their feet, many diseases reduce manual dexterity.

A space between the URLs and surrounding punctuation makes it much easier to select a URL:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Wilbur Haliburton</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: URL</td>
<td>Cc:</td>
</tr>
<tr>
<td>The URL is <a href="http://www.flossrecycling.com/phrock.html">http://www.flossrecycling.com/phrock.html</a>. See if you like it!</td>
<td></td>
</tr>
</tbody>
</table>

To make cut-and-paste mindlessly easy for people, I put URLs on their own lines:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Wilbur Haliburton</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: URL</td>
<td>Cc:</td>
</tr>
<tr>
<td>Wilbur -</td>
<td></td>
</tr>
<tr>
<td>The URL is</td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="http://www.flossrecycling.com/phrock.html">http://www.flossrecycling.com/phrock.html</a></td>
</tr>
<tr>
<td>See if you like it!</td>
<td></td>
</tr>
</tbody>
</table>

Yes, the period after the URL is now missing. While this is ungrammatical, there is no good place to put it. Fortunately, most readers don't notice that it is missing.
Long URLs

If the URL is too long or too close to the end of a line, it can get split across two lines. If that happens, most email programs usually only recognize the first line:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Wilbur Haliburton</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: URL</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

Wilbur -

The report is at is http://www.flossrecycling.com/phrock.html. See if you like it!

Clicking on http://www.flossrecycling.com/phrock, will not take Wilbur to the right page!

If you can see that the URL is probably going to get split in two, mention that the reader might need to cut and paste both lines:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Wilbur Haliburton</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: URL</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

The report is at is http://www.flossrecycling.com/customers/phrockmeijer/2034-01-18/MeetingMinutes.html

(Note: you may need to cut and paste the above Web address into your browser if it doesn't fit on one line.)

**TIP:** If you put URLs on their own lines, they are less likely to get broken in two.

Send Attachments Infrequently

Attachments allow people to share any file in any format. GIF images, JPEG images, Word documents, WordPerfect documents, Photoshop files, Excel spreadsheets, and executable files are just a few of the types of documents people routinely attach to messages.
This can work very well: people can skim through the text of a message and save
long attachments for later. However, if the reader’s email program doesn’t
recognize attachments and receives a non-text file (like a Word document, a
binary, a picture, or even compressed text), it will appear as lots of garbage. Pages
and pages of garbage, usually.

The most common email programs all understand attachments. However, even if
your correspondents have email programs that understands what attachments are,
they still need to have the right programs to read the document. Think of it this
way: somebody can use the Post Office to send you any kind of document.
However, if someone sends you microfilm, you won’t be able to read it without
microfilm equipment.

Even executable programs aren’t always useful to your correspondent. Macintosh
programs won’t run on Microsoft Windows computers; Windows 2000 programs
will not run on DOS-only computers.

In general, it is a good idea to check with your correspondents to see what kind of
attachments they can understand before sending one. Be sure to ask about version
numbers and hardware platforms as well. Someone who has a Macintosh running
Microsoft Word 3.0 will have difficulty opening a Word for Windows 6.0
document.

If some of your correspondents are low on disk space or have a slow Internet
connection, they will not be happy to receive a large attachment—like a 200MB
video—no matter how funny it is. It is almost always better to post large
documents on the Web or in a public folder and email its location instead of the
file itself. If you don’t have that option, please email your correspondents first and
ask if they want the attachment.

Even if your correspondent is able to view your attachments, he or she might be
afraid to. You’ve probably already seen the problems that viruses in attachments
can give an organization. Plain text messages, on the other hand, can’t carry
computer viruses.

Finally, it usually takes extra effort to look at an attachment. Your correspondent
probably has to click on the attachment to open it, and it can take a few moments
for it to show up in a window.

Send Attachments Infrequently 181
If you don’t know what program your correspondent uses, it is almost always best to use plain text. It might be boring, but it is safe, fast, and everyone can read it.

**Word Wrapping**

If there is a mismatch in the line length between the sender and the receiver, the message will look ugly on the receiver’s screen. Some email programs will keep displaying the line until there is a carriage return, forcing the reader to scroll to the right:

```
To: Mabel Garcia
Subject: report printing

I’ve got the price quote for the report printing ready; as soon as I get a decision..."`
```

This is ugly and difficult to read.

Outlook, like many email programs, can *word wrap*—move words to a new line if the line length is longer than the window is wide. Outlook will always word wrap incoming messages, so the above message would be easy to read with Outlook:

```
To: Mabel Garcia
Subject: report printing

I’ve got the price quote for the report printing ready; as soon as I get a decision on the cover selection, I’ll be ready to go. Have you talked to the sales guys about whether they are ready to use the blue cover or do they want to wait and see the red one first?"
```

Outlook 2002 rewraps incoming messages that are poorly wrapped.

Outlook also wraps outgoing messages, so that your correspondents won’t have to scroll to the right to read all of your messages. However, there can still be problems for correspondents who don’t use Outlook.
In particular, you need to be careful not to put in carriage returns at the ends of your lines. If either Outlook or your correspondent’s email program has a different opinion of where the end of the line is, your correspondent will probably see alternating long lines and short lines. The break at the end of the long line will be from automatic word wrapping; the break at the end of the short line is from the Enter that you put in.

The best thing to do is to leave word-wrapping enabled and let Outlook figure out where the line breaks should be. Only hit Enter to start a new paragraph.

You might also sometimes see a pattern of alternating long and short lines when a message is quoted:

<table>
<thead>
<tr>
<th>From: Mei Lin</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Subject:</strong> report printing</td>
<td><strong>Cc:</strong></td>
</tr>
</tbody>
</table>

I've got the price quote for the report printing ready; as soon as I get a decision on the cover selection, I'll be ready to go. Have you talked to the sales guys about whether they are ready to use the blue cover or do they want to wait and see the red one first?

When this person quoted the previous message, the ‘>’ made the lines too long, so they wrapped.

*Word Wrapping*
How to Change Line Wrapping

If, in the normal course of your conversations, you frequently send multiply-forwarded messages with many angle brackets (>) at the beginning of the line, you might want to change the word wrapping length. To change the maximum number of characters Outlook will put on a line, select Tools→Options… and then select the tab marked Mail Format. If you use Outlook 2000, Press the button marked Settings and change the box next to Automatically wrap at, as shown in Figure 35:

![Figure 35: Wrapping Line Length (Outlook 2000)]
If you use Outlook 2002, select the tab marked Internet Format and change the box next to Automatically wrap at, as shown in Figure 36:

![Internet Format Settings](image)

**Figure 36: Wrapping Line Length (Outlook 2002)**

"From " at the Beginning of a Line

You need to be careful if a line in the body of a message starts with “From " (with a space after the “m”). Because of some shortcuts taken when email was young and didn't know any better, “From " at the beginning of a line is always modified.

Email was traditionally stored as one long file of text, with one message after another. The first line in any email message starts with “From” followed by *Space*. (Outlook hides that line, so you won't ever see it.) Email programs could thus tell where one message stopped and the next message started by looking for “From " (with a space) at the beginning of a line.

However, if someone wrote a message that had “From " at the beginning of a line, it could fool the receiving email program into thinking that it had reached a message boundary. Thus, when sending a message, email programs are required to modify lines that start with “From " (with a capital F) followed by a space.
Most programs—including Outlook—change “From” to “>From”. Outlook then changes “>From” in incoming messages back to “From”, but if your correspondent doesn’t use Outlook, the “>From” might be unchanged.

This means that your correspondents might think that you’re quoting something you’re not:

<table>
<thead>
<tr>
<th>From:</th>
<th>Milos Smith</th>
<th>To:</th>
<th>Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject:</td>
<td>patent application</td>
<td>Cc:</td>
<td>Pete Pittman</td>
</tr>
</tbody>
</table>

Dear Ms. Garcia:

Pete Pittman forwarded your application to me.

At 5:37 PM, Pete Pittman said:
> Milos --
> Please review this application and let the applicants know if they need to provide any additional information.
> From my review, it looks fine.

Here, it looks like Pete Pittman is the one who thought the application was fine, not Milos Smith.
Summary

• What you see when you compose an email message is not always the same thing that your correspondents will see when reading the message.
• If you don’t know what email program your correspondent uses, it’s safer to send messages as plain text.
• If your messages are too pretty, your colleagues might think you don’t have enough to do.
• When sending a URL in email, be sure to include the http:// part of it.
• Put URLs on lines by themselves.
• If the URL is long enough that it will cross lines, warn your correspondent that they might have to cut and paste multiple lines.
• Avoid all punctuation except for angle brackets (<> right before or after URLs.
• Some older email programs don’t understand attachments at all. Your attachments will then show up as pages and pages of garbage.
• Even when your correspondent’s email software can decode attachments, your correspondent might not have the right software to view it. It’s a good idea to check with your correspondent to see what format (including version numbers!) he or she can read before sending an attachment.
• Even if your correspondent has an application that can read an attachment, he or she might not want to open it.
• People with slow Internet connections or limited disk space might be annoyed if you send them large attachments. It is almost always better to post large files on a local network or the Web and send only the URL.
• All characters except the basic English typewriter characters are encoded in ways that might look different on your correspondents’ computers from on yours.
• Let Outlook figure out where to put the line breaks. Only type Enter to start a new paragraph.
Picture your correspondent. She’s sitting at a desk in a noisy office. She’s right under the cooling duct, so she’s cold. She’s wearing glasses that are two years out of date and has to lean forward to read her screen. Her neck is sore. She’s read fifty messages today and has another fifty in her inbox. She’s tired, and to top it off, she’s hungry. She wants to go home.

Why should she read your message?

If you don’t grab her attention, she might never get around to reading your message. You will then need to send her another piece of email (which she also might not read), chase her down in person, or phone her. What a waste of time!

If you don’t keep her attention, she might not read your message carefully and completely. She might skim over a key point and so not address it. Worse, she might abandon the message before finishing. Again, you would have to waste some of your time to get the response you need. Thus, it is a good idea to call attention to important messages.

You should also tell the truth about messages that are not important. If you routinely exaggerate the importance of your messages, your correspondents won’t believe you when you write a message that really is important. If, on the other hand, you always show when messages have low importance, you will gain credibility with your correspondents. They’ll be more likely to respond to your important messages.
This chapter shows techniques for quickly conveying a message’s importance and main points. In turn, this will help you get and keep your correspondents’ attention, allowing you to work more efficiently.

Get Attention

To get attention, you must make your purpose known quickly. If you waste your correspondents’ time, you’re not likely to get what you need when you need it. Ideally, your correspondents should be able to figure out what you want within the first few lines of your message.

Get Attention with Subject Headers

The first chance you have to get your correspondents’ attention is in the subject header of your message. A clear indication of a message’s topic and urgency will help your message stand out in your correspondents’ (possibly long) list of messages. Subjects should summarize the message compactly, with the most important ideas at the beginning.

If you have trouble coming up with a good subject, imagine walking up to your correspondent and saying, “I’d like to talk to you about…” or “I’d like to ask you about…” The words that complete the sentence will probably make a good subject.

Signal Words

You might already be using some high-impact words or abbreviations in subject lines to signal your intentions.

The words URGENT:, REQ:, ACTION REQUIRED:, CAUTION:, or DANGER: in subject lines will—unless you overuse them—call attention to your messages. Putting the signal words BTW:, FYI:, and HUMOR: in the subject line of your low-priority messages will make your other messages look more important by contrast. (See “Subject Signal Words and Abbreviations” on page 216, for more on common signal words.)
Because it might not be immediately obvious if a message is going only to one person or to many, you might be able to get more attention by using your correspondent’s name in the subject lines:

Subject: Mabel: budget estimates

Occasionally, the message will be so short that it will fit completely on the Subject: line. In such cases, you can end the Subject: line with EOM or eom, for End Of Message.

Subject: red minivan lights on, license 2DLH822(EOM)

Don’t forget to repeat the contents of the subject line in the body of the message, as mentioned in “Repeat Subject in the Body” on page 155.

TIP: Because not everybody understands EOM, you might want to spell out End of Message in the body of the message.

Signal Priority with Addressing Method

Which distribution option you choose—To, Cc, or Bcc—can tell your correspondents how you hope they will respond to the message.

To

You should use the To field for people who the message affects directly. This includes people who:

- have specifically requested information contained in your message or
- might know the answer to a question in your message or
- you would like to take an action in response to your message

Putting people in the To field encourages them to respond.

Cc

If you do not want a response unless something is wrong, you can use Cc. This lets people stay informed but tells them that they don’t need to respond, leading to less
email for you. There are several reasons why you would add a group of people to the Cc list:

- You think that one or more of the Cc group might have comments or corrections. You might be paraphrasing something one of the Cc group said, or you might be less of an authority than someone in the Cc group.
- You think the outcome of the conversation will affect the Cc group (but they won't have to take any direct action).
- You think the Cc group needs to know the information in the message. (For example, your boss might want to know what you're up to.)

Here is an example of a message that uses To and Cc well:

![Image](attachment:image.png)

**Figure 37: Using To and Cc**

Note that the toolbar in the Outlook 2002 message composition window has a few more buttons than in the Outlook 2000 message composition window.

Here Jim was the only one who needed to take an action as a result of the message, so he was the only one in the To field. John, Betsy, Donald, Charles, and Mary
Jane did not have actions that they needed to perform, so Liz did not put them in the To field. However, Liz wanted to give the Cc group a chance to make corrections if Liz misunderstood something.

If you think that your correspondents will want to read your message but not any later discussion, you should use Bcc. This is not only nice for your correspondents but also useful to you. The fewer messages your correspondents get from other people, the more time they will have for messages from you.

**Use Your Correspondent’s Name**

If you greet your correspondent by name in the body of the message, then you’ve made it clear that the message is specifically for him or her. Your correspondent will know that you are not tossing a message into an arbitrary group of people in the hope that someone—anyone—in the group will answer it.

If you are addressing a group instead of an individual, you can use a functional name in the greeting, like Dear Payroll Data-Entry Clerks. Even such an impersonal greeting tells each of the payroll data-entry clerks that the message might be of interest to them.

Yes, the address list can also show who else is getting the message, but if your correspondent uses the Preview Pane to read messages, the To and Cc fields might not be big enough to show all of the people. Many people also don’t look at the address lists. If you put the name in the body of the message, you make it obvious.

**Identify Yourself to Strangers**

People who don’t know you are much more likely to pay attention to your message if they have an idea of what you want and who you are. You should get their attention by answering the following questions very quickly:

- Who are you? In what role are you acting?
- How did you hear of your correspondent?
- Why will your correspondent be interested in your message?
Do this at the beginning of the message. It should not take more than three or four lines. Frequently, it will take only one sentence to answer all three questions. For example:

<table>
<thead>
<tr>
<th>From: J. Wilson</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: playground tour</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

Mabel -

Ezra Snodwhistle said that you were interested in getting a tour of the rose garden that I designed.

Ezra said you would like to see it before the Rose Gardeners' Club meeting on Tuesday, 19 Jan 2038, at 4 PM. I'd be happy to show you the garden, but I have to take my horse to the dentist that day at 3 PM. If you have time, I can show you the garden after the meeting.

Giving your name isn’t as important as explaining your role. Your name alone probably doesn’t help your correspondents figure out the message’s topic.

### Use Importance Levels

Outlook allows you to mark the importance of a message. This can be a useful attention-getter.

However, you should not rely too heavily on importance levels for getting attention.

- Different email software programs implement importance levels differently. Some of your correspondents might not be able to see the importance level that you set.
- Many people ignore importance levels because too many people set the importance level higher than their messages deserve.
- Rules can reset the importance level.

If you do mark messages’ importance levels, be realistic. If you mark all of your messages as high importance, people will stop trusting your ratings. You should mark no more than 10% of your messages as high importance. Conversely, you should be careful to mark low-priority messages as low importance. If you
consistently give your messages appropriate importance levels, your correspondents might learn to trust your ratings.

Mark importance levels for messages according to how important they are to your correspondents, not to you. That your child scored well on an exam might be the most important thing in the world to you, but it is unlikely that anyone else at your workplace will like being interrupted to learn that.

Also be sensitive to your status in your organization’s hierarchy. If you send something with high importance to your subordinates, they will give it more attention than if it came from a peer. Your subordinates might suddenly stop everything they were doing to handle a high-importance message from you. On the other hand, your boss might be irritated by a message that calls too loudly for his or her attention.

Keep Attention

Getting attention is not very useful if you can’t keep it. This is not a trivial task. Your correspondents undoubtedly want to deal with your message as quickly as possible. You need to make the message easy to read, make your points easy to find, and present yourself as someone worth responding to.

Make the Message Easy to Read

Your correspondents want to get through your messages as fast as possible. Help them.

Shorten the Message

Most email messages are part of ongoing negotiations so do not need to be very long. Whenever possible, keep your message short enough that your correspondents don’t need to scroll to see all of it. When reading a long message, they might decide that the delete button is easier to reach than the scrollbar.

Granted, if your document is a report or plan whose purpose is to give extensive detail—like an annual report or a marketing campaign plan—it might need to be long. In such cases, sending it by email might not be the best way to distribute it. If you have the capability, it is better to post long documents on a Web page and
send only the Web address. Besides keeping the email message short, this lets you make changes to the document after you send out the Web address.

People using some other email programs have to wade through all of the To and Cc addresses before getting to the body of the message. Using Bcc gets them to your message more quickly.

If you are uncomfortable hiding the other recipients with Bcc, you can put a line in your message somewhere that summarizes who you are sending the message to:

(Bcc used to trim the address list; this message sent to 50 of Mabel's most intimate friends)

You can also use the greeting to show who else is getting the message:

From: Roger Yzaguirre       To: 
Subject: birthday party!    Cc: 

Dear friends of Mabel's:

Mabel's 45th birthday is coming up soon. I am planning on having a party for her at Mama Del's next Saturday, June 6th, at 6 PM. Please join us!

Because hiding the addresses can be a signal that the receivers don't need to respond, you should say explicitly if you want the unnamed people to respond:

From: Roger Yzaguirre       To: 
Subject: birthday party!    Cc: 

Dear friends of Mabel's:

Mabel's 45th birthday is coming up soon. I am planning on having a party for her at Mama Del's next Saturday, June 6th, at 6 PM. Please join us!

Please tell me if you can come or not.
Shorten Paragraphs

You should keep your paragraphs short, not just your messages. It is easier to locate a sentence that is near the beginning or ending of a paragraph, so shorter paragraphs make it easier for your correspondents to find their places. While this is true when reading any text, it is especially useful when your readers scroll through text. The somewhat unpredictable jumping of scrolled text makes it even easier for readers to lose their place. Keeping paragraphs short reduces the chance that a reader will skip a sentence or two.

Avoid Attachments

As mentioned in Chapter 9, *Make Messages Legible*, not everybody can read all attachments. Even if your correspondents have the technical capability to open attachments, they might not want to. In addition to potentially exposing your correspondence to viruses, opening attachments can take a few moments that your correspondents might not want to spare. You are more likely to keep their attention with a plain, text-based message.

Make Your Points Easy to Find and Respond to

Making it easier for your correspondents to track the text is good, but you also need to make your points easy to find and respond to.
Cut Extraneous Information

One of the fastest ways to lose your readers is to hide the point of the message. In the example below, the real reason for sending the message is hidden in the middle of a huge amount of irrelevant material:

<table>
<thead>
<tr>
<th>From: Steven White</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: information</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

Dear Ms. Garcia:

I'm a nurse at the Medical Center of Carp (East Wing) in Indiana. I have two dogs, three kids, and a fabulous wife who comes from Paris, Illinois. She's also named Mabel, and her maiden name was Garcia, too! Quite a coincidence, huh? My business manager is really hassling me about my floss budget. He's a bit of a jerk, but I can't quit now, so I have to put up with it. How much floss per patient is reasonable? I have been using about 10 cm per patient per night. I guess I can see how hospital spending could get cut, what with HMOs and all. That doesn't mean I have to like it. My wife is pretty good at stretching our limited budget. For example, she has this great recipe for fake Cornish game hens that is so good that it doesn't matter what the price of real hens is. Would you like the recipe?

Your correspondents could easily get bored with a message like this and not read it carefully, postpone reading it, or ignore it completely. This means more work for you to get the response you need.

You are much more likely to get speedy responses with a message like this:

<table>
<thead>
<tr>
<th>From: Steven White</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: typical floss usage</td>
<td>Cc:</td>
</tr>
</tbody>
</table>

Dear Ms. Garcia -

I'm wondering what a reasonable floss consumption in a hospital setting is. I'm using approximately 10 centimeters per patient per night. How much floss do most hospitals use?
TIP: This advice assumes that your correspondent is busy and doesn’t care much about you. Your mother, however, probably wants all the details.

Put The Most Important Topic First

If you introduce topics in the order of their importance, your correspondent will find the main point right away. It’s also a good idea to mark nonessential text with the phrases “for your information” (FYI) or “by the way” (BTW). That way, your correspondent has a clearer idea of what points you care most about:

From: Steven White             To: Mabel Garcia
Subject: typical floss usageCc:

Dear Ms. Garcia -

I’m wondering what a reasonable floss consumption in a hospital setting is. I’m using approximately 10 centimeters per patient per night. How much floss do most hospitals use?

BTW, my wife is also named Mabel, and her maiden name was Garcia! Quite a coincidence, huh? She’s from Paris, Illinois, a wonderful mother to our two dogs and three kids, and a great cook. She’s got an outstanding recipe for fake Cornish game hens, for example. Would you like the recipe?
Discuss One Issue Per Message

Once your correspondents have found your main point, you need to make sure they don't lose it again. Sending a message with several unrelated issues that need a response can lead to trouble. It is easy for your correspondent to discuss only one of the points raised, forgetting the others. It’s even fairly common for people to neglect the most important issue, as in this example:

<table>
<thead>
<tr>
<th>From: Mabel Garcia</th>
<th>To: Steven White</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: typical floss usage</td>
<td></td>
</tr>
</tbody>
</table>

>Dear Ms. Garcia -
>
>I'm wondering what a reasonable floss consumption in a
>hospital setting is. I'm using approximately 10
>centimeters per patient per night. How much floss do most
>hospitals use?
>
>BTW, my wife is also named Mabel, and her maiden name was
>Garcia! Quite a coincidence, huh? She's from Paris,
>Illinois, a wonderful mother to our two dogs and three
>kids, and a great cook. She's got an outstanding recipe
>for fake Cornish game hens, for example. Would you like
>the recipe?

I love Cornish game hens! I would love to have that recipe.

Long messages are more vulnerable to this problem than short messages: what scrolls off the screen frequently scrolls out of short-term memory. Topics that require thought or a lot of research are also likely to make your reader forget previous topics.

You should try to limit your email messages to a single topic or set of closely related topics. If you only have one topic, your correspondents can't get distracted by other topics. While it is cumbersome to send two separate paper letters for two topics, addressing and sending email is so fast that sending multiple messages in succession should not be a burden.

If you are worried about what your correspondents will think to get a lot of messages from you all at once, ask yourself if you would rather get one long
message or several short messages. If it still bothers you to send multiple messages, put a note in the first message that warns them that further messages are coming.

**Summarize Long Messages at the Beginning and End**

If you send a message that raises multiple issues, summarize the issues at the beginning and end of the message. This is particularly important if there are questions that you need answered. For example:

```
From: Mabel Garcia          To: Chantelle Williams
Subject: staff meeting issues

Chantelle,

Yesterday's staff meeting brought up three issues: interns, the picnic, and the patent application.

First, the summer is approaching quickly, and we need to figure out how many interns we want. Jeff has already asked for an intern to help with the paper clip inventory, but I think we can get two more. Do you have any unpleasant tasks that a student could do?

Second, the Picnic Committee is still looking for a good place for the summer party. I remember your husband raving about the place his company's picnic was held a few years ago - that place where the geese stole his boss' toupee. Can you remember the name of that place?

Third, Martha Boise in Legal is ready to start working on your patent application. As soon as you and Winston have finished with the budget estimates, I'd like you to give the patent application your full attention.

So:
+ Where do you think summer interns would be useful?
+ Where was your husband's company picnic?
+ When will you and Winston finish the budget estimates?
```

The way this message is structured, Chantelle isn't likely to forget to answer any of the questions.
Separate Quotes with Blank Lines

If quoted and new material runs together, your correspondent might skip over one of your points, thinking it was part of a quote. If Mabel reads the following message quickly, she could miss the line in the middle. Mabel might think that Chantelle agreed to finish the budget estimates by Thursday:

<table>
<thead>
<tr>
<th>From: Chantelle Williams</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: budget estimates</td>
<td>Cc:</td>
</tr>
<tr>
<td>&gt; Are you going to have the budget estimates printed up and distributed by Thursday? Pat wants everything by Friday. No, I haven't gotten the sales results from Winston yet. &gt; Additionally, I'd like it if you would please order seven reports with blue covers (not yellow) for the Expo. I can do that.</td>
<td></td>
</tr>
</tbody>
</table>

A blank line separating quotes and next text makes the message much more legible.

It is also helpful to put two blank lines between the end of a section of new material and the start of another quote. The second blank line shows that you are done discussing the first quote and have moved on to the second quote:

<table>
<thead>
<tr>
<th>From: Chantelle Williams</th>
<th>To: Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Re: budget estimates</td>
<td>Cc:</td>
</tr>
<tr>
<td>&gt; Are you going to have the budget estimates printed up and distributed by Thursday? Chris wants everything by Friday. No, I haven't gotten the sales results from Winston yet. &gt; Additionally, I'd like it if you would please order seven reports with blue covers (not yellow) for the Expo. I can do that.</td>
<td></td>
</tr>
</tbody>
</table>

Chapter 9, *Make Messages Legible*, discusses in detail a number of other issues affecting legibility of messages.
Shorten Quotes

Electronic mail messages frequently contain material quoted from previous messages. There are good reasons for quoting material, as discussed in “Provide Adequate Context” on page 150. However, quotes that are too long or too hard to follow will make your correspondent lose interest and/or miss your point.

When you incorporate a long original message into a response, your response is more readable when you remove extraneous text and/or paraphrase the original message. This makes it easy for your reader to find your points. For example, Chantelle could respond to the message on page 201 by quoting only the last three lines:

<table>
<thead>
<tr>
<th>From:</th>
<th>Chantelle Williams</th>
<th>To:</th>
<th>Mabel Garcia</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject:</td>
<td>Re: staff meeting issues</td>
<td>Cc:</td>
<td></td>
</tr>
</tbody>
</table>

+++ Where do you think summer interns would be useful?

It would be really nice to have someone to keep the break rooms tidy and the coffee pots full.

+++ Where was your husband's company picnic?

It was held out at Land O'Clowns, but I can't recommend it. It was cold, windy, and the geese stole all the hot dog buns.

+++ When will you and Winston finish the budget estimates?

Tomorrow, I hope. Winston's creeping Norwegian sunwarts have stopped itching enough that he's able to concentrate again.

You should quote only enough context to make the message clear. Try to keep quoted material to less than half of the lines in an email message.

If you don't have time to edit a quote and must include the whole thing, put your comments before the quote. Paging through a long quote to get to your comments might irritate your readers.
**TIP:** Many people quote the entire message, no matter how long. If you shorten quotes, you will have less to read through when your correspondents quote your message back at you.

Use Voting Buttons

As mentioned in “Use Voting Buttons” on page 112, voting buttons can make it very easy for your correspondents to reply.

Raise Your Perceived Status

The higher your perceived status, the more interested people will be in reading (and finishing) your message. However, your correspondents can't tell much about who you are from email.

Your correspondents will probably do the same thing you might catch yourself doing—make assumptions on the flimsiest of pretexts. I am emphatically *not* saying that people *should* stereotype, just trying to warn you that they might.

Language

Your language probably influences people’s impression of your status more than anything else. Lots of misspellings, poor grammar, and misused words will make people suspect that you are uneducated. From that, they might conclude that you are not very clever. It doesn't matter that the correlation between language skill and intelligence is weak (especially among non-native speakers); many people will draw that conclusion anyway.

Some people are literally insulted by messages that contain errors, especially typographical errors. They feel that flagrant errors show disrespect: if you cared, you would have been more careful.

Outlook has a built-in spelling checker. If you don't see a spell checker appear after you click on *Send*, either you are a phenomenally good speller or that feature is turned off. Select *Tools* ➜ *Options*..., click on the *Spelling* tab, and put check marks in the boxes marked *Always suggest replacements for misspelled words* and *Always check spelling before sending*. If you want to check the spelling before you click on *Send*, press the *F7* key.
If you'd like to see errors as soon as you make them, you might like to use Microsoft Word to edit your email messages. In addition to finding spelling errors, Word will find some grammar errors as well. To use Word, select Tools→Options..., click on the Mail Format tab, and put a check in the boxes marked Use Microsoft Word to edit email messages and Use Microsoft Word to edit Rich Text email messages.

If you use Word to edit your email messages, you probably will want to turn off Outlook's spelling checker. Select Tools→Options..., click on the Spelling tab, and uncheck the box next to Always check spelling before sending.

**Show Status Explicitly**

You can influence people's impressions by showing your status explicitly. You can do this by adding a signature that shows your job title:

```
From: Martha Boise  To: info@deladuck.com
Subject: catalog request  Cc:

Please email me information about your product line.

--
Martha J. Boise
Vice-President of Legal Affairs
Floss Recycling Incorporated
```

Your signature should be brief. Your name is probably in the message header and your email address always is. To reply by email, your correspondent probably doesn't even need to look at your email address. You should only give your phone number and address if you are willing to get phone calls and visitors!

**TIP:** A signature sends a signal to your readers that they have read your entire message. If you don't routinely sign messages, people might accidentally stop after the first page of a two-page message. They are less likely to forget to scroll if they are used to seeing your signature at the end.
It can also be effective to start your message with status information:

<table>
<thead>
<tr>
<th>From: Martha Boise</th>
<th>To: <a href="mailto:info@deladuck.com">info@deladuck.com</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: catalog request</td>
<td>Cc:</td>
</tr>
<tr>
<td>Hi, I'm the Vice-President of Legal Affairs at Floss Recycling Incorporated. Please email me information about your product line; I'm interested in buying your company.</td>
<td></td>
</tr>
</tbody>
</table>

**Personal Opinion on Language**

I have read a number of “email etiquette” guides that say that you should always use correct grammar and spelling—as if the etiquette authority wants you to stop deliberately inserting errors.

Nobody wants their messages to have errors, but it takes time and effort to double-check a message. If you write forty messages every day, you might not have the time to make every message perfect.

I have known some people who are paralyzed by their perfectionism. They worry so much about getting everything right that they never send any messages. I would much rather quickly get a response with errors than never get a perfect one. If you don't respond to my messages, I will think less of you than if you don't conjugate your verbs properly.

If you only have a limited amount of time to spend on a message to me, I'd prefer that you spend your time making sure there is adequate context than on making your grammar flawless. I'd much rather get a message that says:

<table>
<thead>
<tr>
<th>From: Loy Duncan</th>
<th>To: <a href="mailto:announce@flossrecycling.com">announce@flossrecycling.com</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Subject: Guns! Warning! Danger!!!Cc:</td>
<td></td>
</tr>
<tr>
<td>There is 50 people with machine guns on Main Street abt 1 mi away wallking north and they not friendly so getcher selfes outta here proto!!!</td>
<td></td>
</tr>
</tbody>
</table>
I can usually guess what the proper grammar is; I usually can't guess what the proper context is.

Choose Your Battles Wisely

How much energy should you invest in raising your status for a particular message? That depends upon several things:

- Do you know your correspondents already? Your message probably won't change their opinions of the people you work most closely with, but if you are sending a message to someone in another division who you've never met, you probably want to mention what your job function is.
- What depends on the message? If you are sending email to the head of your organization, you probably should be careful about your grammar. Salespeople who want your business, on the other hand, are paid to not care about your grammar.
- Are your correspondents likely to care? The head of the documentation department might care more about your spelling than your project team leader. People who send lots of email will probably be more tolerant than people who have the luxury of spending an hour on every email message.
- What do your correspondents’ messages look like? If they send you email with incorrect punctuation, poor spelling, and bad grammar, they probably won't care too much if you do the same.
Summary

To get attention:

- Write a compelling subject header that is compact and summarize the message.
- Put signal words in subject headers: URGENT:, REQ:, ACTION REQUIRED:, CAUTION!, DANGER!, and first names are useful to raise priority. FYI: and BTW: are useful for conveying that a message is of lower urgency.
- If you can keep the message to one line, put it in the Subject: line. Use eom at the end of the subject to show that there is no further information (but be sure to repeat the information in the body of the message!)
- Use To for people who you want to take an action. Use Cc for people who are interested, affected, or authorities. Use Bcc to shorten address lists, maintain privacy, and spare your correspondents from follow-up discussions.
- Use importance levels, but only mark things urgent if they really are. Always show when a message is low-importance.
- Identify yourself to strangers and explain why you chose to write to them.

To keep attention:

- Make your messages and paragraphs short: reading while scrolling through messages is hard.
- Cut information that isn’t essential. Shorten long quotes, paraphrasing or deleting as needed.
- Put topics in order of importance.
- If you need to write about unrelated issues, try to put them in different messages.
- Summarize messages that are long or contain several unrelated topics. Do so at both the beginning and the end of the message.
- Use white space between quoted material to improve legibility.
- When asking for a favor, show that you’ve already put some effort into solving the problem.
- To raise your perceived status, use proper grammar and spelling or explicitly give your position. Using Word to edit email messages can make grammar- and spell-checking less painful.
CHAPTER 11

Improve Your Company’s Email Effectiveness

Changing your own behavior—setting up rules, using prewritten responses, writing good subject lines, providing adequate context, and so forth—will make getting through your email much easier. However, at some point, you will be limited by how well your company deals with email.

Your company’s email behaviors might have been the result of conscious decisions, but it’s more likely that its culture evolved spontaneously. Your company can probably improve its email effectiveness.

There are three basic ways to change behavior in a company: improve resources, provide training, and set policy. This chapter will discuss each method and suggest specific examples of each that can help improve email efficiency.

Improve Resources

Providing good resources can make desirable behaviors easier and undesirable behaviors harder or impossible. Technology is one powerful resource for changing behavior. Unfortunately, technological changes almost always cost money—from buying (or developing), configuring, and maintaining the software.

If you are technically proficient, you might be able to influence your company’s email usage by developing one or more of the following resources.
Web-based Distribution List Interface

If your company sets up distribution lists for different functional groups, your company will be more productive. Not only do distribution lists make it easy to send messages to the right people, they make creating and using rules extremely easily. This improves people’s ability to organize and prioritize.

Making it easy for people to set up distribution lists is thus good for the company. Something that works well is to have a web-based interface to distribution lists with information on

- what lists are available
- what their policies are
- who the “owner” of the list is
- who has subscribed
- how to subscribe
- how to unsubscribe

A searchable Web-based archive with all the messages from a list is also very useful.

- An archive helps people who delete a message and then decide later that they wanted to see it.
- It is easier to catch up after an absence if the distribution list messages are in an archive.
- An archive is a useful resource for training new employees.
- An archive creates a record of what decisions were made and why.
- People are sometimes a bit more polite and careful if they know that their comments are stored.

External Subscribers

Letting people from outside the company subscribe to distribution lists has benefits and disadvantages. If your company allows people from outside the company to be on a distribution list, employees can send confidential information outside the company accidentally. (Because senders can’t always see who is on a list when they mail to it, it is easy to make that mistake.) On the other hand, if your company does not allow external subscribers, then nobody can set up lists of customers and vendors that you might want to correspond with in bulk. One
compromise solution is to have a privileged set of people who can create and maintain distribution lists with both internal and external subscribers.

Your company might also want to have a different naming convention for internal-only and internal/external lists. That way, people can see quickly how confidential a message to the list would be.

**Geographical Distribution Lists**

There should be a distribution list for every geographical area so that messages that apply only to one location don't also go to other locations. The classic example of what happens if you don't have this is everyone worldwide getting messages like this:

Subject: blue Ford ZRSM183 - headlights on

Facilities closures, maintenance, and party announcements are frequently mis-addressed as well.

Once your company has geographic distribution lists, training can impress upon people that they shouldn't waste people's time by sending to the wrong list. Peer pressure can keep people from making that mistake twice.

**Reply-to-all vs. Reply-to-sender**

Distribution list servers should be configured so that the From line has the author of the message, not the listname address. This will ensure that simple replies (including Out-of-Office messages) go to just the original author, not the whole list. It would be nice if people wouldn't send automatic responses to distribution lists, but the more people you have on a list, the more likely that someone will make that mistake.

**Virus-Checkers**

Email attachments can contain viruses. Hopefully, everyone will have the latest virus-checking software on their desktop computer. However, some people are lazy. Unfortunately, if one person fails to install the latest virus-checker, that can affect the entire company. It is slower but safer to check all attachments automatically before the receivers have a chance to see them.
Certain types of attachments are more prone to viruses than others. In particular, executable files (with extension .exe) can be deadly, and are rarely useful. Your company might wish to delete all .exe attachments that come from outside the company.

**Eliminate Duplicates**

If your company’s distribution list software can remove redundant copies of messages, that can save people a lot of aggravation. There will come times when a message is appropriate for several different distribution lists. If people subscribe to multiple lists, however, that means they could get multiple copies of the same message—which gets dull quickly. Sending each person only one copy of a message will help people get through their email faster.

**Develop a Good Web Site**

A good Web site for your company or department means that people can refer to information there instead of creating it all themselves. For example, if your company has a Web page with a map and directions to its location, people won’t have to spend time writing directions. They can instead send the URL of the map.

Any sort of information that people ask about regularly is helpful to put on a Web site. These include things like benefit details, lists of medical providers, technical specifications, organization charts, and even floorplans.

**Develop Corporate- or Department-Wide Responses**

It might save time for someone in the company to carefully develop prewritten responses for common questions, and then make them available to the whole company. For example, a non-profit might make a mission statement available. A corporation might want to have a blurb directing people to the public relations department:

I’m sorry, I really am not the appropriate person to discuss this with. You need to talk to Sal Mgabi in our Public Relations department. His phone number is +1-217-555-7777x77.
A Customer Support department might have a large number of canned responses that would be useful to have easily available, like:

The problem of the Harik Quicksilver Electric Bagpipes overheating has been fixed in release 3.1.4.1.5.9. To download the patch, go to http://www.electricbagpipes.com/harik/rel314159.zip

The overheating is only a problem if all the drones are blocked. Keeping the drones clear will prevent this problem.

Should you have any further questions, please do not hesitate to ask.

Good Email Software

Outlook is an adequate email program. However, for people doing customer support, Customer Relationship Management software might be better.

Customer Relationship Management (abbreviated CRM or eCRM) software makes it easier to keep track of and use a company’s prewritten responses. While these are most useful for customer support personnel, they can also be useful for anybody who gets many routine questions.

I have found that an “auto-suggest” rule action is extremely useful. I was able to get through messages about ten times faster when I had a system that let me select (with one click) from several suggested responses. I could then, if I chose, edit the response(s) before sending them.

This isn’t as fast as responding completely automatically, but allowing a human being to make the choices cuts down on the number of inappropriate responses. Humans are still a lot smarter than computers.

Most CRM software will also allow you to track all communication that you have had with the sender of the incoming message. Again, this is most useful for support personnel, but anybody who manages a lot of communications—like people in sales or fund raising—could find it useful.
Provide Alternatives to Distracting Messages

People, left to their own devices, will generate all kinds of messages that are not directly related to work. Some of the most common non-work messages are about

- goods to buy, sell or give away (for example, “spare ticket to Monday’s football game”)
- requests for recommendations of products or services
- jokes
- notification that food is available (for example, “leftover bread and cheese in conference room C4”)
- notification that automobile headlights are on

Eliminating these messages might be difficult and create bad will. What your company can do, however, is create better channels for sending non-essential messages, as I describe below.

Distribution Lists

If you set up specific distribution lists for the distracting messages, then people can use rules to put them into low-priority folders. For example, it would be easy to make rules for a distribution list for leftover food.

Web-based Services

Another, more sophisticated, option is to set up web-based services. For example, your company could set up a simple Web-based application that would send a message only to the owner of the car whose lights are on. (People would have to enter their license plate numbers, but their reward for doing so is high.) Your company might also provide Web-based applications for finding leftover food, buying/selling goods, and reviewing products and services.

Rules

It is very valuable for the company to set up rules that remove unsolicited commercial email before it gets anywhere close to the end-user. Junk email can take up an enormous amount of time and energy.
While the recipes in Chapter 3 are good starting points for rules, having a set of pre-made rules might help your company’s productivity. Your employees could then customize the rules for their specific needs.

Confidential Material

Email makes it very easy to transmit confidential material, but email has very poor security. Anything highly confidential should be sent via a trusted courier. One way to make it more difficult to disclose confidential information is to have a computer program examine all outgoing messages for a set of words marking confidentiality. For example, Mabel’s company could prevent people from emailing documents containing the phrase Floss Recycling Inc. Confidential.

Messages from “The Company”

From time to time, someone will need to send a message to the entire company about policy changes, facilities closures, and so on. For large companies, it can be dangerous for an executive to send that message from his or her own account. The sender might get 1000 messages from employees complaining. (If nothing else, there could be a lot of Out-of-Office messages.) On the other hand, if updates come from an email address that is not attached to a person, it can seem very cold and impersonal.

One way around this is to make the message from an impersonal address, but to give the name of the person who sent the message. Then ask that follow-up comments go to a web-based discussion forum. Ask that people not post replies unless they have something new to add, but provide a way to count “I like this” or “I don’t like this” votes.

Provide Training

Many of the tools above enforce good practice, but good training can encourage good practices. If your company does not have the technical resources to develop tools like the above, adding training on email effectiveness can be valuable.
Even if your company has the time, money, and skill to develop resources, training might be useful. Good resources won't help everything. In particular, technical aids do a poor job of helping people write more understandable messages.

Training is particularly productive if the unwanted behavior is the result of uninformed or unconscious decisions. Showing the benefits of doing things a different way might be all that it takes to change the behavior.

If your company can come to agreement on what behaviors are acceptable, peer pressure can enforce those behaviors. If five hundred people all reply, “that wasn’t appropriate” to an unacceptable message, the sender isn’t likely to make that mistake again. To make this work, however, the culture must accept or encourage this type of vigilante justice.

The disadvantage of training everybody is that it takes time and energy—which usually means money.

**Subject Signal Words and Abbreviations**

Even if your company doesn’t have the resources to make more appropriate homes for distracting messages, it can get similar results if everybody uses the same signal words in the subjects. If people use the signal words consistently, those who are not interested in such messages can use rules to move them into low-priority folders or delete them outright. Examples of useful signal words are:

- **OT**: for messages that are Off-Topic—not directly related to a distribution list’s topic
- **REQ**: for REQuest—meaning the sender wants the receiver to do something
- **LIGHTS**: for messages about cars whose headlights are on
- **FOOD**: for messages that there is leftover food available for the taking
- **WHERE**: to notify people of a temporary absence
- **OOO**: for automatic responses that the sender is out of the office
- **FS**: for messages advertising something For Sale
- **WTB**: for messages expressing a desire to purchase something (Wanted To Buy)
- **EOM** to show that the subject line contains the entire message
- **TC**: for Time Critical
It doesn’t really matter what words people use, as long as everybody uses them consistently. Your company will be just fine if everybody uses AR: (for Action Request) instead of REQ:. But if some people use AR:, some use REQ:, some use AI:, and some use DIRECTIVE:, it will be harder for people to set up rules.

Training can also reduce confusion about common abbreviations. While FYI (For Your Information) and BTW (By The Way) are relatively common outside of email, there are a number of abbreviations that aren’t seen often except in email:

- IMHO - In My Humble Opinion
- RTFM - Read The Manual
- LOL - [I] Laughed Out Loud
- ROTFL - [I am] Rolling On The Floor Laughing
- RSN - Real Soon Now
- TIA - Thanks In Advance
- YMMV - Your Mileage May Vary (meaning “your experiences might be different”)
- <g> - grin

In addition, every company has its own acronyms and code names. For example, Intel uses NCG to mean “New College Graduate.” NASA has so many acronyms that its employees joke that it stands for “National Acronym-Slinging Agency.”

Alas, frequently someone will send a message to a huge distribution list asking questions like, “What does IMHO mean?” If there are 500 people on the distribution list, the message will probably annoy 450 of them.

To let everyone know what these words and abbreviations mean, your company might want to have a Web page with a list of the signal words, abbreviations, and code words that your company uses. Even if someone explains the signal words and abbreviations once to every employee, there might still be trouble in the future. People will forget, new situations will call for new signal words, and new people will join the company.

The new hire orientation should impress upon people that if they don’t understand a phrase, they should not ask everybody on a distribution list. Tell them to ask either the sender of the message or the person responsible for the acronyms Web page.
Signatures

Different companies have different attitudes towards signatures. It might be worthwhile to discuss signatures at new-hire orientation. Even if there isn’t a company policy, it would be good for people to understand the issues surrounding signatures.

Some people like to see signatures with the name, phone number, and/or position in the company for internal mail. Others prefer to receive uncluttered messages. They figure that if they want that information, they can look it up in the company directory. Some cultures allow humorous sayings in the signature. This can be fun. It can also look unprofessional.

For external mail, your company might want to ask people to include lots of information in a text signature. People outside the company probably can’t see your company directory.

Importance Levels

Importance levels can be very useful—if everyone knows what the importance level means. Unfortunately, left to their own devices, people will use radically different importance levels for the same circumstances. Some will never set the importance level and others will make everything high importance. Some will set the importance level according to how important it is to the sender while others will set importance level according to how important it is to the receiver. Thus, many readers ignore importance levels completely. (Some even use rules to change the importance level.)

Another problem is that importance level is a combination of urgency and importance, but there is a big difference between the two. For example, “Do you want to go to lunch with me in an hour” is high urgency but low importance. On the other hand, “I will need a bone marrow transplant in a year. Please register to be a bone marrow donor” is high importance but low urgency.

Developing and training people on some organization-wide guidelines for importance levels will make them more useful for everybody.
Voice instead of Email

There are times when phone or face-to-face conversations are better than email. If the topic is emotionally charged or if there are many intertwined issues to resolve, voice is frequently better. If your company’s culture demands that people always use email, your company could have more hurt feelings. Education is the key to getting people to use the right medium for the situation.

Response Speed

Differences in response speed can cause problems. If someone who thinks that people should respond to email immediately sends email to someone who replies a week later, there could be trouble.

It is difficult to set firm policy on response time because of unintended consequences. If the boss orders that everyone must respond within a certain amount of time, people will probably set up their rules to respond to all messages with “I got your message and am looking into your issue.” This is not helpful.

If your company makes a policy insisting that employees must answer messages in a certain amount of time or not at all, then people might choose to never respond. This is also not helpful.

Your company might want to suggest to its employees that if they can tell it will take more than a day to find the answer to a question, that they should send a courtesy response. This response should say why they can’t respond and when they expect to know enough to be able to respond.

Some people respond slowly simply because they are buried in email. In that case, some training on how to manage email might be appropriate. Give them a copy of this book or get them to email management training. If they still can’t cope with the deluge, perhaps they need email management software (as described on page 213) or an assistant to help them deal with all the messages.

Emoticons

Some people really hate emoticons, despite how helpful they can be in conveying emotional tone properly. Some language purists find emoticons to be an assault on
proper usage. Some people think emoticons are unprofessional. Other people use
text-to-speech processors, which render emoticons unintelligible or invisible.

Your company might want to make sure that everyone understands the reasons for
emoticons as well as their limitations.

**Writing Email Well**

Good usage can reduce the number of messages that fly around. If quotations are
not an appropriate length, if lines aren't wrapped well, if messages are too long, or
if they cover too many topics, it will take longer to finish the negotiation.

Good usage is extremely difficult to order because poor usage is almost never
deliberate. Training, however, can be useful. Give everybody a copy of this book,
send them to a class, or develop a Web page with hints, tips, and links to resources
for writing well.

**Set Policy**

One way to change behavior is to put it into the company policy. The benefits of
doing things by decree are that it can be efficient and costs very little directly. The
bad news is that the indirect costs can be high if people don't like the policy:
grumbling and unhappiness can hurt productivity. Furthermore, there are always
gray areas: behaviors that decrees can't cover or that can't be enforced. For
example, “write better messages” is not a meaningful order. People don't usually
write poorly on purpose.

Email is a new enough phenomenon that sometimes it isn't clear who is
responsible for making high-level decisions about email. Even if you aren't part of
the management chain, you might be able to affect your company’s email culture
by asking the senior management who is responsible for email policy decisions.
Getting an answer to that question means that somebody now has ownership of
the problem. This, by itself, might be a big enough step to lead to changes.

Each company’s management will have differing abilities to dictate policy,
depending upon the company’s overall culture. A military organization can tell
people what to do much more easily than a charity staffed by volunteers.
That said, there are times when management needs to issue decrees about email usage. Management should make policies particularly clear for any issues with legal implications. Some examples follow.

**Personal Use**

If your company does not have a policy against it, people will use email for their personal use. This might be good. People might not need to briefly leave work if they can take care of errands by email. Email is also quieter than talking on the telephone—which people who work in high-density cubicle farms will appreciate.

Personal use can also hurt productivity. People can end up spending a lot of time on personal email. Jokes, hoaxes, and chain letters can be a particularly wasteful.

However, limiting employees’ email access might make them resentful, especially if other companies in your area allow it. Limiting email access might limit your ability to attract and retain employees.

Your company probably needs to have a policy on acceptable behavior, which could include a recommendation that employees use a separate account for personal messages.

**Illegal Uses**

Many things are just as illegal on-line as they are off-line. Depending upon your jurisdiction, the following can be illegal: harassment, stalking, libel, fraud, gambling, and pyramid schemes. Your company should have a clear policy stating that your company will not tolerate illegal uses of email. Be sure to give clear examples of unacceptable behavior.

**Privacy**

Depending upon your jurisdiction, your company might have the legal right to examine employees’ email. There are some situations where clearly it makes sense for a company to exercise that right. For example, system administrators might need to glance at someone’s email to make sure that they fixed a problem with the email system properly.
However, employees will probably get upset if someone reads their messages for no obvious reason. Your company might want to say who can read email under what circumstances. For example, the policy might say that reading someone else’s email is cause for disciplinary action except in the following cases:

- authorized by a vice president
- fixing a problem in the email system
- developing a defense for a legal case
- providing subpoenaed material
- investigating illegal activities (including theft of intellectual property)

The company’s email privacy policy should be stated clearly, perhaps at orientation or in the personnel policy.

Attachments

What formats are okay to send as attachments? If a minority isn’t able to view attachments in a certain format, what is the policy? Is the minority obliged to find software that can read it or is the majority obliged to find a format that everybody can read?

One way to address this issue is to have a list of approved formats and to issue a policy directive that everyone must have the appropriate software loaded on their computer. Another approach is to say that the person requesting the favor bears the burden of translating the document into a usable format.

It is also helpful to set limits on the size of attachments people can send. Attachments can be very large, and if the attachment goes to 500 people, that’s 500 disk drives that the attachment might take space on. Instead, your company might want people to put large documents on a file server or Web server.

Circumventing Technology Channels

If your company has technically-savvy employees, they might be able to set up their own email servers and/or Internet connections. Sometimes there might be good reasons for doing this. For example, if someone is developing new mailing list software, he or she will need to set up their own list servers.
However, these unofficial servers can sometimes bypass important security features. Your company might want to state that setting up an email server without the prior written permission of the MIS department is grounds for disciplinary action.

**Email vs. Telephone**

Some people don't like email. I know people who don't read their email because “if it's important, they'll telephone.” This eliminates many of the benefits of email.

Frequently this culture clash forms along age, gender, and job position. While many older workers are quite comfortable with email, the minority of people who are not comfortable with email tend to be older. Older men, particularly, don’t always type well because typing used to be “woman's work” and low-status. The human-contact people—sales, marketing, human resources, and so on—also tend to like the telephone more than engineers do. Engineers tend to be more comfortable with email than non-technical people are.

Given that senior management tends to be older men with non-technical backgrounds, there can sometimes be more email resistance as you move up the management chain. This can make it difficult to change policy. The senior executives could find it a loss of face to admit difficulty with email, so they might not be receptive to training or persuasion, either.

The best way to get people to read their email is to make it part of everyone’s performance evaluation: does the employee respond promptly to requests from others? If email messages are a significant part of your corporate communication, your company might also want to ask all job applicants how comfortable they are with email.
Summary

Developing resources, providing training, and setting policy are all ways of improving a company's email productivity.

Useful resources include:

- Web-based applications to archive distribution lists
- Web-based applications for communicating with list servers
- Web-based applications for indicating where someone has gone
- Web-based applications to configure out-of-office auto-responses
- Web-based applications for messages about food, car lights left on, items for sale, and recommendations
- Web-based applications for discussing corporate announcements
- Software to monitor outgoing messages for confidential information
- Software to eliminate duplicate messages
- Software to remove viruses
- A good Web site
- Prewritten responses
- Prewritten rules

Training can improve understanding of:

- Abbreviations and signal words
- Signatures
- When to use voice instead of email transactions
- Appropriate response times
- When to use Bcc
- How to write clearer email messages
- When to use emoticons
Management should clarify what is expected regarding:

- personal use of email
- illegal uses
- privacy
- email addresses
- attachments
- setting up alternate email servers
- reading email
This glossary cannot be an ultimate authority. Electronic mail is still relatively new, and the language has not completely settled down yet. For example, *newsgroups*, *discussion groups*, and *electronic forums* are all the same thing—many-to-many textual conversations that can happen over long periods of time—but they have different names depending upon who is talking about them. Words also take on multiple meanings because there aren’t other good terms. For example, *a client* can be a piece of hardware, a piece of software, or the combination of the two. You can sometimes figure it out from context, but not always. Use this glossary as a guide only.

This glossary includes a number of terms that are not specific to electronic mail. In particular, it defines a number of words that come from other Internet services like Usenet and various chat communities. People who use email frequently use other Internet services, so they frequently use terms from those communities in their email.

- **account**: Usually used as a synonym for email address or login ID. (Billing accounts are frequently identified by login IDs.)
- **action**: A sequence of manipulations that a rule performs on a message that matches the given conditions.
- **address**: A unique identifier used to determine where to send someone’s email. Usually made up of the login ID, the at sign (@), and the name of the company or Internet Service Provider.
advTHANKSance A cute way of saying *Thanks In Advance*.

AFAIK Abbreviation for *As Far As I Know*.

alias Same as *nickname*.

article Message sent to many people. Usenet term; not frequently used to refer to an email message.

BCC BCC is an abbreviation for *Blind Carbon Copy*. “Blind” indicates that the receivers can’t see who is on the Bcc list. See also *CC*.

blacklist A list of addresses that you don’t want to ever hear from again. *Junk Senders* on page 81 is an example of a blacklist. Also see *whitelist*.

body The part of a message that contains the conversation — as opposed to the part that has information about the message like the time and date, sender, transmission path, and so on. See also *header*.

bounce To be returned as undeliverable. “I tried to send you the summer picnic menu, but the message bounced.” Also sometimes used as a noun to refer to a bounced message.

BTW Abbreviation for *By The Way*. “BTW, I loved the curried mushrooms and broccoli appetizer!”

burst To split an Internet distribution list digest into individual messages.

card Netscape’s term for *nickname*. 
CC is an abbreviation for Carbon Copy and comes from the days when people had to use carbon paper to make copies.

For those of you who are too young to remember, carbon paper used to be one of the only ways to duplicate a document. To make a copy, one had to place a sheet of carbon paper between two pieces of regular paper. Pressure from writing or typing on the top paper would transfer through the carbon paper and leave marks on the bottom paper. While people now rarely use carbon paper for duplicating documents, you can still occasionally see carbon paper in credit card signature slips.

chat A real-time textual conversation, often with many participants.

client A user of services. There are now many services available where one program runs on one computer, another runs on a different computer, and they communicate over a network. The program that provides the service is called the server and the program that uses the service is called the client. (The language is a bit imprecise; the respective computers are also frequently called servers and clients.)

One good example of a client-server application is the Web. A Web client or browser runs on an individual's personal computer. The browser connects to a Web server, which gives the client the Web page for display. Email is also a client-server application. Messages come to a mailbox on a mail server, where they stay until a mail client retrieves them.

condition The piece of the rule that determines whether or not the email software will execute the specified action. Also called criteria.

criteria Same as conditions in rules.

CC 229
CRM  Abbreviation for *Customer Relationship Management* [software].

**Customer Relationship Management Software** A type of software that tracks interactions with customers, makes using a shared database of knowledge easier, and directs questions to the most appropriate person.

digest  A collection of messages to an Internet distribution list that are packaged together and sent as one message.

discussion group  For practical purposes, same as *newsgroup*.

distribution list  A free-flowing, many-to-many email conversation with shifting membership. For Exchange users, the participants are usually on a Global Address List. If there are non-Exchange users in the conversation (as when participants are from many companies), a piece of software (called a *list server*, *listbot*, or *listserv*) will take any messages to a particular email address and re-send them to everybody who has subscribed to that list. Also called *mailing list*.

eCRM  Abbreviation for *Electronic Customer Relationship Management* [software]. See *Customer Relationship Management*.

e-mail client  A more precise and technical term for the email program that you use to read, organize, send, and store email messages.

e-mail ID  Same as *login ID*.

emoticon  Cartoon faces “drawn” with text and used to express emotion. Short for “emotional icon.”

envelope information  Also called a message *header*. See *header*.

EOM  Abbreviation for *End Of Message*. 

230  [CRM]
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>extranet</td>
<td>Set of computers connected to the Internet but protected (by encryption) from completely public access.</td>
</tr>
<tr>
<td>FCC</td>
<td>Abbreviation for <em>File Carbon Copy</em>. FCC’d messages are copied to a mailbox. See also <em>CC</em>.</td>
</tr>
<tr>
<td>filter</td>
<td>Term that many email programs use for what Outlook calls <em>rules</em>.</td>
</tr>
<tr>
<td>flame</td>
<td>An angry or insulting message. “I sent a warning to everyone in the company about the Good Times virus, and boy, did I get flamed for wasting resources!”</td>
</tr>
<tr>
<td>flame war</td>
<td>A series of angry or insulting messages between two or more correspondents.</td>
</tr>
<tr>
<td>folder</td>
<td>A collection of messages or other items. Some other email programs use the term <em>mailbox</em> instead.</td>
</tr>
<tr>
<td>forum</td>
<td>For practical purposes, same as <em>newsgroup</em>.</td>
</tr>
<tr>
<td>forward</td>
<td>To send a copy of a received message on to a third party. “I hope you don’t mind, but your essay about learning how to drive was so funny that I forwarded it to my Aunt Sonia.”</td>
</tr>
</tbody>
</table>
Abbreviation for *For What It's Worth*. “I know you're concerned about shaving your head, but FWIW, I have never been hassled because of my shaved head.”

Abbreviation for *For Your Information*. “FYI—someone stole Fred's bike this morning, so he's in a bad mood.”

Abbreviation for *Global Address List*.

A collection of email addresses that can be addressed with one Contact, similar to *Personal Address Lists*. While Personal Address Lists are private, Global Address Lists are public.

Abbreviation for *Great Minds Think Alike*.

A piece of information *about* an email message. Headers typically show who sent the message, who it was addressed to, the date and time that it was sent, and some information about the path that the message took. *Header* can refer to either the entire set of information or to just one piece (such as the subject or the date). Also called *envelope information*.

Abbreviation for *HyperText Markup Language*. See *HyperText Markup Language*.

Text that, when clicked upon, initiates an action (like retrieving a Web page).

The language used to create most Web pages.

Abbreviation for *Internet Engineering Task Force*. See *Internet Engineering Task Force*.

Abbreviation for *I Have A Customer*. “IHAC who says that he broke the cup-holder on his computer.”

232

IMHO  Abbreviation for In My Humble Opinion or In My Honest Opinion. “IMHO, Eudora is the best email program available.”

IMNSHO  Abbreviation for In My Not-So-Humble Opinion.

intranet  A set of computers that communicate with each other with TCP/IP, can access machines on the Internet, but that can only be accessed by computers that are on the same local network. Machines on an intranet are not supposed to be publicly accessible.

Internet  When capitalized, it refers to a specific extremely large network of computers that communicate with each other using the TCP/IP specifications and that are publicly accessible. When not capitalized, refers to a network of computers connected by a TCP/IP network that are not attached to the public network.

Internet distribution list  In this book, an Internet distribution list is a distribution list that does not involve a Global Address List. See also distribution list. Internet distribution lists are usually called mailing lists or plain distribution lists; in this book I needed to be more precise.

Internet Messaging Access Protocol  A type of server-based email system. Messages are kept on the server and only temporarily stored on the client. (This is different from Post Office Protocol (POP), where messages are stored on the client and only temporarily stored on the server.)

In practical terms, IMAP lets you access your email from two or more computers and it will always look the same. The disadvantage of IMAP is that you need to stay connected to the Internet for the whole time you are working with your email.
With POP, the messages are stored on the computer you used to read them. If you go to another computer, you won't see all the messages because some or all are on the first computer. See also *Post Office Protocol*.

<table>
<thead>
<tr>
<th><strong>Internet Engineering Task Force</strong></th>
<th>A group that develops standards for Internet technologies, including email.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Internet Service Provider</strong></td>
<td>An organization that provides access to the Internet. If you get your email through your company, then your company is your Internet Service Provider.</td>
</tr>
<tr>
<td><strong>ISP</strong></td>
<td>Abbreviation for <em>Internet Service Provider</em>. See <em>Internet Service Provider</em>.</td>
</tr>
<tr>
<td><strong>listbot</strong></td>
<td>Although the name of a particular list server site, this term is frequently used as a generic synonym for <em>list server</em>.</td>
</tr>
<tr>
<td><strong>listname address</strong></td>
<td>The email address that reaches all the subscribers on an Internet distribution list. This is <em>not</em> the same as the list server address, which is used for communicating with the list server software.</td>
</tr>
<tr>
<td><strong>listserv</strong></td>
<td>The name of an early <em>list server</em> software package. Some people now use it to mean a list server or Internet distribution list.</td>
</tr>
<tr>
<td><strong>list server</strong></td>
<td>A program that automatically administers an Internet distribution list. &quot;If you don't want to get any more messages, don't tell the list, send an unsubscribe message to the list server.&quot; Also called a <em>listserv</em> or <em>listbot</em>.</td>
</tr>
<tr>
<td><strong>list server address</strong></td>
<td>Email address used to communicate with list server software.</td>
</tr>
<tr>
<td><strong>live text</strong></td>
<td>See <em>hyperlink</em>.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition/information</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>login ID</td>
<td>The unique identifier used for signing on to a computer or email account. Same as handle, username, email ID, and (sometimes) account.</td>
</tr>
<tr>
<td>LOL</td>
<td>Abbreviation for Laughing Out Loud.</td>
</tr>
<tr>
<td>lurker</td>
<td>A person who reads messages on an Internet distribution list or Usenet newsgroup but does not write (post) any messages.</td>
</tr>
<tr>
<td>mailbox</td>
<td>Term that some other email programs use for what Outlook calls folders.</td>
</tr>
<tr>
<td>mailing list</td>
<td>See distribution list.</td>
</tr>
<tr>
<td>Mail Transport Agent</td>
<td>A very technical term for the software that takes a message and transmits it to the destination computer.</td>
</tr>
<tr>
<td>Mail User Agent</td>
<td>A very technical term for the email software that a user interacts with. Same as email client.</td>
</tr>
<tr>
<td>majordomo</td>
<td>The name of a very widely-used list server.</td>
</tr>
<tr>
<td>Message-ID</td>
<td>The message header that gives a unique identifier to each message.</td>
</tr>
<tr>
<td>mirror</td>
<td>A web site that has a copy of another site. Mirrors are used to reduce how busy a server is, or to make access faster for people who are located a long distance from the original site.</td>
</tr>
<tr>
<td>MIME</td>
<td>Abbreviation for Multipart Internet Mail Extensions, an extension to the original email specifications that allows sending messages in essentially any format. (It does not, however, guarantee that the receiver’s computer will be able to display any format.)</td>
</tr>
</tbody>
</table>
**MLM**  
Abbreviation for *Multi-Level Marketing*. See *Multi-Level Marketing*.

**MOO**  
Abbreviation for MUD, Object-Oriented. Essentially the same as a MUD, but providing more capabilities for the users to change the environment. See *MUD*.

**MTA**  
Abbreviation for *Mail Transport Agent*. See *Mail Transport Agent*.

**MUA**  
Abbreviation for *Mail User Agent*. See *Mail User Agent*.

**MUD**  
Abbreviation for *Multiple User Dungeon*. The word *Dungeon* in the title refers to its earliest use—role playing games—but MUDs are now used for many things besides games. Consequently, the definition of MUD has expanded. To some, MUD stands for *Multi-User Dimension* or *Multi-User Dialogue*.

**Multi-User Dungeon**  
See *MUD*. It’s rare that people use the entire term instead of the abbreviation.

**Multi-Level Marketing**  
A type of *pyramid scheme*.

**newbie**  
A person who is new to the Internet. Depending upon how it is used, it can be derogatory.

**newsgroup**  
A forum where many people can read and write (post) messages. Once this word only referred to Usenet discussions, but now the word is drifting to include Web-based discussions. “One of the basketball newsgroups had a posting that someone is going to start a second women’s professional league.”
nickname  Term for something similar to *Global Address Lists* or Contacts—a shortcut for either a single email address or a group of email addresses. For example, you might have a group nickname *roses* that contains the email addresses of seven people in your rose gardening club. Then if you addressed a message to *roses*, your email software would send the message to those seven club members. Also called *alias*, *group*, or *card*.

NRN  Abbreviation for *No Reply Needed*. This is not common, but I would like to see it become common.

off-topic  About something that is not directly related to an Internet distribution list’s stated purpose.

OT  Common (but by no means universal) abbreviation for *Off-Topic*.

OTOH  Abbreviation for *On The Other Hand*. “I think the president is incompetent. OTOH, her husband is the best politician I’ve ever seen.”

outbox  Non-Outlook term for the equivalent of the *Sent* folder. A folder containing copies of messages that have been sent. “I looked through my outbox for my last message to him, and I sent him the report last Thursday.”

PAL  Abbreviation for *Personal Address List*.

**Personal Address List**  A collection of email addresses that can be addressed with one Contact, similar to *Global Address Lists*. Personal Address Lists are private and Global Address Lists are public.

Ponzi scheme  A particular type of *pyramid scheme*.

POP  Abbreviation for *Post Office Protocol*. See *Post Office Protocol*. 
**Post Office Protocol** One specification for how computers must talk to each other to transfer a message from an email server to an email client. Post Office Protocol (commonly abbreviated POP) systems are designed for the user to download, store, and manipulate mail on the user's desktop machine. This is different from IMAP, where the mail is stored and manipulated on a server.

**post** To write a message for a large group. One implication of *post* instead of *write* is that the message will be public and not private. “Somebody posted to the Stanford alumni Internet distribution list that they had a job vacancy to fill in floss recycling.”

**protocol** A set of rules that computers use to talk to each other. There are many protocols for many purposes, including sending email, transferring email, and sending instant messages.

**pyramid scheme** A scheme where later participants (B) pay money to earlier participants (A) in the hope that even later participants (C) will give them (B) even larger sums of money than they (B) gave to earlier participants (A). This is almost always illegal (except when investing in stock market bubbles).

**Reply-to-All** The method of replying where every person in the From:, To:, and Cc: headers get the response, not just the person on the From: line. See also Reply-to-Sender.

**Reply-to-Sender** The method of replying where only the person in the From field gets the response, not also any people in the To and Cc fields. See also Reply-to-Sender.

**RFC** Abbreviation for Request For Comments, but almost nobody uses the long form. Originally, RFCs were requests for comments. In practice, now RFCs are the rules for how computers talk to each other over the Internet.
RFC822  RFC822 is the name of the original specification for email—before rich text, attachments, and many of the other bells and whistles that are in modern email. To say that a message is “RFC822”, then, is to say that its formatting is very simple.

Rich Text Format  A file format/language for describing styled text, similar to but older than HTML

ROTFL  Abbreviation for Rolling On The Floor Laughing.

ROTFLMAO  Abbreviation for Rolling On The Floor Laughing (ahem) hard.

RSN  Abbreviation for Real Soon Now. This is usually used jokingly when something has been promised (and delayed) for a long time. If you read RSN, you should probably not believe that the item under discussion is going to be ready any time soon.

RTF  Abbreviation for Rich Text Format.

RTFM  Abbreviation for Read The (ahem) Manual.

rule  Rules are tools in an email program that automatically take actions based upon the contents of a message and rules that you define. Also called filters by many programs.

screen name  One of many email IDs associated with one billing account.

sendmail  Sendmail is the most common Message Transport Agent. Sendmail takes a message and sends it on towards its final destination.

server  Software and/or hardware that provides a service (like Web pages) over a network. See also client.
Simple Mail Transport Protocol  The protocol (rules) for computers to talk to each other to send email towards its destination.

snailmail  Techno-slang for postal (paper) mail.

smiley  Same as emoticon.


subscribe  To join [an Internet distribution list].

spam  Techno-slang for Unsolicited Commercial Email. It apparently comes from an episode of the Monty Python television show, and is not usually capitalized except at the beginning of sentences. (The words Spam and SPAM are trademarks for a particular brand of canned meat.)

TCP/IP  Abbreviation for Transmission Control Protocol/Internet Protocol, but almost nobody uses the long form. TCP/IP refers to the set of rules that computers on the Internet use to talk to each other.

thread  A thread is a set of messages on the same topic. Threads usually have the same subject or have information in the header that connects a message with the previous message.

TIA  Abbreviation for Thanks In Advance.

UCE  Abbreviation for Unsolicited Commercial Email.

Uniform Resource Locator  A Web address, for example http://www.webfoot.com.

Unsolicited Commercial Email  Fancy name for junk email.

unsubscribe  To request to be removed [from an Internet distribution list].

Simple Mail
<table>
<thead>
<tr>
<th><strong>URL</strong></th>
<th>Abbreviation for <em>Uniform Resource Locator</em>. See <em>Uniform Resource Locator</em>.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Usenet</strong></td>
<td>An application that lets many people write (or <em>post</em>) and read messages (or <em>articles</em>). Articles are distributed by copying them from computer to computer. Usenet is the original Internet discussion forum, but there are now many types.</td>
</tr>
<tr>
<td><strong>username</strong></td>
<td>Same as <em>login ID</em>.</td>
</tr>
<tr>
<td><strong>viral marketing</strong></td>
<td>Viral marketing is a term for any product that encourages (or forces) its customers to advertise the product. For example, many free email services include a mini-ad for their service at the bottom of each message that is sent via the service. This book is another example: if you want to get more readable email, you should convince your correspondents to also read this book.</td>
</tr>
<tr>
<td><strong>whitelist</strong></td>
<td>A list of email addresses that you want to hear from. The rules on page 74 are examples of whitelisting. See also <em>blacklist</em>.</td>
</tr>
<tr>
<td><strong>word-wrap</strong></td>
<td>What happens with text where the width of the screen is smaller than the number of characters until a carriage return. If the text is broken into lines at word boundaries, it is word-wrapped. If the text is not broken into lines or is broken in the middle of words, it is not word-wrapped.</td>
</tr>
<tr>
<td><strong>YMMV</strong></td>
<td>Abbreviation for <em>Your Mileage May Vary</em>, a standard disclaimer in automobile advertisements in the United States. It means, basically, that the author believes his or her statement to be true, but recognizes that it might not be a universal truth. “I’ve never had trouble getting a ticket right before the game starts. YMMV.”</td>
</tr>
</tbody>
</table>
Visual Basic is a programming language that is tightly connected to Outlook. As such, it is very powerful. A Visual Basic macro can give Outlook more capabilities.

However, this power also makes Visual Basic dangerous. It is easy to write viruses in Visual Basic that can erase your hard drive, for example. This appendix gives some guidelines for spotting dangerous macros and how to install (hopefully safe!) macros.

Visual Basic Macro Security

Before you run a Visual Basic macro—even from me!—you should ask a few questions.

Investigate the Author

First, you need to ask questions about the source of the information.

Is the Author Traceable?

Did you get the macro in an unsolicited email message from someone you'd never heard of before? If so, *throw it away immediately!* The dangers of running it far outweigh any benefits it could give to you.

If the macro is on a Web site, is it the author’s personal Web site? Has the Web site been around for a while? Does it have a good reputation? If so, the macro is
more likely to be okay. (Note: you can use reputation-based search engines like www.google.com to get an idea of a site's popularity and age.)

Is the Author Competent?

Even if the macro's author has the best of intentions, he or she might make mistakes. The more experience the author has, the less likely it is for the macro to have dangerous errors in it.

Examine the Code

Even if the macro that the original author wrote was correct and benign, a malicious hacker could abuse the original author's reputation. A hacker could break into the author's Web server and replace a "good" macro with an "evil" macro. Or, the hacker could forge someone's return address in email. (Return addresses are trivially easy to forge!)

You should always take a quick look at the macro code. Even if you aren't a programmer yourself, there are some obvious things you can look for.

Are the Macro and Author Identified?

There should always be a section at the very top of the macro that says who wrote the macro, what it does, and where to find more information about it. If that is missing, be a little more skeptical about the macro.

If the code has a digital signature attached, it is probably more trustworthy. See http://officeupdate.microsoft.com/2000/downloadDetails/o2ksec.htm for a Microsoft analysis of digital signatures.
Is It Full of Nonsense Words?

Visual Basic isn’t exactly English, but it isn’t complete nonsense, either. If you look at the code, there will be recognizable words or combinations of words like Set, myCounter, and even myOLApp.ActiveExplorer.Selection. Sometimes there will be strange things at the beginnings of words, like

- obj or o in objCurrentWidget in oCurrentWidget
- i in iCount
- n in nChild

This is normal. Programmers use those beginning letters to help them keep track of something that you don’t need to worry about. Programmers also frequently abbreviate Outlook as OL or ol.

You should worry if you see lots of words that are complete nonsense, like v1, akjfd37, or foo23. The author might just be sloppy, but frequently nonsense words are used to hide evil intentions.

Are there Directory Paths in the Macro?

Anything that looks like a DOS-style directory path, like

```
C:\Programs\Windows
```

should make you extremely nervous. A directory path in the macro means that the macro can potentially modify files on your hard drive. If you can’t immediately think of a good reason for this macro to be modifying or reading your hard drive, throw the macro away.

Are the Comments Believable?

If the macro has lots of lines that start with a single quote mark (‘), followed by normal sentences, that’s a good sign. Those are comments—a natural-language description of what the next segment of code is supposed to do. For example, you want to see lines like this:

```vbnet
' Move the selected message(s) to the "done" folder
```
If the macro doesn’t have a lot of comments, that might just mean that the author is a lazy programmer. It could, however, mean that he or she doesn’t want anyone to understand what the program does.

Make sure that the comments say sensible things related to the macro’s stated purpose. You don’t want to see comments like this:

```vbnet
' Yellow ducks are prettier than white ducks
```

and you really don’t want to see comments like this:

```vbnet
' Remove all the files on the idiot's hard drive
```

**Dims and Sets?**

Almost all Visual Basic scripts will have a bunch of lines at the front that have the form `Dim <something> As <something else>`, then a bunch at the end that say `Set <something> = Nothing`. Those are perfectly normal and reasonable.

**How to Install Visual Basic Macros**

Here is one way to install Visual Basic Macros.

1. Open the file that contains the macro(s). You can reach the macros discussed in this book from this Web page:

   http://www.OvercomeEmailOverload.com/outlook/OEOmacros.html

2. Copy the code for the macro to the clipboard. You can copy an entire file by pressing Control-a and then Control-c.
3. Go back to Outlook and open the Visual Basic editor by pressing \texttt{Alt-F11} or selecting \texttt{Tools \rightarrow Macro \rightarrow Visual Basic Editor}, as shown in Figure 38:

![Figure 38: Start Visual Basic Editor](image)

The Visual Basic Editor will appear, as shown in Figure 39:

![Figure 39: Visual Basic Editor](image)
4. Select Insert→Module, as shown in Figure 40:

![Insert Module](image1)

**Figure 40: Insert Module**

This brings up the Module editor, as shown in Figure 41:

![Module Editor](image2)

**Figure 41: Module Editor**
5. Click in the module window and paste the code for the macro(s). The top of
the code for the macros I wrote is shown in Figure 42:

![Visual Basic Macro Code]

**Figure 42: My Macros**

6. Save the macro by selecting File→Save from the menu or by pressing
Control-s, then close the Visual Basic Editor.

**Macro Security**

Once you have the macros, you need to give yourself permission to run them.
There are two ways to do this. The easy way is to enable all Visual Basic macros.
**Do not enable all macros:** it makes you incredibly vulnerable to computer viruses.
The difficult way is by creating a digital signature for yourself and signing the document. To do this, you need to create a certificate for yourself with SelfCert.exe. If SelfCert.exe is already on your computer, it’s probably in the directory

C:\Program Files\Microsoft Office\Office

If SelfCert.exe isn’t already loaded on your computer, here is how to install it:

1. Go to the Start menu in the lower-left corner of your screen and select Control Panel.
2. Click on the Add/Remove Programs icon.
3. Make sure that the Change or Remove Programs icon in the upper left is selected.
4. Select Microsoft Office 2000 and click on the Change button.
5. Expand Office Tools by clicking on the plus sign (+).
6. Select Digital Signature for VBA Projects and set it to Run from My Computer.
7. Click on the Update Now button. (At this point, the installation program might ask you for your Microsoft Office 2000 CD-ROM installation disk.)

To create your certificate, start SelfCert.exe and enter your name. This will create a digital certificate for your personal use.

Finally, you need to actually sign the macro with this new certificate.

1. Go back to the Visual Basic Editor.
2. Select Tools ➝ Digital Signature.
3. Click on the Choose button.
4. Select the certificate that you just created.
5. Click OK.

When you try to run a macro, you might get a warning that macros are disabled. If so, quitting and restarting Outlook usually fixes it.
The first time you run one of the macros, you should get a warning message that your certificate isn't trusted, as shown in Figure 43:

![Security Warning](image)

**Figure 43: Untrusted Macro Warning**

Check the box near the bottom next to **Always trust macros from this source**, as shown in Figure 43. Now you will be able to run these macros at any time.
Summary

While these guidelines won’t save you from all dangerous macros for all time, they should help you spot some of them.

Viruses are dangerous enough, however, that you should be very careful about running scripts. If you have the slightest worry about the safety of a virus, you should go find someone who can read Visual Basic and ask them to look at it.

Otherwise, ask the following questions:

- Where did the macro come from? Does the author have a good reputation?
- Is the author skilled enough to write good programs?
- Does the macro itself say who the author is?
- Does the macro contain a lot of nonsense words?
- Does the macro have any directory paths in it?
- Does the macro have comments? Are they understandable and sensible?

If you decide that my macros are acceptable, you need to do the following to install them:

- Open a Web browser to http://www.OvercomeEmailOverload.com/outlook/OEOmacros.html and follow the instructions to open the macros file.
- Copy the entire contents of the macros file to the clipboard.
- Open the Visual Basic Editor.
- Open a new module and paste the macros into the Module window.
- Create a digital certificate for yourself using SelfCert.exe.
- Sign the project with the certificate you just created.
- Save the project.
Index

Symbols

*, emphasizing with 162
<> around URLs 179

A
actions, rule
about 37
advanced 50–54
mark importance 51
moving to folder 54
play sound 52
Rules Wizard page 44
address book 49
addressee list, suppressing 115
addressing methods
for determining when to reply 130
signaling importance with 191
see also Bcc, Cc, and To
advTHANKSance visual pun 111
ambiguity
intonational grouping 159
of common names 152
of concepts 153
of place 153
of pronouns 152
of references 151–155
of time 154
reducing with emphasis 161
archiving messages, benefits of 93
asterisks 162
attachments
about 172
incompatibilities 180
policy 222
audience, intended 20
auto-responders
dangers of 147
for blocking strangers 143
loops 147
Out-of-Office messages 144
B
Bcc
about 115
dangers of 115
for reducing further traffic 115
origin of term 228
buttons
adding to toolbar 88–91
customizing names and icons 89
C
capital letters, using 167
categories
humor 30
one per mailing list 30
organizing
by project vs. by sender 29
using prefix 31
View by 32
Cc
origin of term 229
responding to 130
signaling unimportance with 191
chain letters
about 120
responding to 140
unintended consequences 120
closing comments 128
composing messages, speed relative to
reading 127
concrete references, see ambiguity
conditions, rule
about 37
advanced 49
is in address book 49
Rule Wizards page 42
selecting Contacts 43
using Global Address Lists in 47
using Personal Address Lists in 48
confidential material 215
Contacts see also Personal Address Lists
customizing toolbar 89
context
asking questions 155
expressing desired outcome 157
importance of 150
corporate messages 215
courtesy responses 131
CRM software 213
culture, email 209
Customer Relationship Management software 213
deleting
as coping strategy 93
dangers of 78
junk mail 80
digital certificates 250
discourage responses, see responses
discussion, see mailing lists
distribution lists
about 101
dangers of external subscribers 210
for geographical areas 211
loops 129
see also Global Address Lists
see also Internet distribution lists
web interface to 210
distribution options, see addressing method
E
eCRM software 213
emailing lists, see mailing lists
emoticons
about 164
in business communications 164
training 219
emphasis 161
EOM 191
exceptions, rule 45
Exchange
how to tell if you’re using 43
lack of headers 173
rule order 55
rule size limits 65
F
flagging messages 94
flame wars
about 163
avoiding 169
fonts 176
formality, for discouraging responses 108
forum, see mailing lists
G
Global Address Lists
about 101
in rules 47
H
headers, showing 172
history of email 171
hoaxes
  recognizing 121
  see also chain letters
HTML messages
  legibility 175
  problems rules have with 58
humor
  appropriateness 123
  keyword in subject 123
  responding to 141
I
  identifying yourself 193
illegal uses of email 120, 124, 221
importance levels
  getting attention with 194
  policy 218
  potential futility of using 194
inappropriate messages
  “me too” 118
  chain letters 120
  hoaxes 121
  humor 123
  junk email 124
  providing alternatives to 214
Internet distribution list
  definition 233
Internet distribution lists 101
  announcement lists 106
  configuring for replies 211
  definition 235
  digests 105
  duplicate messages 212
  first message 102
  managing 100–107
  moderated 106
  servers, see list servers
  unsubscribing from 103
Internet headers, showing 172
intonational grouping 159
issues, one per message 200
J
  jokes, see humor
  junk email
    about 124
    reducing 100
    responding to 128
K
  keywords, see subject, signal words
L
  language
    nonstandard 168
  legibility, history of
    incompatibilities 171
list loops, see mailing lists, loops
list server
  description of 102
  requesting help 104
listbot, see list server
listname address 102
listserv, see list server
long messages, danger of 200
loops
  see auto-responders, loops
  see mailing lists, loops
M
mailing lists, see distribution lists
marking done
  by deleting 93
  by flagging 94
  by marking Unread 95
  by moving to folder 96
mass-mailings, establishing credibility 122
match conditions, see conditions
me too messages, don't send 118

N
names
getting attention with 193
see also ambiguity, of names
negotiation vs. persuasion 165
next message
keyboard shortcuts 91
toolbar button 87
No Reply Needed 109
nonstandard writing, justification for 206
notation
fonts 24
Outlook menus 24
rules 24, 65
NRN 109
numbered outlines, dangers of 160

O
ordering topics, keeping attention by 199
organizing
see also rules
with multiple accounts 59–60
Outlook Express 21
Outlook versions

differences between Outlook 2000 and Outlook 2002 21, 34, 41, 42, 43, 46, 48, 56, 66, 74, 89, 94–95, 112, 176, 182, 192
Outlook 97 and Outlook 98 21
Out-of-Office messages 144

P
paper vs. email
emotional tone 168
inconsistent presentation 171
persuasion vs. negotiation 165
speed 149
typography 149
Personal Address Lists in rules 48
personal use of email 221
persuasion vs. negotiation 165
place, see ambiguity, in place
placeholders, see ambiguity, of references
policies 220
politeness
corresponding with strangers 129
in prewritten responses 134
thank you/you’re welcome 109, 128
Ponzi scheme 120
Preview Pane 86
prewritten responses
company-wide 212
driving directions 135
humor responses 141
long To list responses 142
mass mailing responses 138–141
vague question responses 136–138
prioritizing
benefits of 27
see also rules
privacy, internal policies 221
pronouns, see ambiguity, of pronouns
pyramid scheme 120
Q
questions
implied 131
one per message 200
summarizing 201
quotations
shortening 203
quoted material, see quotations
quotes
separating 202

R
reply to sender only 114
responding
after reading all 132
automatically, see auto-responders
policy for speed 219
remembering to 133
to
inappropriate messages 124
insults 169
long TO lists 142
mass mailings 138–141
strangers 129
vague questions 136–138
when to 128
responses
courtesy 131
discouraging closing comments 108
discouraging with formality 108
Rich Text Format 239
RTF 239
rules
about 22, 28, 36
actions, see actions, rule
blacklist 81
conditions, see conditions, rule
corporate support for 214
exceptions 45
Exchange rules
order 55
modifying 47
order 54, 63
problem with Contacts 58
problem with HTML messages 58
real-world analogy 37
recipe for
adjusting importance level 68
adjusting priority 70
blocking pornography 79
confirmations and updates 73
coworkers 76
distribution lists 72
filing finished messages 97
finding potential viruses 66
frequent correspondents 74
junk mail 77
strangers 82
testing 57
Rules Wizard
action page 44
exceptions page 45
finish page 45
start page 38
rules,
Exchange rules
size limits 65

S
security 211
servers, policy on personal use 222
short verbal utterances 167
shortening
messages 195, 198
paragraphs 197
quotations 203
signal words
  approved list 217
  common 190
signatures
  policies 218
  signaling end of message with 205
  using for common responses 133
smileys, see emoticons
spam, see junk email
speech disfluencies, see um and uh
speech vs. email
  about 158
  choosing 170, 219
  emotional cues 163, 164
  emphasis 161
  nonstandard writing 168, 206
  pauses 159, 166
  um and uh 167
status 204–206
Stopping Spam (book) 128
strangers, messages from 129
styled text
  perceived idleness 175
  sending 174–177
subject
  getting attention with 190
  repeat in body 155
  signal words 190
  voting 119
subject, signal words 190
summarizing to keep attention 201
suppressing addressee list 115

T
  telephone vs. email 170, 223
  terminology, about 24
  testing rules 57
  text-to-speech processors 164
thank you 109, 128
TIA 111
time, see ambiguity, in time
To, signaling importance with 191
toolbar, modifying 88–91
training 215
U
  um and uh 167
  uncertainty, expressing 165–167
  unsubscribing
    how to 103
    how not to 105
  uppercase letters, using 167
  urgency 69, 167, 194, 218
  URLs 177–180
V
  vacation messages
    see auto-responders,
    see Out-of-Office messages
  versions, see Outlook versions
  View, grouped by category 32
viruses
  chain letters 120
  finding 66
  hoaxes 121
  virus-checkers 211
  Visual Basic macros
    digital certificates 250
    installing 87, 246
    security 243, 249
  visually impaired correspondents 164
voice vs. email, see speech vs. email
  voting 112, 119, 160
  voting buttons
    how to add 113
    reducing ambiguity with 160
W
ways to look stupid 105, 116, 118,
121, 124, 129, 132, 147, 151,
153, 198
whitespace, in HTML messages 177
word wrapping 182

Y
you're welcome 110, 128
About the Author

Kaitlin Duck Sherwood worked in a cornfield, fast-food restaurant, space suit design lab, semiconductor manufacturing factory, university, and three bankrupt high-tech startups before venturing out into her own. She worked as a software consultant for four lucrative but boring years before going back to graduate school—where she discovered the World Wide Web. Her Web-based projects earned her two awards and an outstanding case of repetitive strain injury. She worked as a Smalltalk programmer for two years years after she (mostly) recovered and before starting this book project.

Sherwood has been using electronic mail since 1973 and Internet email since 1985. In 1994, she developed what might have been the very first Web-based email system.

Sherwood's Web site gets over 100,000 hits per month, with most visitors going to her tutorial, A Beginner's Guide to Effective Email.

Colophon

The inside layout of this book was done on Apple Macintosh computers named Loue and Pencil, using Adobe FrameMaker 5.5. The cover layout was produced with Adobe Photoshop 6.0 and Adobe Illustrator 9.0. Proofs were printed on a Tektronix Phaser 850 named Crayon. Color matching was by industry-standard SWAG technology. The final digital master was produced in PDF format using Adobe Acrobat 5.0.

The body text face is Adobe Garamond 11.76 on 13.72, from the Adobe Type Library. The title face is Verdana. The email and filter samples are set in Monaco and Helvetica. The cover is set in Myrid.
Quick Tips for Overcoming Email Overload

1. If your email program has tools called rules or filters, use them to automatically prioritize your inbox. If possible, use rules to assign each message a category (or label) based on what group the sender belongs to. If you assign the categories so that they sort in the same order as their probable importance, then you can easily sort your inbox to list messages in roughly the order you want to deal with them.

2. If your email program allows it, put a button in the toolbar for moving the selected message(s) to a final resting place. Also put or use a button in the toolbar to move to the next message. If you are done with a message, press the first button. If you still need to do something with a message, press the second button.

3. Use rules to assign junk email a very low-priority category or move it to another folder. (But do not delete junk email automatically! Your rules will make mistakes sometimes.)

4. Get off of as many distribution lists as you can.

5. Get and use a free email account for all transactions with retailers or the public.

6. Use formal language and end messages with “No Reply Needed” to discourage responses.

7. As much as possible, reply to only the sender instead of to everybody and use BCC instead of CC.

8. Don’t forward any message that asks you to forward it to everyone you know. Those messages are almost always hoaxes or out of date. You might get lots of messages back telling you so.

9. If someone sends you messages you don’t want (like hoaxes or jokes), ask them very politely to stop. Otherwise, they will send you more.

10. Be sure to provide adequate context for your messages. Quote previous messages carefully and watch out for references to people or things that you don’t mention in the message.

11. Save and reuse responses to questions that you get frequently.

12. Make your emotional tone as obvious and explicit as you can.

13. Use styled text infrequently. If your messages are too pretty, people might think you don't have enough to do.

14. Discuss only one issue per message. People frequently forget about all but the first or last question.

15. Visit http://www.OvercomeEmailOverload.com for more resources.

16. Buy and read a book in the Overcome Email Overload series (see reverse).
Help your friends overcome email overload: give them this page!

Postal orders: PO Box 36, Palo Alto, CA 94302-0036 USA. Make checks payable to World Wide Webfoot Press.
Paypal orders: outlookOrder@webfoot.com
Web orders: http://www.overcomeEmailOverload.com/orderForm.html
Phone orders: +1-800-852-4890
Fax orders: print and send this form to +1-707-838-2220

Please send the following:

<table>
<thead>
<tr>
<th>Item</th>
<th>Price</th>
<th>Qty.</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overcome Email Overload with Microsoft</td>
<td>US$29.95</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Outlook 2000 and Outlook 2002</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overcome Email Overload with Eudora 5</td>
<td>US$29.95</td>
<td></td>
<td></td>
</tr>
<tr>
<td>postage for first book (US)</td>
<td>US$4.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>postage for additional books (US)</td>
<td>US$2.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>postage per book (Canada and Mexico)</td>
<td>US$7.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>postage per book (all other countries)</td>
<td>US$9.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>tax per book (California only)</td>
<td>US$2.40</td>
<td></td>
<td></td>
</tr>
<tr>
<td>information about training and consulting</td>
<td>Free!</td>
<td></td>
<td>$0.00</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

TO:  Name: ____________________________
     Address: ______________________________________
     City: ____________________________
     ZIP or Postal Code: _______  Country: ______________

Credit card (circle one): Visa  Mastercard  Name on Card: ____________________________
Account number: ____________________________  Expiration date: ___/____